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THIS PRODUCT CONTAINS CERTAIN COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL, THE USE OF WHICH IS SUBJECT TO
THIS END-USER LICENSE AGREEMENT (THE "AGREEMENT"). DO NOT PROCEED WITH THE INSTALLATION OF THIS PRODUCT UNTIL YOU
(LATER DEFINED AS LICENSEE) HAVE READ THIS AGREEMENT AND AGREE TO BE BOUND BY AND BECOME A PARTY TO THIS
AGREEMENT.  BY PROCEEDING WITH THE INSTALLATION OF THIS PRODUCT (OR AUTHORIZING ANY OTHER PERSON TO DO SO), YOU
AND YOUR COMPANY ACCEPT THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU MAY EXIT THE
INSTALLATION PROCESS AND RETURN THIS PRODUCT, ALL MEDIA AND DOCUMENTATION, AND PROOF OF PAYMENT, TO THE PLACE
YOU OBTAINED THEM FOR A FULL REFUND WITHIN TEN (10) DAYS OF FIRST ACQUIRING THIS PRODUCT. WRITTEN APPROVAL IS NOT A
PREREQUISITE TO THE VALIDITY OR ENFORCEABILITY OF THIS AGREEMENT AND NO SOLICITATION OF ANY SUCH WRITTEN APPROVAL
BY OR ON BEHALF OF LEGATO SHALL BE CONSTRUED AS AN INFERENCE TO THE CONTRARY.  IF YOU HAVE ORDERED THIS PRODUCT,
LEGATO'S ACCEPTANCE IS EXPRESSLY CONDITIONAL ON YOUR ASSENT TO THESE TERMS TO THE EXCLUSION OF ALL OTHER TERMS; IF
THESE TERMS ARE CONSIDERED AN OFFER BY LEGATO, ACCEPTANCE IS EXPRESSLY LIMITED TO THESE TERMS.

1. DEFINITIONS

1.1 Authorization Code:  means the code provided to Licensee by Legato
for permanent authorization to use the Software. The Authorization Code
is provided to Licensee once the Enabler Code is registered with Legato.

1.2 Documentation:  means any user reference materials on any media,
provided by Legato for use with the Software.

1.3 Enabler Code: means the code provided by Legato for activation of the
Software.

1.4 Licensee:  means the person or entity acquiring this License or for
whom this License was acquired.

1.5 Software means the object code copy of the software program provided
to You in association with this Agreement, together with the associated
original electronic media and all accompanying manuals and other
documentation, and together with all enhancements, upgrades, and
extensions thereto that may be provided by Legato to You from time to
time.

2. OWNERSHIP AND ADMINISTRATION OF SOFTWARE

2.1 Ownership and Title. As between the parties, Legato, and its licensors,
own and shall retain all right, title, and interest in and to: (i) the Software
including all intellectual property rights embodied therein; (ii) all of the
service marks, trademarks, trade names, or any other designations
associated with the Software; and (iii) all copyrights, patent rights, trade
secret rights, and other proprietary rights relating to the Software.
Licensee further acknowledges and agrees that it shall have no rights with
respect to any of the foregoing rights other than the rights expressly set
forth in this Agreement.

2.2 Software Activation.  Legato employs Enabler Codes and
Authorization Codes that enable the use of the Software. The Software is
shipped in a "Media Kit" which consists of object code software on
CD-ROM and an Enabler Code for initial activation of the Software or the
Software and Enabler Code may be delivered electronically. Once Legato
receives confirmation from Licensee that the Enabler Code is installed and
is provided with the host ID information, Legato will provide the
Authorization Code to Licensee.  Legato administers the generation and
distribution of Enabler and Authorization Codes, which administration
may be modified by Legato from time to time.

2.3 Administration of Software. Legato may include on the media with the
Software additional computer programs which are not currently licensed
for use by Licensee and to which the Enabler Code or Authorization code
will not permit access. Inclusion of such additional computer programs in
no way implies a license from Legato and access or use of such programs
is strictly prohibited unless Licensee procures the right to use any such
program and the applicable Enabler Code is provided thereto.

3. LICENSE GRANT

3.1 Grant.  Legato grants to Licensee a non-exclusive, nontransferable,
non-sublicensable, perpetual, unless terminated in accordance with the
provisions of this Agreement, license (the "License") to (i) use the Software
installed in accordance with the Documentation and only on the licensed
computer solely for its own internal operations; and (ii) move the Software
temporarily in case of computer system malfunction. The License granted
under this Agreement does not constitute a sale of the Software or any
portion or copy of it. Licensee may not use the Software on more than one
computer system unless otherwise specifically authorized by an explicit
Software product, or additional licenses for additional computers are
purchased.  Rights not expressly granted are reserved by Legato.  Where
the Software is provided to Licensee at no charge for evaluation purposes
only, the License granted is limited to a continuous thirty (30) day period,
commencing with the acceptance of this Agreement (the "Evaluation
Period").  At the conclusion of the Evaluation Period, Licensee agrees to
destroy the Software and certify its destruction to Legato, in writing,
within ten (10) days, or shall return the Software to Legato or purchase a
perpetual license.

3.2 Copies.  Licensee may make copies of the Software provided that any
such copy is : (i) created as an essential step in utilization of the Software
on the licensed computer and is used in no other manner; or (ii) used for
archival purposes to back-up the licensed computers. All trademark and
copyright notices must be reproduced and included on such copies.
Licensee may not make any other copies of the Software.

3.3 Restrictions on use.  Licensee shall not, and shall not aid, abet, or
permit any third party to: (i) decompile, disassemble, or otherwise reverse
engineer or attempt to reconstruct or discover any source code or
underlying ideas or algorithms of the Software by any means whatsoever;
(ii) remove any identification, copyright, or other notices from the
Software; (iii) provide, lease, lend, use for timesharing or service bureau
purposes, or otherwise use or allow others to use the Software or any
portion thereof to or for the benefit of third parties; (iv) create a derivative
work of any part of the Software; or (v) develop methods to enable
unauthorized parties to use the Software.  If EC law is applicable, the
restrictions in Section 3.3 (i) are limited so that they prohibit such activity
only to the maximum extent such activity may be prohibited without
violating the EC Directive on the legal protection of computer programs.
Notwithstanding the foregoing, prior to decompiling, disassembling, or
otherwise reverse engineering any of the Software, Licensee shall request
Legato in writing, to provide Licensee with such information or assistance
and Licensee shall refrain from decompiling, disassembling, or otherwise
reverse engineering any of the Software unless Legato cannot or has not
complied with such request in a commercially reasonable amount of time.

3.4 Purchase Orders.  Nothing contained in any purchase order,
acknowledgment, or invoice shall in any way modify the terms or add any
additional terms or conditions to this Agreement.

3.5 Updates. This section applies if the Software acquired is an update to
the original Software ( the "Update").  An Update does not constitute a
legally licensed copy of the Software unless purchased as an Update to a
previous version of the same Software.  The Update may only be used in
accordance with the provisions of this Agreement.  The Update, together
with the original Software, constitute one (1) legally licensed copy of the
Software.

3.6 Evaluation License.  This Section applies if the Software is being used
for an initial thirty (30) day evaluation period. The license is valid only for
a period of thirty (30) days from the delivery of the Software, and is
designed to allow Licensee the right to evaluate the Software during such
period.  In the event that Licensee desires to enter into a longer-term
license agreement with Legato, Licensee shall obtain an appropriate
Enabler and Authorization Code in accordance with Section 2.2 above,
upon payment of applicable fees, which authorizes use of the Software
after such evaluation period, but only subject to all of the terms and
conditions of this Agreement.  In the event Licensee determines not to
enter into a licensing transaction with Legato at the end of such thirty (30)
day evaluation period, then Licensee's rights under this Agreement shall
terminate automatically and Licensee shall promptly return to Legato or
destroy all copies of the Software and so certify to Legato.

4. MAINTENANCE AND SUPPORT

4.1 Legato has no obligation to provide support, maintenance, upgrades,
modifications, or new releases under this Agreement. Legato may provide
such services under separate agreement.

5. LIMITED WARRANTY

5.1 Media and Documentation.  Legato warrants that if the media or
documentation are damaged or physically defective at the time of delivery
of the first copy of the Software to Licensee and if defective or damaged
product is returned to Legato (postage prepaid) within thirty (30) days
thereafter, then Legato will provide Licensee with replacements at no cost.

5.2 Software.  Subject to the conditions and limitations of liability stated
herein, Legato warrants for a period of thirty (30) days from the delivery
of the first copy of the Software to Licensee that the Software, as delivered,
will materially conform to Legato's then current published
Documentation for the Software.  This warranty covers only problems
reported to Legato during the warranty period.



5.3 Remedies. The remedies available to Licensee hereunder for any such
Software which does not perform as set out herein shall be either repair or
replacement, or, if such remedy is not practicable in Legato's opinion,
refund of the license fees paid by Licensee upon a return of all copies of the
Software to Legato.   In the event of a refund this Agreement shall
terminate immediately without notice.

6. TERM AND TERMINATION

6.1 Term.  The term of this Agreement is perpetual unless terminated in
accordance with its provisions.

6.2 Termination.  Legato may terminate this Agreement, without notice,
upon Licensee's breach of any of the provisions hereof.

6.3 Effect of Termination.  Upon termination of this Agreement, Licensee
agrees to cease all use of the Software and to return to Legato or destroy
the Software and all Documentation and related materials in Licensee's
possession, and so certify to Legato. Except for the License granted herein
and as expressly provided herein, the terms of this Agreement shall
survive termination.

7. DISCLAIMER AND LIMITATIONS

7.1 Warranty Disclaimer.  EXCEPT FOR THE LIMITED WARRANTY
PROVIDED IN SECTION 5 ABOVE, LEGATO MAKES NO
WARRANTIES WITH RESPECT TO ANY SOFTWARE AND DISCLAIMS
ALL STATUTORY OR IMPLIED WARRANTIES, INCLUDING
WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR ARISING FROM A
COURSE OF DEALING OR USAGE OF TRADE AND ANY
WARRANTIES OF NONINFRINGEMENT.  ALL SOFTWARE IS
PROVIDED "AS IS" AND LEGATO DOES NOT WARRANT THAT THE
SOFTWARE WILL MEET ANY REQUIREMENTS OR THAT THE
OPERATION OF SOFTWARE WILL BE UNINTERRUPTED OR ERROR
FREE.  ANY LIABILITY OF LEGATO WITH RESPECT TO THE
SOFTWARE OR THE PERFORMANCE THEREOF UNDER ANY
WARRANTY, NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY
WILL BE LIMITED EXCLUSIVELY TO THE REMEDIES SPECIFIED IN
SECTION 5.3 ABOVE.  Some jurisdictions do not allow the exclusion of
implied warranties or limitations on how long an implied warranty may
last, so the above limitations may not be applicable.  This warranty
provides specific legal rights.  Other rights vary from state to state.
Licensee acknowledges and agrees that Legato is not responsible for and
will have no liability for hardware, software, or other items or services
provided by persons other than Legato.

8. LIMITATION OF LIABILITY

8.1 Limitation of Liability. NOTWITHSTANDING ANYTHING ELSE IN
THIS AGREEMENT OR OTHERWISE, AND EXCEPT FOR BODILY
INJURY, LEGATO WILL IN NO EVENT BE LIABLE OR RESPONSIBLE
FOR OR OBLIGATED WITH RESPECT TO THE SUBJECT MATTER OF
THIS AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT
LIABILITY, OR OTHER LEGAL CONTRACTUAL OR EQUITABLE
THEORY FOR:  (I) ANY INDIRECT,  SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND WHETHER
OR NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH
DAMAGES; OR (II) DAMAGES FOR LOST PROFITS OR LOST DATA; OR
(III) COST OF PROCUREMENT OF SUBSTITUTE GOODS,
TECHNOLOGY, SERVICES, OR RIGHTS; OR (IV) FOR ANY MATTER
BEYOND ITS REASONABLE CONTROL.  NOTWITHSTANDING
ANYTHING IN THIS AGREEMENT TO THE CONTRARY OR THE
FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITATION OF
LIABILITY OR LIMITED REMEDY, LEGATO'S ENTIRE AGGREGATE
LIABILITY ARISING FROM OR RELATING TO THIS AGREEMENT OR
THE SUBJECT MATTER HEREOF, UNDER ANY LEGAL THEORY
(WHETHER IN CONTRACT, TORT, INDEMNITY OR OTHERWISE)
SHALL BE LIMITED TO THE AMOUNTS RECEIVED BY LEGATO FOR
THE SOFTWARE DURING THE SIX (6) MONTH PERIOD PRIOR TO
THE DATE THE CLAIM AROSE FOR THE PARTICULAR LEGATO
SOFTWARE THAT CAUSED THE LIABILITY.

9. MISCELLANEOUS

9.1 Governing Law. This Agreement shall be governed by the laws of the
State of California, as applied to agreements entered into and to be
performed entirely within California between California residents,
without regard to the principles of conflict of laws or the United Nations
Convention on Contracts for the International Sale of Goods.

9.2 Government Restricted Rights.  This provision applies to Software
acquired directly or indirectly by or on behalf of any government.  The
Software is a commercial software product, licensed on the open market at
market prices, and was developed entirely at private expense and without
the use of any government funds.  Any use, modification, reproduction,
release, performance, display, or disclosure of the Software by any
government shall be governed solely by the terms of this Agreement and
shall be prohibited except to the extent expressly permitted by the terms
of this Agreement, and no license to the Software is granted to any
government requiring different terms.

9.3 U.S. Government Users.  As defined in FAR section 2.101, DFAR
section 252.227-7014(a)(1), DFAR section 252.227-7014(a)(5), or otherwise,
all software and accompanying documentation provided in connection
with this Agreement are "commercial items," "commercial computer
software" and/or "commercial computer software documentation."
Consistent with DFAR section 227.7202 and FAR section 12.212, any use,
modification, reproduction, release, performance, display, disclosure, or
distribution thereof by or for the U.S. Government shall be governed
solely by the terms of this Agreement and shall be prohibited except to the
extent expressly permitted by the terms of this Agreement. Licensee will
ensure that each copy used or possessed by or for the government is
labeled to reflect the foregoing.

9.4 Export and Import Controls.  Regardless of any disclosure made by
Licensee to Legato of an ultimate destination of the Products, Licensee will
not directly or indirectly export or transfer any portion of the Software, or
any system containing a portion of the Software, to anyone outside the
United States (including further export if Licensee took delivery outside
the U.S.) without first complying with any export or import controls that
may be imposed on the Software by the U.S. Government or any country
or organization of nations within whose jurisdiction Licensee operates or
does business.  Licensee shall at all times strictly comply with all such
laws, regulations, and orders, and agrees to commit no act which, directly
or indirectly, would violate any such law, regulation or order.

9.5 Assignment.  This Agreement may not be assigned or transferred by
Licensee without the prior written consent of Legato which shall not be
unreasonably withheld.  Legato may assign or otherwise transfer any or
all of its rights and obligations under this Agreement upon notice to
Licensee.

9.6 Sole Remedy and Allocation of Risk.  Licensee's sole and exclusive
remedy is set forth in this Agreement. This Agreement defines a mutually
agreed-upon allocation of risk, and the License price reflects such
allocation of risk.

9.7 Equitable Relief.  The parties agree that a breach of this Agreement
adversely affecting Legato's intellectual property rights in the Software
may cause irreparable injury to Legato for which monetary damages may
not be an adequate remedy and Legato shall be entitled to equitable relief
in addition to any remedies it may have hereunder or at law.

9.8 No Waiver.  Failure by either party to enforce any provision of this
Agreement will not be deemed a waiver of future enforcement of that or
any other provision, nor will any single or partial exercise of any right or
power hereunder preclude further exercise of any other right hereunder.

9.9 Severability.  If for any reason a court of competent jurisdiction finds
any provision of this Agreement, or portion thereof, to be unenforceable,
that provision of the Agreement will be enforced to the maximum extent
permissible so as to effect the intent of the parties, and the remainder of
this Agreement will continue in full force and effect.

10. ENTIRE AGREEMENT

10.1 This Agreement sets forth the entire understanding and agreement
between the parties and may be amended only in a writing signed by
authorized representatives of both parties. No vendor, distributor, dealer,
retailer, sales person, or other person is authorized by Legato to modify
this Agreement or to make any warranty, representation, or promise
which is different than, or in addition to, the warranties, representations,
or promises made in this Agreement.
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Preface

This Legato® Single Server Version Administrator’s Guide, Release 6.1 contains

information on how to configure and use the Legato Single Server Version

release 6.1 software in conjunction with the latest Oracle Server software for

Oracle data storage management.

Important: In this guide, "Windows" refers to both the Windows 2000 and

Windows NT operating systems, unless specified otherwise.

Legato Single Server Version must be installed on a supported UNIX or

Windows operating system running Oracle9i Server software to use the

information presented in this guide. If the software is not yet installed, refer to

the Legato Single Server Version Installation Guide, Release 6.1 for installation

instructions.

Audience
The information in this guide is intended for system administrators and Oracle

database administrators (DBAs) who are responsible for maintaining Oracle

Server backup and recovery systems. Operators who monitor the daily Oracle

database backups may also find this manual useful.

Effective use of this guide requires a working knowledge of Oracle concepts

and terminology, especially those related to Oracle database backup and

recovery.
Legato Single Server Version, Release 6.1
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Product Documentation
Product Documentation
Legato offers an extensive archive of product documentation at its web site

www.legato.com. Most of the documents are in Adobe Acrobat Portable

Document Format (PDF), and can be viewed by downloading and installing

the Adobe Acrobat Reader. The Reader is available directly from Adobe at

www.adobe.com. To install and use the Reader on the preferred platform, refer

to the instructions at the Adobe web site.

Conventions
This document uses the following typographic conventions and symbols to

make information easier to access and understand.

Convention Indicates Example

boldface Names of line commands,

daemons, options,

programs, or scripts

The nsradmin command starts the

command line version of the administration

program.

italic in text Pathnames, filenames,

computer names, new terms

defined in the Glossary or

within the chapter, or

emphasized words

Displayed messages are also written to

/nsr/logs/daemon.log.

italic in command
line

A variable that must be

provided in the command

line

nwadmin -s server-name

fixed-width Examples and information

displayed on the screen

media waiting: recover waiting for
8mm 5GB tape volume name

fixed-width,
boldface

Commands and options that

must be typed exactly as

shown

nsr_shutdown -a
Legato Single Server Version, Release 6.1
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Preface
Information and Services
Legato offers a variety of methods, including electronic, telephone, and fax

support to obtain company, product, and technical information.

General Information

The Legato web site provides most of the information that customers might

need. Technical bulletins and binary patches are also accessible on the Legato

FTP site. For specific sales or training needs, e-mail or call Legato.

Menu_Name>

Command

A path or an order to follow

for making selections in the

GUI

Volume>Change Mode>Appendable

Important: Information that must be

read and followed to ensure

successful backup and

recovery of data

Legato Service or
Resource

Technical
Bulletins

Binary
Patches

Company &
Product
Information

Training
Programs

www.legato.com Yes Yes Yes Yes

ftp.legato.com
(log in as anonymous)

Yes Yes

Legato Sales

(650) 210-7000 (option 1)

sales@legato.com

Yes

Legato Education Services

(650) 842-9357

training@legato.com

Yes

Convention Indicates Example

Important: Use the no_verify option with

extreme caution.
Legato Single Server Version, Release 6.1
Administrator’s Guide 17



Technical Support
Technical Support

The Support section of the Legato web site provides contact information,

software patches, technical documentation, and information about available

support programs.

• Customers with an active support agreement have access to TechDialog,

Legato’s integrated product knowledge base. Help with Legato software

issues is also available through Legato Technical Support.

• Customers without an active support agreement can contact Support

Sales and Renewal to purchase annual Software Update Subscriptions, or

Legato Technical Support services for per-update/per-incident support.

Licensing and Registration

To license and register Legato products, go to the Legato licensing web site. To

change contact information, transfer licenses, or ask questions about licensing,

contact Legato using one of the following methods.

Customer Feedback
Legato welcomes comments and suggestions about software features, the

installation procedure, and documentation. Please send any suggestions and

comments to feedback@legato.com. Legato confirms receipt of all e-mail

correspondence. Although Legato cannot respond personally to every request,

all comments and suggestions are considered during product design.

Help improve Legato documentation and be eligible to win a prize by

completing a brief survey. Visit the Legato web site at www.legato.com, navigate

to the documentation page, and click on the link to the survey.

Licensing and Registration Contact

Legato licensing web site http://license.legato.com

Telephone number (650) 812 6000 (option 3, option 2)a

+31 23 554 8881b

a. Contact information for Americas, Asia, and Pacific.

b. Contact information for Europe, Middle East, and Africa.

Fax number (650) 745-1477a

+31 23 554 8808b

E-mail licensing@legato.coma

licensingemea@legato.comb
Legato Single Server Version, Release 6.1
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Chapter 1: Introduction

This chapter provides an overview of the Legato Single Server Version

product. It describes the main features and functionality of Legato Single

Server Version and how Legato Single Server Version works in conjunction

with the other components of an integrated Oracle backup and recovery

system.

Note: For important information on registering Legato Single Server Version,

see "Splash Screen and Registration Information" on page 23.

This chapter includes the following main sections:

• "What is Legato Single Server Version?" on page 19

• "Overview of Legato Single Server Version Features" on page 20

• "Overview of Oracle Backup and Recovery System" on page 32

• "Other Information Sources" on page 36

What is Legato Single Server Version?
Legato Single Server Version is a comprehensive Oracle data storage

management system. Legato Single Server Version augments the Oracle

backup and recovery subsystem in Oracle9i on UNIX or Windows, by means

of its media management functionality.

Legato Single Server Version provides Oracle data storage management

services to the Oracle Server. Use Legato Single Server Version to configure

and manage the Oracle backup devices and the storage volumes in those

devices. Legato Single Server Version interacts with the backup/restore utility

on the Oracle Server during Oracle backup and restore operations. That utility

is Recovery Manager (RMAN) in Oracle9i.
Legato Single Server Version, Release 6.1
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Overview of Legato Single Server Version Features
An Oracle backup or restore is initiated by running the RMAN utility on the

Oracle Server. During the backup, Legato Single Server Version receives the

Oracle data from the Oracle utility and stores that data on the backup volumes.

During the restore operation, Legato Single Server Version retrieves the

required data from the backup volumes and passes it to the Oracle utility.

Legato Single Server Version also maintains information records about the

Oracle backups in its online index files and uses this information to track the

backed up data.

Overview of Legato Single Server Version Features
As part of an overall Oracle backup and recovery system, Legato Single Server

Version provides:

• Complete storage device and volume management services

• Convenient tracking of Oracle backup data on storage volumes

• Management of Oracle backup data throughout a complete data life cycle

• Complete disaster recovery protection for Oracle databases

The Legato Single Server Version software must be installed on the same

computer as the Oracle Server. The Oracle backup devices must also be

connected to the Oracle Server computer. For more information on Legato

Single Server Version installation, refer to the Legato Single Server Version
Installation Guide.

The Oracle backup devices and volumes must be configured in Legato Single

Server Version. The Legato Single Server Version software maintains

information about the Oracle backups in its online index files.

The Legato Single Server Version Administrator program is a graphical user

interface (GUI) that can be used to configure and administer Legato Single

Server Version and its resources. Use the Administrator program to:

• Connect to Legato Single Server Version

• Configure Legato Single Server Version

• Manage the storage devices and volumes

• Monitor the status of Oracle backup and restore operations

The Administrator program is installed during the Legato Single Server

Version installation on the Oracle Server computer. The Administrator

program can also be installed and run on a separate Windows platform, which

does not require Oracle Server software.
Legato Single Server Version, Release 6.1
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Note: Configuration and management tasks performed in the Legato Single

Server Version Administrator program can also be performed using either the

character-based Legato Single Server Version interface (nsradmin program) or

Legato Single Server Version commands at the operating system command

line. For more information on these other options, see the following sections:

• "Character-Based Interface (nsradmin)" on page 69

• "Command Line Interface" on page 69

Figure 1 on page 21 illustrates the general organization of Legato Single Server

Version and its main components.

Figure 1. Legato Single Server Version Components

In Figure 1 on page 21, Legato Single Server Version (including the

Administrator program) is installed on the same UNIX system as the Oracle

Server. Legato Single Server Version uses the two online indexes—the client
index and media index—to store information about the Oracle backups. It uses

this information to manage the life cycle of the Oracle backup data and enables

users to browse this index information.

Legato
Single Server Version 
Administrator Program

Storage Devices

Resource Database

Media Index

Client Index

UNIX Oracle Server

Legato
Single Server Version
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Overview of Legato Single Server Version Features
Important: Legato Single Server Version has a subset of the features in the

Legato NetWorker® and Legato NetWorker Module for Oracle products from

Legato Systems, Inc.

Information on how to upgrade from Legato Single Server Version to the

combination of Legato NetWorker and Legato NetWorker Module for Oracle

is available at the Legato web site at www.legato.com/LSSV.

For more information on upgrading from Legato Single Server Version,

contact a Legato representative.

Legato Single Server Version stores the backup data passed from the Oracle

RMAN utility onto volumes mounted in the Oracle backup devices. During

Oracle data recovery, Legato Single Server Version retrieves the backed up

Oracle data from the appropriate storage volumes and passes it to the Oracle

utility.

To start an Oracle backup or restore, run one of these programs:

• Command line interface of the RMAN utility

• Oracle Enterprise Manager (OEM) Backup Management Tools

The RMAN utility creates the Oracle backup data objects and passes them to

Legato Single Server Version.

As an optional component of the Oracle backup and recovery system, OEM

Backup Management Tools provide a graphical user interface to the RMAN

utility. OEM Backup Management Tools direct RMAN to perform the backup

or restore.

Legato Single Server Version supports the backup of Oracle tablespaces,

datafiles, control files, and archived redo logs. It supports the backup of only
Oracle data on the Oracle Server computer—not the backup of other filesystem

data on that computer or the backup of data on any other computer on the

same network.

Note: For more information on how to back up non-Oracle filesystem data in

addition to Oracle data on the Oracle Server, contact a Legato representative.
Legato Single Server Version, Release 6.1
Administrator’s Guide22



Chapter 1: Introduction

1

Splash Screen and Registration Information

After the initial installation, Legato Single Server Version is not registered, by

default. For more information on registering Legato Single Server Version, see

"Registering Legato Single Server Version" on page 24.

On Windows, if Legato Single Server Version is not registered, a splash screen

appears whenever a Legato Single Server Version connection is established or

closed in the Administrator program. For more information on how to

establish or close such a connection, see "Legato Single Server Version

Connectivity" on page 53.

Note: On Windows, if a Legato Single Server Version connection is established

and not closed before the Administrator program is exited, the splash screen

appears at exit time and the next time the Administrator program is started.

The Legato Single Server Version splash screen on Windows appears as shown

in Figure 2 on page 23.

Figure 2. Legato Single Server Version Splash Screen on Windows
Legato Single Server Version, Release 6.1
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Splash Screen and Registration Information
The splash screen describes how to obtain information on the fully functional

Legato NetWorker and NetWorker Module for Oracle products. It also

includes a registration message, explaining how to register Legato Single

Server Version.

If Legato Single Server Version is not registered, a similar registration message

appears every two hours in the following locations, as long as the Legato

Single Server Version daemons or services are running:

• In the Message area of the Administrator program:

– On UNIX, in the Message area in the Server window. See Figure 12 on

page 57.

– On Windows, in the Messages area in the Monitor tab. See Figure 13

on page 61.

Note: This registration message in the Message area is also written to the

/nsr/logs/daemon.log file on UNIX and the

C:\Program Files\nsr\logs\daemon.log file (by default) on Windows.

• In an e-mail message sent to the root user on UNIX.

Registering Legato Single Server Version

Legato Single Server Version can be registered for free by entering a

registration code in the Legato Single Server Version Administrator program.

When Legato Single Server Version is registered:

• The appearance of the Legato Single Server Version splash screen (on

Windows) and registration messages stops immediately.

• A registration completion message is displayed.

• Legato product update notices are provided by Legato Systems, Inc.

Note: Registering Legato Single Server Version does not enable any additional

product features or functionality.

To register Legato Single Server Version, perform the following:

1. Obtain a registration code as follows:

a. Go to the Legato web site at www.legato.com/LSSV.

b. Click on the Register LSSV link.

c. Complete the registration form.

d. Click Submit.

Note: The registration form includes a required Host ID field, in which

you must enter the host identifier (ID) of the Legato Single Server Version
Legato Single Server Version, Release 6.1
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host computer. A host ID is a hexadecimal value consisting of eight

characters that might be preceded by 0x. For example, a host ID might

appear as either zzzzzzzz or 0xzzzzzzzz, where zzzzzzzz is the

eight-character string.

For information on how to determine the host ID number of the Legato

Single Server Version host computer, see the appropriate section:

– "How to Determine the Host ID on UNIX" on page 25

– "How to Determine the Host ID on Windows" on page 26

2. Enter the registration code in the Administrator program by using the

instructions in the appropriate section:

• "How to Register Legato Single Server Version on UNIX" on page 28

• "How to Register Legato Single Server Version on Windows" on

page 29

How to Determine the Host ID on UNIX

To determine the host ID number of the Legato Single Server Version computer

by using the Administrator program on UNIX, perform the following:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. From the Server menu, select Registration.

3. In the Registration window, the required host ID number appears in the

Host id field. For example, in Figure 3 on page 26, the host ID number is

80f89393.

Note: If you do not run the Administrator program as a Legato Single

Server Version Administrator, an Administrator field appears at the

bottom of the Registration window (not shown in Figure 3).

The host ID number is required in the Host ID field of the Legato Single Server

Version registration form on the Legato web site (www.legato.com/LSSV).
Legato Single Server Version, Release 6.1
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Splash Screen and Registration Information
Figure 3. Registration Window on UNIX

How to Determine the Host ID on Windows

To determine the host ID number of the Legato Single Server Version computer

by using the Administrator program on Windows, perform the following:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. In the Configure tab in the Server window, click the Registration icon.

3. In the Registration window, double-click Legato Single Server Version. See

Figure 4 on page 27.

4. In the Edit Registration window, the required host ID number appears in

the Host id field. For example, in Figure 5 on page 27, the host ID number

is e9379a0a.

The host ID number is required in the Host ID field of the Legato Single Server

Version registration form on the Legato web site (www.legato.com/LSSV).
Legato Single Server Version, Release 6.1
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Figure 4. Registration Window on Windows

Figure 5. Host ID Field in Edit Registration Window
Legato Single Server Version, Release 6.1
Administrator’s Guide 27



1

Splash Screen and Registration Information
How to Register Legato Single Server Version on UNIX

The section describes how to register Legato Single Server Version by entering

the registration code in the Administrator program on UNIX.

Note: The Administrator program must be run as a Legato Single Server

Version Administrator. For more information, see "Administrator Privileges"

on page 52.

To enter the registration code for Legato Single Server Version on UNIX,

perform the following:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. From the Server menu, select Server Setup to open the Server window.

3. In the Server window, perform the following:

a. In the View menu, select Details.

b. Scroll down to the LSSV reg code field, as shown in Figure 6 on

page 29.

c. In the LSSV reg code field, enter the registration code.

d. Click Apply.
Legato Single Server Version, Release 6.1
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Figure 6. LSSV Reg Code Field on UNIX

How to Register Legato Single Server Version on Windows

The section describes how to register Legato Single Server Version by entering

the registration code in the Administrator program on Windows.

Note: The Administrator program must be run as a Legato Single Server

Version Administrator. For more information, see "Administrator Privileges"

on page 52.

To enter the registration code for Legato Single Server Version on Windows,

perform the following:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. From the Options menu, select Customize.

3. In the Window Configurations tab in the Customize window, select

Display Hidden Attributes and click OK. See Figure 7 on page 30.
Legato Single Server Version, Release 6.1
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4. In the Configure tab in the Server window, click the Set Up Server icon.

5. In the Miscellaneous tab in the Set Up Server window, enter the

registration code in the LSSV reg code field and click OK. See Figure 8 on

page 31.

Figure 7. Customize Window on Windows
Legato Single Server Version, Release 6.1
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Figure 8. LSSV Reg Code Field on Windows

Legato Single Server Version Feature Summary

In summary, the Legato Single Server Version software:

• Supports specific UNIX and Windows operating system releases.

• Supports specific Oracle9i Server releases.

Note: For more information on the specific operating system and Oracle

Server releases supported, refer to the Legato Single Server Version Release
Supplement.

• Can be configured and administered through the Legato Single Server

Version Administrator program.

• Configures and manages the storage devices and volumes used for

Oracle backups.

• Supports the backup and restore of Oracle tablespaces, datafiles, control

files, and archived redo logs.
Legato Single Server Version, Release 6.1
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• Supports the backup and restore of only Oracle data on the Oracle Server—

not other filesystem data on that computer or data on another computer

on the network.

• Stores the Oracle data objects created by the RMAN utility on volumes in

the backup devices, during an Oracle backup.

• Retrieves the appropriate Oracle data objects from the appropriate

storage volumes, during an Oracle data recovery.

• Monitors the progress of Oracle backup and restore operations.

• Enables browsing of online index information for Oracle backups.

• Supports up to four concurrent storage devices (tape only).

• Supports up to four Oracle data streams being backed up simultaneously

to the available storage devices.

Important: Legato Single Server Version does not support several features of

the Legato NetWorker and Legato NetWorker Module for Oracle products,

such as archiving, cloning, scheduled backups, using autochangers

(jukeboxes) or silos, and volume pools other than the Default pool.

Overview of Oracle Backup and Recovery System
Legato Single Server Version works with the components of the standard

Oracle backup and recovery subsystem to produce a comprehensive Oracle

data storage management system. To implement an effective Oracle backup

and recovery strategy, it is important to understand how Legato Single Server

Version and the Oracle components work together.

The Oracle backup and recovery system with the media management layer

comprises the following major components:

• Oracle9i Server

• Recovery Manager (RMAN)

• Recovery Catalog (optional)

• OEM Backup Management Tools (optional)

• Legato Single Server Version

Figure 9 on page 33 illustrates the architecture of the overall Oracle backup

and recovery system and shows the functional relationship between Legato

Single Server Version (or LSSV in the figure), RMAN, and the Oracle Server.
Legato Single Server Version, Release 6.1
Administrator’s Guide32



Chapter 1: Introduction

1

Figure 9. Oracle Backup and Recovery System

Oracle RMAN Utility

RMAN is the main Oracle utility for backing up, restoring, and recovering

Oracle datafiles, control files, and archived redo log files. It stores information

about its operations in the control file of the backed-up database (the target
database) and, optionally, in the Recovery Catalog on the Oracle Server.

RMAN provides the following features:

• Online and offline Oracle database backups

• High performance through parallel backups and restores

• An intelligent interface to Oracle databases

• Well-defined backup strategies

• Checking for corrupt blocks during backups and restores

• Block-level incremental backups and restores

For more information on RMAN, refer to the Oracle Recovery Manager

documentation.

LSSV
SBT
API
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Oracle Recovery Catalog
Oracle Recovery Catalog

The Recovery Catalog is a collection of Oracle database tables containing

structural information about Oracle database backups and restores. The

Recovery Catalog includes information about the following types of objects:

• Backup sets and backup pieces

• Image copies

• Proxy copies

• Archived redo logs

• Target database schema

• Stored scripts (user-created sequences of RMAN commands)

The Recovery Catalog is maintained by RMAN. RMAN uses the information

in the Recovery Catalog or database control file to determine how to perform

requested backup and restore operations.

Although a Recovery Catalog is not mandatory, Oracle recommends using a

Recovery Catalog, especially if there are 20 or more datafiles. If a Recovery

Catalog is not used, the following functions are not supported:

• Point-in-time recovery

• Stored scripts

• Restore and recovery when the control file is lost or damaged

The Recovery Catalog should be stored in the Recovery Catalog database, a

dedicated database about 20 MB in size. If the catalog database fails, it must be

recovered before the target database can be recovered. Inability to access the

Recovery Catalog database implies an inability to recover the target database.

Oracle recommends that the Recovery Catalog be kept on a separate computer

from the target database.

For more information on the Recovery Catalog, refer to the Oracle Recovery

Manager documentation.

How Legato Single Server Version Backs Up Oracle Data

To provide Oracle data storage management services, Legato Single Server

Version implements the Oracle System Backup to Tape (SBT) application

programming interface (API). During backup and restore operations, Oracle

Server processes interact with Legato Single Server Version through the Legato

Single Server Version implementation of the SBT API.
Legato Single Server Version, Release 6.1
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Legato Single Server Version includes a media management library (MML)

that is integrated with the Oracle Server during the Legato Single Server

Version installation on the Oracle Server host. The Legato Single Server

Version installation links the media management software routines of the

library with the Oracle kernel software. This enables the Oracle Server

processes to call the Legato Single Server Version SBT API functions to back up

and restore Oracle data to and from the media controlled by Legato Single

Server Version.

Perform an Oracle backup by issuing the appropriate RMAN commands

through one of the following:

•  RMAN command line interface

•  OEM Backup Management Tools, including an optional GUI to RMAN

OEM Backup Management Tools generate the RMAN commands required to

run the Oracle backup.

RMAN establishes connections with the target database. Each connection

starts an Oracle Server process that performs the backup. During the backup,

Oracle Server processes read the datafile, control file, or archived redo log

being backed up and write it to Legato Single Server Version, through the SBT

API. Legato Single Server Version, in turn, stores the Oracle data on the

appropriate backup tape device.

At the end of the Oracle backup, Legato Single Server Version updates the

online client and media indexes with information about the backup media

used and the Oracle data it contains. Legato Single Server Version

automatically backs up the client and media indexes once every day as part of

the regular Legato Single Server Version bootstrap backup.

How Legato Single Server Version Restores Oracle Data

Perform an Oracle restore by issuing the appropriate RMAN commands

through one of the following:

•  RMAN command line interface

•  OEM Backup Management Tools, including an optional GUI to RMAN

OEM Backup Management Tools generate the RMAN commands required to

run the Oracle restore.

RMAN starts Oracle Server processes on the target database. These Oracle

Server processes perform the restore by calling the Legato Single Server

Version SBT API functions. The SBT API translates the object names requested

by RMAN into a format that Legato Single Server Version understands.
Legato Single Server Version, Release 6.1
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Other Information Sources
Legato Single Server Version verifies that the backup pieces exist in the online

client index. Legato Single Server Version also searches the online media index

for the media containing the requested data objects. It reads the appropriate

backup volumes and passes the data to the Oracle Server processes through

the SBT API. The Oracle processes write the Oracle data to the disk.

Once the required files are restored from the backup volumes, an Oracle DBA

can complete the standard Oracle database recovery.

Other Information Sources
To take best advantage of the information in this Legato Single Server Version
Administrator’s Guide, use it in conjunction with the information available in

the following documentation.

UNIX Online Help

Important: Several features documented in the UNIX Online Help are not
supported by Legato Single Server Version, such as archiving, cloning,

scheduled backups, using autochangers (jukeboxes) or silos, and volume

pools other than the Default pool.

The UNIX version of the Legato Single Server Version Administrator program

includes Online Help. This Online Help contains specific information about

the Administrator program, including context-sensitive help in each window

that describes the purpose of the window and the information to enter in each

field in the window. Other help topics describe Legato Single Server Version

features and provide step-by-step instructions for carrying out Legato Single

Server Version functions using the Administrator program.

To access the Online Help, select the Help menu displayed in the

Administrator program. There are four choices:

• On Window provides context-sensitive help on the current window.

• On Topic provides a list of help topics from which to choose.

• On Help provides information on how to use the Online Help system

itself.

• On Version provides information on which Legato Single Server Version

release is installed on the system.
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The UNIX version of the Administrator program also provides Help buttons

in most of the dialog boxes. Clicking the Help button in a dialog box displays

the help topic associated with that Legato Single Server Version feature.

UNIX Man Pages

Important: Several features documented in the man pages are not supported

by Legato Single Server Version, such as archiving, cloning, scheduled

backups, using autochangers (jukeboxes) or silos, and volume pools other than

the Default pool. Since the man pages are the same as for the Legato

NetWorker product, they might include NetWorker references. For any

NetWorker reference, substitute Legato Single Server Version.

The man pages provided with Legato Single Server Version on UNIX are a

reference for the syntax and function of the Legato Single Server Version

commands that can be issued from the command line.

To view a Legato Single Server Version man page:

1. Verify that the MANPATH environment variable includes the pathname of

the directory where the Legato Single Server Version man pages are

installed, /usr/share/man by default.

2. At the shell prompt, enter the man command and the name of the Legato

Single Server Version command. For example, to view the man page for

the nsrmm command, enter the following man command:

man nsrmm

To print a copy of the entire collection of Legato Single Server Version man

pages, enter the troff command at the shell prompt with the following options:

troff -t -man ’nsr_man -l’| lpr -t -P printer-name

The command for a particular computer might vary (for example, the print

command might be lp instead of lpr), depending on the versions of the

operating system and PostScript software installed.
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Windows Online Help
Windows Online Help

Important: Several features documented in the Windows Online Help are not
supported by Legato Single Server Version, such as archiving, cloning,

scheduled backups, using autochangers (jukeboxes) or silos, and volume

pools other than the Default pool.

The Legato Single Server Version Administrator program on Windows

includes Online Help to provide both context-sensitive and reference

information on-screen while the software is running. The Administrator

program on Windows has an extensive Online Help component.

Context-Sensitive Help

Access context-sensitive help by clicking the Help button found in most dialog

boxes. In some cases, both a Help button and a Field Help button are present,

particularly in the Create and Edit dialog boxes for Legato Single Server

Version resources. For more information on Field Help, see "Field Help" on

page 39.

Reference Help

To browse all of the help topics, or to use the extensive index or keyword

search features, click the Help Topics button or select Help Topics from the

Help menu. The Help Topics dialog box appears.

This dialog box provides tabs with features to help a user find a specific

help topic:

• Contents tab — Displays a table of contents organized into books and

topics as follows:

– Double-click on a book to expand it and display additional books

and/or topics it contains.

– Double-click on a topic to open the Help dialog box in the upper right

corner of the screen.

• Index tab — Displays a scrollable index of keywords and terms, much

like an index found in a printed book. Double-click the keyword or term

that pertains to the subject for which help is required.

• Find tab — Displays a Help Wizard that leads a user through a process to

find help topics based on entered keywords.
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When a help topic appears, the window can be moved and resized just like any

other Windows help topic. The help window also contains buttons that enable

a user to print the topic, view the previous topic, or return to the Help Topics

dialog box.

Field Help

Field Help is a special type of help that appears when the Field Help button is

clicked in certain dialog boxes. Due to the Legato Single Server Version

architecture, the items that appear in a dialog box can vary, depending on the

configuration of the Legato Single Server Version. To meet the dynamic nature

of these dialog box contents, Field Help provides a dynamic help system based

on the items on the screen.

"How Do I" Help

The "How Do I" help is specialized Online Help that provides online

information for common Legato Single Server Version tasks. This help

functions in much the same way as Windows Online Help, has its own Help

Topics dialog box, and is selected from the Help menu.

"What Is This" Help

The "What Is This" help briefly describes each feature in the Administrator

program. To display this help, right-click on a button, icon, or other graphical

feature and select the What Is This option.

Legato Command Reference Guide

Important: The Legato Command Reference Guide is the guide for the Legato

NetWorker products. Since Legato Single Server Version contains a subset of

the features of Legato NetWorker, the guide documents several features that

are not supported by Legato Single Server Version, such as archiving, cloning,

scheduled backups, using autochangers (jukeboxes) or silos, and volume

pools other than the Default pool.

The Legato Command Reference Guide describes the commands and resources

that can be used while running Legato Single Server Version. It comprises a
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Legato Command Reference Guide
complete set of online man pages for the syntax and function of the commands

and their options that can be issued from the command line.

The Legato Command Reference Guide is available in PDF form in the

Documentation section of the Legato web site www.legato.com. The PDF

version of the guide can be accessed using the Adobe Acrobat Reader,

available from the Adobe web site at www.adobe.com. The guide uses the

advanced search feature available in the latest releases of Acrobat Reader.

When the Legato Command Reference Guide is accessed on the Legato web site,

a master page appears, containing a description of the different types of

command utilities. The PDF master page also includes information on how to

use the advanced search feature of Acrobat Reader to search the guide.
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Chapter 2: Preparing to Use Legato Single
Server Version

This chapter describes the internal components of Legato Single Server

Version and their organization as a set of resources and attributes. It explains

how Legato Single Server Version uses these components and how the

components must be configured for Oracle backup and restore operations.

This chapter also provides information on how to use the Legato Single Server

Version Administrator program.

It is assumed that Legato Single Server Version is already installed on the

Oracle Server host. For information on how to install Legato Single Server

Version, refer to the Legato Single Server Version Installation Guide, available at

the Legato web site www.legato.com/LSSV.

This chapter includes the following main sections:

• "Legato Single Server Version Architecture" on page 41

• "Overview of Legato Single Server Version Operations" on page 44

• "The Administrator Program" on page 51

• "Character-Based Interface (nsradmin)" on page 69

• "Command Line Interface" on page 69

• "Configuration Roadmap" on page 69

Legato Single Server Version Architecture
Legato Single Server Version has a set of features configured for Oracle data

storage management services. The process of installing Legato Single Server

Version on the Oracle Server preconfigures the product features to default

settings that enable Legato Single Server Version for Oracle data storage

operations with a minimum of additional configuration.
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Legato Single Server Version Architecture
Legato Single Server Version can use its programs for Oracle data storage

operations only if all the required configurations are in place, and most of the

required configurations are already in place immediately after installation.

The Legato Single Server Version client/server technology uses a Resource

Allocation Protocol (RAP) whereby configurations are maintained as a set of

internal resources. There are several different types of resources—for example,

the Client, Server, Device, and Pool resources.

Legato Single Server Version configuration is a process of creating, modifying,

and deleting the required resources, using the Administrator program or

available commands. Each resource also has its own components known as

attributes, to which values are assigned.

For example, the value of the Name attribute of a resource defines the name of

that particular resource. When creating a new resource, assign a unique name

to that resource by assigning a unique value to its Name attribute.

• On a UNIX system, a resource is represented by a window in the

Administrator program. A resource attribute is represented by a field,

radio button, or check box in the window.

• On a Windows system, a resource is represented by a dialog box in the

Administrator program. A resource attribute is represented by a text box,

drop-down list, or similar component in the dialog box.

Before a backup device attached to the Oracle Server can be used, a Device

resource must be configured for it. An important step in Legato Single Server

Version configuration for Oracle operations is creating the required resource

for each attached storage device. By modifying the set of resources maintained

by Legato Single Server Version, the product performance and functionality

can be modified.

Legato Single Server Version maintains all the information about its

configured resources in an online resource database file, as shown in Figure 1 on

page 21.

Table 1 on page 43 lists the main types of resources that Legato Single Server

Version uses for Oracle data storage management.
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The resource types listed in Table 1 are the only ones that enable Legato Single

Server Version functionality for Oracle data storage. Legato Single Server

Version does not use or support other types of resources, available with the

Legato NetWorker product. For example, Legato Single Server Version does

not support the Autochanger and Schedule resources.

Some of the resources described in Table 1 exist as attributes of other resources.

The interdependent relationships of these resources affect the order in which

the resources must be configured. A component resource must be defined

before it can be listed as an attribute of another resource.

Figure 10 on page 44 shows the dependencies between the resources. A

resource with an outgoing arrow is both an independent resource itself and an

attribute of the resource where the arrows end.

Table 1. Legato Single Server Version Resource Types

Resource Type Description

Client Identifies the Oracle Server as the backup client and
specifies the policies used for the Oracle backup data
management.

Device Describes a storage device connected to the Oracle Server
that can be used for the Oracle backup and restore
operations.

Group Lists the specifications for the automatic bootstrap backup.

Label Template Provides instructions for creating a label for a storage
volume. Each storage volume belongs to a volume pool
(represented by a Pool resource), and each pool has a
specific label template associated with it.

Policy Defines a time period for Legato Single Server Version to
use for managing the backup data life cycle.

Pool Names a collection of backup volumes and specifies the
criteria that Oracle data must meet to be written to the
collection of volumes.

Server Identifies the Legato Single Server Version characteristics.
(Only one Server resource can exist per Legato Single
Server Version installation.)
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Overview of Legato Single Server Version Operations
Figure 10. Resource Configuration Dependencies

For example, a Policy resource must be defined for a browse or retention policy

before that policy can be assigned as an attribute in a Client resource. Also, a

label template named File cannot be assigned to a Pool resource until the Label

Template resource named File has been created.

After installation, Legato Single Server Version has a set of preconfigured

resources of the types listed in Table 1 on page 43 that are available for

immediate use. These preconfigured resources and their default attribute

values are described in "Configuration Roadmap" on page 69. That section also

explains the additional resource configurations required before Legato Single

Server Version can perform Oracle backups and restores.

Overview of Legato Single Server Version Operations
Figure 11 on page 45 illustrates a simplified model for the Oracle backup

operation using Legato Single Server Version. During a backup, Oracle Server

processes create the Oracle data backup sets and pass them to Legato Single

Server Version. Legato Single Server Version writes the Oracle data to backup

volumes in the storage devices and tracks the location and status of the backup

data on the volumes.
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Figure 11. Data Backup Flow

Legato Single Server Version tracks the location and status of the Oracle

backup data, using two special online indexes—the client index and media

index. The client index contains information on each Oracle data object backed

up. The media index contains information on the location and content of each

backup volume as well as on the life cycle status of the data on each volume.

At the end of an Oracle backup, Legato Single Server Version adds entries for

that backup to the client index and media index files.

• To the client index, it adds information on the specific Oracle data that

was backed up.

• To the media index, it adds information on the location of the backup

volume and the Oracle data written to that volume.

Legato Single Server Version is also preconfigured to perform an automatic

bootstrap backup, every day at 3:33 a.m. The bootstrap is a special backup set

essential for disaster recovery procedures on the Legato Single Server Version

computer. The bootstrap contains the information needed to restore the online

indexes and resource configuration files to the state just before the bootstrap

was created.

Legato Single Server Version can perform Oracle backup operations only after

the required resources are configured and the required storage volumes are

labeled and mounted for the backup:

• A Client resource must be configured to identify the Oracle Server as the

backup client.

Media
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Managing the Data Life Cycle
• A Server resource must be configured to:

– Identify the Legato Single Server Version computer.

– Specify the parallelism or maximum number of concurrent backup

data streams.

– Specify the users who have the Administrator privileges required to

modify the Legato Single Server Version configuration.

• A Device resource must be configured for each device to be used for

Oracle backups or restores.

• A storage volume must be labeled and mounted in each device to be used

for backup. When labeling a volume, Legato Single Server Version

assigns the volume to a volume pool, for which a Pool resource must

exist.

For more information on the required Legato Single Server Version

configurations, see "Configuration Roadmap" on page 69.

Managing the Data Life Cycle

Two important attributes of the Client resource are the Browse Policy and

Retention Policy attributes. Legato Single Server Version uses the browse and

retention policies for managing the Oracle backup data life cycle. These

policies specify how long the Legato Single Server Version maintains Oracle

backup data for recovery.

After installation, Legato Single Server Version contains a preconfigured

Client resource for the Oracle Server, including the Browse Policy attribute set

to a year and the Retention Policy attribute set to a decade.

Important: Legato recommends that the default values of the Browse Policy

and Retention Policy attributes in the Client resource not be modified. The

browse policy period of a year ensures that the save sets retain a browsable

status and the Oracle data can be restored using RMAN for at least a year. Also,

with the retention policy of a decade, the backup volumes do not become

recyclable for at least ten years.
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Browse Policy Considerations

The browse policy determines how long the client index maintains the

information on an Oracle backup. As long as the browse policy period for a

particular backup set has not been exceeded, the entry for that backup remains

in the client index. And, as long as there is an entry for the backup in the client

index (and in the Oracle Recovery Catalog or control file), RMAN can be used

to restore the backup set from the backup volume.

After the browse policy period for a backup set has been exceeded, Legato

Single Server Version automatically deletes the entry for that backup from the

client index. When the entry has been deleted, the backup cannot be restored

using RMAN. However, the scanner program can be used to recreate the

backup’s entries in the client index and media index, to enable recovery using

RMAN.

Note: The NSR_BROWSE environment variable can be used to specify the

browse policy. For more information, see "Legato Single Server Version

Environment Variables" on page 109.

Retention Policy Considerations

The retention policy determines the minimum period of time that the media index
maintains the information on Oracle backup data. The media index tracks the

Oracle backup sets on the volumes. The retention policy is different from the

browse policy in that its expiration does not trigger the automatic deletion of

entries from the media index.

After the retention policy period for a backup save set has been exceeded,

Legato Single Server Version marks the status of that save set as recyclable, but

retains its entry in the media index. When all the backup sets on a volume are

marked recyclable, Legato Single Server Version changes the volume mode to

recyclable. The volume is then eligible for automatic relabeling.

Legato Single Server Version deletes a volume from the media index only

when either:

• The volume is relabeled, or

• The volume’s entries are deleted manually in the Volumes window or tab

in the Administrator program.

Note: The NSR_SAVESET_EXPIRATION environment variable can be used to

specify the retention policy. For more information, see "Legato Single Server

Version Environment Variables" on page 109.
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Tracking the Save Set and Volume Status
Additional Client and Media Index Considerations

If a backup save set has passed its browse policy and/or retention policy and

has become recyclable, the scanner program can be used to rebuild the client

index and media index entries for the backup set. When the index entries are

rebuilt, the backup save set can be recovered using RMAN.

When Legato Single Server Version relabels a volume, all entries for the

volume’s backup sets are deleted from the media index. When a volume is
relabeled, the data on the volume can no longer be recovered. For more information

on volume operations, see "Volume Operations" on page 95.

Note: When Legato Single Server Version relabels a volume for reuse within

the same volume pool, the volume identification (the name as it appears in the

volume label) remains unchanged. However, the information that Legato

Single Server Version needs to locate and access the data on the volume is

destroyed, and the scanner program is no longer an option. At this point, the

volume is ready for new data. All existing data is inaccessible and will be

overwritten.

All entries for a volume’s backup save sets are also deleted from the media

index when the volume is deleted manually. This type of manual deletion can

be performed in the Volumes window or tab in the Administrator program.

For more information, see "Volume Operations" on page 95.

The scanner program can still be used to enable data recovery from a manually

deleted volume. The scanner program can retrieve the information needed to

re-create entries in the client index and media index. When the scanner
program has re-created the index entries, a user with the proper permissions

can recover data from the volume using RMAN.

For more information on the scanner program, refer to these sources:

• scanner entry in the Legato Command Reference Guide (see "Legato

Command Reference Guide" on page 39)

• scanner man page on UNIX (see "UNIX Man Pages" on page 37)

• "Appendix C: scanner Program" on page 189

Tracking the Save Set and Volume Status

In its system of tracking the status of storage volumes and the Oracle backup

save sets on them, Legato Single Server Version assigns a "status" value to each

backup save set (or "save set") and a "mode" value to each storage volume.
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Save Set Status

Table 2 on page 49 shows the possible values that Legato Single Server Version

can assign for a save set status.

As long as a save set remains in the client index, its status is browsable.

After Legato Single Server Version deletes the save set from the client index,

Table 2. Save Set Status Values

Status Value Meaning Description

abort aborted The backup for this save set was aborted
manually, or a crash occurred during the
operation. This save set is considered
immediately eligible for recycling.

brows browsable The browse policy for this save set has not
expired. The files in this save set retain entries
in the client index. All the files can be restored
using RMAN.

inpro in progress This save set is currently being backed up.

recov recoverable The browse policy for this save set has
expired, but the retention policy has not
expired. The files in this save set no longer
have entries in the client index but do have
entries in the media index. The files can be
restored using the scanner program only.

recyc recyclable The retention policy for this save set has
expired, but the files in this save set still have
entries in the media index. The files can be
restored using the scanner program only.

scann scanned-in The client index entry for this save set was
restored using the scanner program. The
policies were reset to the values that were
applied when the save set was created. For
more information, see "Appendix C: scanner
Program" on page 189.

susp suspect An attempt to restore this save set failed. The
restore operation could not read all the blocks
of the save set, for example, if there was a bad
spot in the tape.
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Tracking the Save Set and Volume Status
its status changes from browsable to recoverable, and the save set cannot be

restored directly using RMAN.

The status of a save set remains recoverable until its retention policy

expires. Then, the save set status changes from recoverable to recyclable.

When all the save sets on a volume change status to recyclable, the mode of

the volume changes to recyclable. For more information on volume modes,

see "Volume Modes" on page 50.

When the status of a save set is either recoverable or recyclable, the save set

can be restored from its storage volume using the scanner program. The

scanner program can be used to re-create a save set’s entries in the client

index and enable file recovery using RMAN.

For more information on how to view the save set status in the

Administrator program, see "How to View Save Set Information" on

page 98.

Volume Modes
Table 3 on page 50 shows the possible values that Legato Single Server

Version can assign for a volume mode.

Table 3. Volume Mode Values (Part 1 of 2)

Mode Value Meaning Description

appen appendable The volume contains empty space. Oracle
data that meets the criteria for the pool to
which the volume belongs can be backed
up (appended) to the volume.

man manual recycle The volume is exempt from automatic
recycling. The mode can only be changed
manually in the Volumes window or tab in
the Administrator program. For more
information, see "How to Change the Mode
of a Volume" on page 103.

(R) read-only The save sets on the volume are considered
read-only. The mode can only be changed
manually in the Volumes window or tab in
the Administrator program. For more
information, see "How to Change the Mode
of a Volume" on page 103.
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Use the Administrator program to see a list of all the Oracle backup volumes

and their modes, as well as the save sets on each volume and their status. For

more information on how to view volume modes in the Administrator

program, see "How to View Volume Information" on page 96.

For more information on how Legato Single Server Version manages Oracle

backup volumes, see "Chapter 3: Device and Media Management" on page 81.

The Administrator Program
Configure and administer Legato Single Server Version using one of the

following interfaces:

• Graphical Administrator program (nwadmin)

• Character-based administration interface (nsradmin)

• Command line interface

The Administrator program provides a graphical interface for connecting to

and configuring Legato Single Server Version and its attached tape devices

and volumes. The Administrator program can also be used to monitor the

status of Oracle backup and restore operations as well as the status of Oracle

backup volumes and the backup sets stored on them.

recyc recyclable The save sets on the volume have exceeded
both the browse and retention policy
periods. The volume is eligible for
automatic recycling. (Legato Single Server
Version must relabel the volume before it
can overwrite it.)

full full The volume is full. There is no more space
for data on the volume. The save sets on
the volume have not yet exceeded the
browse and retention policy periods.

Table 3. Volume Mode Values (Part 2 of 2)

Mode Value Meaning Description
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Administrator Privileges
Important: The Administrator program cannot be used to administer a Legato

NetWorker or other server on the same network. The Administrator program

can only be used to configure and administer Legato Single Server Version.

During the Legato Single Server Version installation, the Administrator

program is automatically installed on the Oracle Server computer. The

Administrator program can also be installed and run on a separate Windows

computer on the same network as the Oracle Server.

Note: Oracle Server software is not required on a separate Windows computer

that contains the Administrator program only.

For information on how to use the Administrator program, see the following

sections:

• "Administrator Privileges" on page 52

• "TCP/IP Network Requirements" on page 53

• "Legato Single Server Version Connectivity" on page 53

• "The Administrator Program on UNIX" on page 55

• "The Administrator Program on Windows" on page 60

Note: Configuration and management tasks performed in the Administrator

program can also be performed using either the character-based interface

(nsradmin program) or Legato Single Server Version commands at the

operating system command line. For more information on these alternative

options, see the following sections:

• "Character-Based Interface (nsradmin)" on page 69

• "Command Line Interface" on page 69

Administrator Privileges

Only users listed in the Administrator attribute in the Server resource have

permission to make changes to the Legato Single Server Version configuration.

Users who do not have Administrator privileges can start and use the

Administrator program, but are not able to make configuration changes. For

more information on adding Administrators and Administrator privileges, see

"Server Access Management" on page 71.

Note: On Windows, a member of one of the local groups listed in the

Administrator list text box must log on locally in order to configure Legato

Single Server Version on the local computer.
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TCP/IP Network Requirements

The following requirements for TCP/IP network communication must be met

before the Administrator program can be used:

• The Legato Single Server Version hostname must be added to the Domain

Name System (DNS) file that contains the names and aliases of the

servers (hosts) on the network, or to the local hosts file located in:

– /etc on UNIX

– %SystemRoot%\system32\drivers\etc on Windows

Note: If DNS is used, reverse lookup must be correctly configured.

• If the Legato Single Server Version is a dynamic host configuration

protocol (DHCP) client, it must use a reserved address.

• If DHCP is used with dynamic addresses, DHCP must be synchronized

with DNS.

• On Windows, use the same name for the Legato Single Server Version

TCP/IP hostname and the Windows computer name.

After these requirements are met, the Administrator program can be run

according to the information in one of these sections:

• "The Administrator Program on UNIX" on page 55

• "The Administrator Program on Windows" on page 60

Legato Single Server Version Connectivity

The Administrator program enables a user to connect to and monitor Legato

Single Server Version on a separate computer. For example, the Administrator

program can be installed on a Windows computer that is separate from the

Legato Single Server Version computer.

• On UNIX, the program automatically connects to a local Legato Single

Server Version or the default backup server.

• On Windows, the program displays icons for Legato Single Server

Version and the NetWorker servers and clients in the network subnet, and

for any remote servers being monitored.

To connect to Legato Single Server Version in order to configure or monitor its

activities, use the instructions in "How to Establish a Server Connection" on

page 54.
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Legato Single Server Version Connectivity
Note: Only a user with Administrator privileges for Legato Single Server

Version can perform configuration tasks and issue commands from the

Administrator program. A user without Administrator privileges can only

monitor the server’s activities. For more information on Administrator

privileges, see "Server Access Management" on page 71.

How to Establish a Server Connection

To connect to Legato Single Server Version:

• On UNIX:

1. Run the Administrator program, as described in "The Administrator

Program on UNIX" on page 55.

2. Select Server>Change to open the Change Server window.

3. In the Server list, select the Legato Single Server Version hostname. If

the name is not listed, do one of the following:

– Click Update Server List to refresh the list.

– Enter the Legato Single Server Version hostname in the Server

field.

4. Click OK.

• On Windows:

1. Run the Administrator program, as described in "The Administrator

Program on Windows" on page 60.

2. Open the Connect To dialog box by doing one of the following:

– Click the Connect to Server toolbar button.

– Select Operations>Connect to Server.

– Right-click a server icon in the Network or Messages window

and select Connect to This Server.

3. Enter the Legato Single Server Version hostname in the Server text

box.

4. Click OK.

The Administrator program displays information for the Legato Single Server

Version that is connected.

How to Monitor a Remote Server from Windows

When the Administrator program is started on Windows, the servers and

clients being monitored are usually limited to the subnet. However, a Legato

Single Server Version outside of the subnet can also be monitored in the

Network and Messages windows by using the Remote Servers feature.
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To monitor a remote Legato Single Server Version in the Network window:

1. Select Options>Remote Servers to open the Remote Servers dialog box.

2. In the Server Name text box, enter the name of the remote Legato Single

Server Version host, then click Add.

3. Click OK.

The Legato Single Server Version hostname is added to the list. Legato Single

Server Version will be monitored as long as the name remains listed.

To stop monitoring a remote Legato Single Server Version:

1. Select Options>Remote Servers to open the Remote Servers dialog box.

2. Select the appropriate Server name.

3. Click Remove.

How to Close a Server Connection

To disconnect and close a Legato Single Server Version connection:

• On UNIX, select File>Exit to exit the Administrator program.

• On Windows, close the Server window and click OK when prompted.

The server icon remains in the Network window and appears in the

Connect To dialog box until the Administrator program is exited.

The Administrator Program on UNIX

The following sections describe how to use the Administrator program on

UNIX to connect to and configure Legato Single Server Version and its

resources:

• "How to Start the Administrator Program" on page 56

• "Administrator Toolbar" on page 58

• "How to Display Hidden Attributes" on page 59

• "Legato Single Server Version Resources" on page 59
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How to Start the Administrator Program

To start the Administrator program and connect to Legato Single Server

Version, use one of the following methods:

• If the Legato Single Server Version installation directory is in the system

PATH environment variable, enter the nwadmin command at the

command line prompt:

# nwadmin -s server-name &

where server-name is the Legato Single Server Version hostname.

• If the Legato Single Server Version installation directory is not in the

system PATH environment variable, enter the complete pathname of the

nwadmin command at the command line prompt, for example:

# /usr/sbin/nwadmin -s server-name &

where server-name is the Legato Single Server Version hostname.

If there are problems starting the Administrator program, consider the

following possibilities:

• The Legato Single Server Version software cannot resolve the hostname

into a network address.

• A connection is being attempted to a computer not currently running the

Legato Single Server Version software.

• The Legato Single Server Version host is unreachable or down.

For more information, see the troubleshooting information in

"Appendix B: Troubleshooting and Error Messages" on page 171.

Most Legato Single Server Version administration tasks can be performed in

the Administrator program. The Administrator program contains the program

menus, the toolbar, and the windows shown in Figure 12 on page 57.
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Figure 12. Administrator Program Interface

Server Information

The server information area displays information regarding the Legato Single

Server Version that is currently connected.

Message Area

The message area displays the information listed in Table 4 on page 57.

Table 4. Message Area (Part 1 of 2)

Window Description

Devices window Displays information about the devices configured

for the current server.

Sessions window Displays progress messages. This information is

also written to the /nsr/logs/daemon.log file.

Server
information

Message
area

Toolbar

Menus
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The nsrwatch command line program also provides this information in a

character-based format. For more information on the nsrwatch program, refer

to the nsrwatch man page on UNIX, or the Legato Command Reference Guide.

Administrator Toolbar

The Administrator program’s toolbar enables a user to perform common tasks

by clicking toolbar buttons. Table 5 on page 58 describes the function of each

supported toolbar button.

Messages window Displays completion messages. This information is

also written to the /nsr/logs/messages file.

Pending window Displays information on why a backup cannot

progress, along with requests to mount tapes and

other conditions that require intervention.

Table 5. Administrator Toolbar Functions (Part 1 of 2)

Button Name Function

 Change Server Opens the Change Server dialog box to

connect to a new server.

 Mount Mounts the device selected in the

Devices window.

Unmount Unmounts the device selected in the

Devices window.

Label Labels the device selected in the Devices

window.

Table 4. Message Area (Part 2 of 2)

Window Description
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How to Display Hidden Attributes

By default, the Administrator program leaves some attributes hidden from

view in the resource windows. Hidden attributes provide additional

functionality and control over resources.

To display hidden attributes, select Details>View in a particular resource

window.

Legato Single Server Version Resources

Each resource has a corresponding window or dialog box opened by selecting

menu commands. Because resource attributes are created and displayed

dynamically in the Administrator program, the same resource window or

dialog box might show different attributes depending on the Legato Single

Server Version that is currently connected.

For more information on each attribute, select On Window from the Help

menu.

For more information on Legato Single Server Version resources, see the

following sections:

• "Legato Single Server Version Architecture" on page 41

• "Configuration Roadmap" on page 69

Indexes Opens the Indexes window, which

displays information about the online

indexes.

Volumes Opens the Volumes window, used to

managed volumes.

Table 5. Administrator Toolbar Functions (Part 2 of 2)

Button Name Function
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The Administrator Program on Windows

The following sections describe how to use the Administrator program on

Windows to connect to and configure Legato Single Server Version and its

resources:

• "How to Start the Administrator Program" on page 60

• "Administrator Program Features" on page 62

• " Setup Wizard" on page 65

• " Legato Single Server Version Resources" on page 66

How to Start the Administrator Program

To start the Administrator program and connect to Legato Single Server

Version:

1. Use one of these methods to start the program:

• From the taskbar, select Start>Programs>NetWorker

Group>NetWorker Administrator.

• If the Legato Single Server Version installation directory (C:\Program
Files\nsr\bin, by default) is in the system path, enter the nwadmin
command at the command line prompt:

nwadmin -s server-name

where server-name is the Legato Single Server Version hostname.

• If the Legato Single Server Version installation directory is not in the

system path, enter the complete pathname of the nwadmin command

at the command line prompt, for example:

C:\Program Files\nsr\bin\nwadmin -s server-name

where server-name is the Legato Single Server Version hostname.

The Administrator program window appears.

2. Click the Connect to Server toolbar button.

3. In the Connect to Server dialog box, enter the name of the Legato Single

Server Version host and click OK.

The Server window opens (with the Configure tab active). The Server

window displays the name of the Legato Single Server Version host that is

currently connected.
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If there are problems starting the Administrator program, consider the

following possibilities:

• The hostname cannot be resolved into a network address.

• A connection is being attempted to a computer not currently running the

Legato Single Server Version software.

• The Legato Single Server Version host is unreachable or down.

For more information, see the troubleshooting information in

"Appendix B: Troubleshooting and Error Messages" on page 171.

Most administration tasks can be performed in the Administrator program.

The Administrator program contains the program menus, the toolbar, and the

windows shown in Figure 13 on page 61.

Figure 13. Administrator Program Interface

Network Window

The Network window displays the Legato Single Server Version and

NetWorker clients and servers currently on the network.This window can be

changed to display all the computers that are on the network.

Network
window

Server
window

Messages
window

Toolbar

Menus
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Server Window

The Server window displays information regarding the Legato Single Server

Version that is currently connected.

• If there is more than one Server connected, multiple Server windows

appear.

• If there is no connection to a Server, no Server window appears.

The Server window contains information in the following tabs:

• Configure — Contains buttons for creating and configuring the Server,

Client, Device, and other resources. Buttons for unsupported features (for

example, staging) are dimmed.

• Monitor — Displays messages about the backup devices.

• Volumes — Displays messages about the volumes, including volume

names, sizes, modes, and other information.

• Indexes — Displays messages about the client indexes, including index

names, sizes, and percentages used.

Messages Window

The Messages window displays messages in the Pending Messages tab about

server activity and performance that might require intervention.

Note: Legato Single Server Version does not use the Group Status and Clone

Status tabs.

Administrator Program Features

The following sections describe the main features of the Administrator

program display and how to customize those features:

• "Administrator Toolbar" on page 62

• "How to Display Hidden Attributes" on page 64

• "How to Change the Server Information Refresh Rate (Polling Interval)"

on page 64

• "How to Modify the Toolbar" on page 65

• "How to Sort Tables by Category" on page 65

Administrator Toolbar

The Administrator program’s toolbar enables a user to perform common tasks

by clicking toolbar buttons.
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Note: Depending on the window that is currently open, certain buttons might

be disabled.

Table 6 on page 63 describes the function of each supported toolbar button.

Table 6. Administrator Toolbar Functions

Button Name Function

Show NetWorker Servers

and Clients

Displays Legato Single Server Version

and NetWorker servers and clients in the

Network window.

 Show Entire Network Displays the entire network in the

Network window.

 Connect to Server Opens the Connect To dialog box to

connect to Legato Single Server Version.

 Create Item Opens the Create dialog box to create a

new resource. This button is enabled

only when a specific resource window is

open and the resource type is selected.

Edit Item Opens the Edit dialog box to edit the

attributes of a specific resource. This

button is enabled only when a specific

resource window is open and the

resource type is selected.

 Delete Item Deletes a specific resource. This button is

enabled only when a specific resource

window is open and the resource type is

selected.

NetWorker Wizard Starts the Setup Wizard for the active

server. The Setup Wizard enables

simplified configuration of the server

and its clients, storage devices, and

media. For more information, see "Setup

Wizard" on page 65.

Help Topics Click this button to access Online Help

and open the Help Contents dialog box.
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How to Display Hidden Attributes

By default, the Administrator program leaves some attributes hidden from

view in the resource windows. Hidden attributes provide additional

functionality and control over resources.

To display hidden attributes in the resource dialog boxes:

1. Select Options>Customize to open the Customize dialog box.

2. In the Window Configurations tab, select Display Hidden Attributes.

3. Click OK.

How to Change the Server Information Refresh Rate (Polling
Interval)

The polling interval determines how often (in seconds) data is refreshed in

certain windows of the Administrator program. Polling can be set for as short

as five seconds, and as long as 32,767 seconds (approximately nine hours).

A low polling interval value refreshes the data in the status windows more

frequently. However, refreshing the data more often can create more network

traffic and server overhead. On slower networks, the interval between

refreshes can be increased by increasing the polling interval value.

To change the polling interval:

1. Select Options>Customize to open the Customize dialog box.

2. In the Polling Intervals tab, select the appropriate options and click OK.

Table 7 on page 64 describes the Polling Intervals tab attributes and their

functions.

Table 7. Polling Interval Options

To determine the polling and refresh rates for: Select this option:

Resource dialog boxes. A resource window can be manually refreshed

by right-clicking any icon in the window and selecting Refresh from the

pop-up menu.

Primary Polling

The Volumes and Indexes windows. Polling for these windows places a

higher load on the network, so Legato recommends setting a higher

secondary polling value than for primary polling. The Volumes and

Indexes windows can be manually refreshed by right-clicking anywhere

in the window and selecting Refresh from the pop-up menu.

Secondary Polling
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How to Modify the Toolbar

To modify the toolbar:

1. Select Options>Customize to open the Customize dialog box.

2. In the Toolbar tab, set the following options:

• Button Size — Click the appropriate button to set the size of the

toolbar buttons as either large or small.

• Show ToolTips — Select to enable the message boxes that identify the

items under the mouse pointer.

3. Click OK.

How to Sort Tables by Category

Many dialog boxes and windows in the Administrator program (such as the

Volumes window and the Volume Save Sets dialog box) display information

in the form of tables.

To sort a table by any category, click the category heading. Clicking on the

heading again re-sorts the table in reverse order.

Setup Wizard

The Administrator program includes a Setup Wizard that leads a user through

the steps of setting up and configuring Legato Single Server Version. The Setup

Wizard takes advantage of default settings to simplify the setup process and

ensure the maximum reliability of the configuration.

By following the Setup Wizard through the setup and configuration of the

server, client, and any storage devices, a user can learn how to set up Legato

Single Server Version quickly and easily. The Setup Wizard can be used at any

time to add or modify servers, clients, and storage devices connected to the

Legato Single Server Version computer.

To start the Setup Wizard, use one of these methods:

• Click the Wizard button in the Welcome dialog box when the

Administrator program is first started.

• Click the Wizard button on the toolbar.

• Select Wizard from the Help menu.

Each screen of the Setup Wizard describes the actions required for that

particular task. There is also Online Help for each screen to provide additional

information.
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Legato Single Server Version Resources

The following sections describe how to access the Legato Single Server Version

resources and how to use toolbar buttons and menus to create, modify, and

delete the resources.

• "Resource Windows" on page 66

• "How to Open the Edit Dialog Box" on page 67

• "How to Refresh Information in a Resource Window" on page 67

• "Resource Dialog Boxes" on page 68

• "Using the Toolbar to Configure Resources" on page 68

• "Using the Menu Commands to Configure Resources" on page 69

For more information on Legato Single Server Version resources, see the

following sections:

• "Legato Single Server Version Architecture" on page 41

• "Configuration Roadmap" on page 69

Resource Windows

When a resource icon such as the Server Notifications icon is clicked in the

main Administrator window, a resource window appears containing:

• An icon representing Legato Single Server Version

• An icon (known as the main resource icon) representing the resource type

• Individual resource icons under the main resource icon

A resource window appears as shown in Figure 14 on page 67.

The individual resource icons represent all of the individual resources that

were either packaged with Legato Single Server Version or were created after

Legato Single Server Version was installed on the computer. When a new

resource is created, its name and icon appear in the resource window. When a

resource is deleted, it no longer appears in the resource window.
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Figure 14. Server Notifications Resource Window

As shown in Figure 14, the Server icon appears at the top of the window. A

user can right-click this icon and select one of several server tasks that appear.

Below the Server icon is the main resource icon identifying the type of resource

(in this case, a Notifications type of resource). To create a new individual

resource of this type, right-click the resource icon, select Create, and enter the

necessary information in the Create dialog box. The new resource appears in

the list of individual resource icons under the main resource icon.

How to Open the Edit Dialog Box

To open the Edit dialog box for a resource, perform one of these steps:

• Double-click the resource icon.

• Right-click the resource icon and select Edit.

How to Refresh Information in a Resource Window

Legato Single Server Version updates and refreshes resource window icons

automatically, based on the primary polling interval that is set. When an

individual resource is added or deleted, the appropriate resource window

reflects the changes the next time polling takes place.

Server icon
Main resource icon

Individual resource icons
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To refresh a resource window manually:

1. Right-click anywhere in the window.

2. Select Refresh.

For instructions on how to set automatic polling, see "How to Change the

Server Information Refresh Rate (Polling Interval)" on page 64.

Resource Dialog Boxes

Each resource has a corresponding dialog box that appears any time the Create

or Edit menu option is selected for that resource. Because resource attributes

are created and displayed dynamically in the Administrator program, the

same resource dialog box might show different attributes depending on the

Legato Single Server Version that is currently connected.

For more information about each attribute, select Field Help.

Using the Toolbar to Configure Resources

The Administrator program enables a user to create, edit, and delete resources

using toolbar buttons with the various resource icons located in the main

window. Table 8 on page 68 describes the use of the Create Item, Edit Item, and

Delete Item toolbar buttons.

Table 8. Resource Buttons

Button Condition for Use Result

Create Item

When a resource icon is selected

(excluding the main autochanger

icon).

The Create dialog box for that resource

opens. When a resource is created, its icon

appears under the resource icon.

Edit Item

When an individual resource icon

in a resource window is selected.

The Edit dialog box for that resource

opens.

Delete Item

When an individual resource icon

in a resource window is selected.

The individual resource is deleted from the

Administrator program and no longer

appears in the resource window.
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Using the Menu Commands to Configure Resources

The Create, Edit, and Delete options found in the Resources menu function in

much the same way as the toolbar buttons. The conditions for use and their

results are equivalent. For more information, see Table 8 on page 68.

Character-Based Interface (nsradmin)
The character-based interface can be used to perform the same configuration

and management tasks as in the Administrator program.

Note: The Administrator program provides status information similar to that

provided by the nsrwatch program for the character-based interface.

To start the character-based interface, enter the nsradmin command at the

operating system command line prompt:

nsradmin

For more information on how to use the character-based interface, refer to the

nsradmin man page on UNIX or the Legato Command Reference Guide (see

"Legato Command Reference Guide" on page 39).

Command Line Interface
Any configuration or administration task can be performed by entering Legato

Single Server Version commands at the operating system command line. For

information on how to use these commands, refer to the following sources:

• UNIX man pages for individual commands

• Legato Command Reference Guide (see "Legato Command Reference Guide"

on page 39)

Configuration Roadmap
Before configuring the Legato Single Server Version resources, ensure that

Legato Single Server Version is properly installed on the Oracle Server

computer. Legato Single Server Version can be installed either during or after

the Oracle Server software installation. For more information, refer to the

Legato Single Server Version Installation Guide, Release 6.1.
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After installation, Legato Single Server Version contains a number of

preconfigured resources, the two main ones being the Server resource and Client

resource. "Legato Single Server Version Architecture" on page 41 describes

how Legato Single Server Version uses its system of internal resources and

attributes.

The resources must be properly configured before Legato Single Server

Version is used for Oracle data storage management. The resources can be

viewed and configured using the Administrator program, as described in "The

Administrator Program" on page 51.

To configure the required Legato Single Server Version resources:

1. Configure the Server resource as required. Ensure that the correct

parallelism value is specified and the required users have administrative

privileges on the system. See "Configuring the Server Resource" on

page 70.

2. Verify that the Client resource is properly configured. See "Verifying the

Client Resource Configuration" on page 75.

3. Configure a Device resource for each storage device (attached to the

Oracle Server computer) to be used for Oracle backups and restores. See

"Configuring Storage Devices" on page 81.

4. Configure any required Label Template resources for labeling backup

volumes. See "Storage Managements Operations" on page 90.

Note: For information on how to label and mount backup volumes in the

storage devices, see "Volume Operations" on page 95.

5. Verify that the Default Group resource is properly configured for

automatic daily bootstrap backups. See "Legato Single Server Version

Bootstrap Backup" on page 128.

Configuring the Server Resource

After installation, Legato Single Server Version includes a preconfigured

Server resource with attribute settings that influence the performance and

security of backups. The attributes in the Server resource can be modified for

the particular system requirements.

To configure the Server resource:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.
Legato Single Server Version, Release 6.1
Administrator’s Guide70



Chapter 2: Preparing to Use Legato Single Server Version

2

2. Access the Server resource dialog box:

• On UNIX, select Server>Setup Server to open the Server dialog box.

• On Windows, in the Configure tab of the Server window, click the Set

Up Server icon to open the Set Up Server dialog box.

3. In the Parallelism attribute, specify the maximum number of backup data

streams that Legato Single Server Version allows to arrive concurrently.

Legato Single Server Version supports up to four concurrent data streams.

To increase the efficiency of the storage devices, back up multiple data

streams at the same time.

4. In the Administrator attribute, specify all the users that should have

Administrator privileges for Legato Single Server Version. For the proper

format of a user name in the Administrator attribute, see Table 9 on

page 74.

For more information on Administrator privileges, see "Server Access

Management" on page 71.

5. To enable the device auto-detection feature on Windows NT only, modify

the attribute settings in the Device Configuration tab of the Set Server

dialog box using the instructions in "Device Autodetection and

Configuration on Windows NT" on page 87.

6. Click Apply or OK.

Server Access Management

Some Legato Single Server Version functions require the operator to have

Administrator privileges. Administrators that are authorized to configure the

Server must have their addresses included in the Administrator list in the

Server resource. For more information, see "Administrator Privileges" on

page 73.

Administrator privileges are required to add, modify, or delete

Administrators. Every user or user group listed in the Administrator attribute

in the Server resource has permission to modify the Legato Single Server

Version configuration and delete entries from the online indexes.

If the following error message is received when Legato Single Server Version

configuration changes are attempted, the user name is not included in the

Administrator attribute and the user does not have permission to make

configuration changes:

user user_name needs to be on administrator’s list
Legato Single Server Version, Release 6.1
Administrator’s Guide 71



2

Configuring the Server Resource
Legato Single Server Version attempts to delete an entry in the online index:

• If the RMAN delete command is being used.

• If a running Oracle backup is being canceled according to the procedure

in "Canceling a Running Oracle Backup" on page 131.

Note: For Legato Single Server Version to delete a backup save set entry in the

index, the required Oracle user name must in the Administrator list;

otherwise, the deletion fails. If Legato Single Server Version fails to delete an

entry, RMAN might still delete the corresponding entry in the RMAN catalog,

leaving the Legato Single Server Version index and RMAN catalog

unsynchronized. To resynchronize the index and catalog, issue the appropriate

media management command to manually delete the inconsistent save set

entries from the Legato Single Server Version index.

To enable Legato Single Server Version to delete an entry from the online

index, add the required user name to the Administrator list in the Server

resource:

• For an Oracle Server on UNIX:

– If Net service is used, add the name of the operating system user who

starts Net service.

– If Net service is not used, add the name of the operating system user

who runs RMAN.

• For an Oracle Server on Windows, add the name of the operating system

user who runs the Oracle service (OracleService<oracle_sid>).

How to Add an Administrator

Only a current Administrator can add Administrators. To add an

Administrator:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Access the Server resource dialog box:

• On UNIX, select Server>Setup Server to open the Server dialog box.

• On Windows, in the Configure tab of the Server window, click the Set

Up Server icon to open the Set Up Server dialog box.

3. In the Administrator attribute, enter the additional user or group name.

Note: Each Administrator is listed on a separate line in the Administrator

attribute.
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4. Apply the addition of the new name:

• On UNIX, click Add and then Apply.

• On Windows, click OK.

The new name appears in the Administrator attribute.

For details about valid formats for identifying Administrators, see

"Administrator Privileges" on page 73.

How to Delete an Administrator

Important: Do not delete all Administrators, especially root@server-name on

UNIX or Administrators@server-name on Windows, because that administrator

is required to start Legato Single Server Version daemons and services.

To delete an Administrator:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Access the Server resource dialog box:

• On UNIX, select Server>Setup Server to open the Server dialog box.

• On Windows, in the Configure tab of the Server window, click the Set

Up Server icon to open the Set Up Server dialog box.

3. Select the name to be deleted in the Administrator list box, then click

Delete.

4. Click Apply or OK.

Administrator Privileges

Although any user can view resources in the Administrator program, only

users specified in the Administrator attribute in the Server resource can add to

or change the Legato Single Server Version configuration and delete entries

from the online indexes.

After installation, root@server-name on UNIX and Administrators@server-name
on Windows are the only users authorized to change the Legato Single Server

Version configuration, by default. The Administrator attribute in the Server
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dialog box should include the following entries, depending on the platform

where the Administrator program is running:

• Windows: Administrators@hostname

• UNIX: root@hostname

Note: Legato Single Server Version must be able to convert hostname to a

resolved TCP/IP address.

Important: If the Administrator list must be restricted so that it does not

include root@server-name on UNIX or Administrators@server-name on Windows,

ensure that the Administrator list includes the account that starts the Legato

Single Server Version daemons or services. Normally, this is the system

account. Using system@server-name would allow the proper access to resources

and allow the daemons or services to start.

To give administrative privileges to additional users or user groups, add their

names to the Administrator attribute in the Server resource. On Windows,

Legato Single Server Version recognizes domain names and Microsoft

Windows groups, both local and global, for example:

• Administrators group

• Domain Admins group

In a Windows domain, only the global group is recognized. To find out the

name of the group, run the Windows utility findgrp.exe, available with the

Windows Resource Kit.

On an individual Windows computer, only the local group is recognized,

because there is no “global” group.

User names in the Administrator attribute must be in one of the formats listed

in Table 9 on page 74.

Table 9. Acceptable Administrator Formats (Part 1 of 2)

Acceptable Formats Example

local-group@hostname Administrators@jupiter

global-group@hostname Domain Admins@jupiter

root@hostname root@jupiter
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Important: Using a wildcard before the @ sign grants Administrator privileges

to any account logged onto that computer. Using a wildcard after the @ sign

grants Administrator privileges to any group or account name that precedes

the @ sign, regardless of their location.

Using wildcards in the Administrator list might introduce security problems;

before using them, verify that enterprise security is not compromised.

Note: If the nsradmin interface is used to input these entries, they must be

separated by commas.

Verifying the Client Resource Configuration

After installation, Legato Single Server Version contains a preconfigured

Client resource with attribute settings that define the Oracle Server as a backup

client.

account-name@hostname anyone@jupiter

wildcard@hostname *@jupiter

hostname/wildcard jupiter/*

user@domain-name me@jupiter.com

user@hostname me@jupiter

hostname/user jupiter/me

user@wildcard me@*

wildcard/user */me

user me

Table 9. Acceptable Administrator Formats (Part 2 of 2)

Acceptable Formats Example
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Verifying the Client Resource Configuration
Important: Do not modify the attribute settings in the preconfigured

Client resource.

The Client resource provides the following type of information:

• How long to maintain backup data entries in the client index for recovery

(according to the Browse Policy attribute).

• How long to maintain backup volume entries in the media index for

recovery (according to the Retention Policy attribute).

• How to run the automatic daily bootstrap backup.

To view the Client resource configuration:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Access the Client resource:

• On UNIX:

a. Select Clients>Client Setup to open the Clients window.

b. In the Clients list, select the Oracle Server name.

The Clients window appears as shown in Figure 15 on page 78. The

window shows the supported Client resource attributes. For more

information on the attributes, refer to the Online Help.

• On Windows:

a. In the Configure tab in the Server window, click Manage Clients

to open the Clients window.

b. Right-click the Clients icon with the Oracle Server name, and

select Edit to open the Edit Client dialog box.

The Edit Client dialog box appears as shown in Figure 16 on page 79.

The General tab shows the supported Client resource attributes. For

more information on an attribute, click Field Help.

3. Verify the supported attribute settings:

Note: Legato Single Server Version does not support all the resource

attributes displayed. The following attributes are the only ones supported.

• Name — This attribute lists the hostname of the Oracle Server.

• Browse Policy — This attribute specifies the length of time (one year,

by default) that Legato Single Server Version retains an entry for an

Oracle backup in the online client index.
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Note: If the NSR_BROWSE environment variable is set as described in

"Legato Single Server Version Environment Variables" on page 109, its

value overrides the Browse Policy attribute setting in the Client

resource.

• Group — This attribute specifies the backup group used for the

automatic daily bootstrap backup. The attribute must be set to

Default for the proper bootstrap backup configuration. For more

information, see "Automatic Bootstrap Backup" on page 129.

• Retention Policy — This attribute specifies the minimum length of

time (one decade, by default) that Legato Single Server Version

maintains information about Oracle backup data in the online media

index.

Note: If the NSR_SAVESET_EXPIRATION environment variable is set

as described in "Legato Single Server Version Environment Variables"

on page 109, its value overrides the Retention Policy attribute setting in

the Client resource.

• Save Set — This attribute specifies the pathname of the configuration

file backed up during the automatic daily bootstrap backup.

For more information on how Legato Single Server Version uses the browse

and retention policies to manage Oracle backup data and enable the data to be

restored, see "Overview of Legato Single Server Version Operations" on

page 44.
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Verifying the Client Resource Configuration
Figure 15. Clients Window on UNIX
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Figure 16. Edit Client Dialog Box on Windows

Configuring Other Resources

Before Legato Single Server Version can be used for backups and restores, a

Device resource must be created for each backup device. A backup volume

must also be labeled and mounted in each device.

For more information on configuration and management tasks involving the

backup devices and volumes, see "Chapter 3: Device and Media Management"

on page 81.
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Configuring Other Resources
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Chapter 3: Device and Media Management

This chapter describes how to configure and manage the storage devices and

volumes for Oracle backup and restore operations. It explains how Legato

Single Server Version sorts Oracle data onto volumes grouped into volume

pools and how volumes can be labeled and mounted in the storage devices. It

also describes how Legato Single Server Version tracks Oracle backup volumes

and their data.

This chapter includes the following main sections:

• "Configuring Storage Devices" on page 81

• "Storage Managements Operations" on page 90

• "Volume Operations" on page 95

Configuring Storage Devices
A storage device is a local tape drive that Legato Single Server Version uses to

write Oracle data during a backup and to read Oracle data during a restore

operation. Legato Single Server Version recognizes an attached storage device

only if a Device resource has been configured for it.

Consider the following Legato Single Server Version features when planning

the configuration of the storage devices:

• Support for tape devices only

• Support for up to four storage devices attached to the Legato Single

Server Version computer

• Support for up to four Oracle data streams backing up simultaneously to

the storage devices

• Support for device autodetection on Windows NT only

• No support for autochangers (jukeboxes) or silos
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Preparing for Device Resource Configuration
• No support for high-speed devices

• No support for cloning

Except for autochangers, silos, and high-speed devices, Legato Single Server

Version supports all the same devices as the Legato NetWorker release 6.1

product. For more information on the devices Legato NetWorker supports,

refer to the Legato Compatibility Guide for Hardware at the Legato web site

www.legato.com.

Note: Legato Single Server Version supports device autodetection and

configuration on Windows NT only. For more information, see "Device

Autodetection and Configuration on Windows NT" on page 87.

Preparing for Device Resource Configuration

The Legato Single Server Version installation automatically configures a

Device resource for a default tape device. For more information on Legato

Single Server Version installation, refer to the Legato Single Server Version
Installation Guide.

The Legato Single Server Version configuration must include a Device

resource for each tape device to be used for Oracle backup and restore

operations. Up to four Device resources can be configured. Each tape device to

be used must contain a labeled and mounted volume.

The Administrator program enables a user to view, create, modify, or delete

Device resources. For more information on the Administrator program, see

"The Administrator Program" on page 51.

Note: To be able to create, modify, or delete a Device resource, run the

Administrator program as an Administrator (one of the users listed in the

Administrator attribute of the Server resource). To view resources only, run the

Administrator program as any system user. For more information on

Administrator privileges, see "Server Access Management" on page 71.

Device Preparation on Windows

On Windows, use the Tape Devices program in the Control Panel to install the

device driver for a storage device before configuring the Device resource for the

device. Only devices currently registered with the Windows Registry are

available for use with Legato Single Server Version.
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To determine the devices that are available:

1. Open an MS-DOS window.

2. Change to the Legato Single Server Version binary directory (C:\Program
Files\nsr\bin, by default).

3. Display all the devices currently available by entering the following

command at the operating system prompt:

inquire

In the resulting display:

• Devices that have a Registry entry of \\.\TAPE# are tape devices.

• Devices that have a Registry entry of \\.\PHYSICALDRIVE# are

regular disk drives.

• Some physical hard drives can also have a \\.\PHYSICALDRIVE#

Registry entry but are not compatible with Legato Single Server

Version.

• Any devices not listed, or listed without a Registry entry, are

unavailable to Legato Single Server Version.

If a tape device does not appear in the Windows Registry, consider one of the

following reasons:

• The tape device is not properly installed.

• The device driver is not properly installed.

• The driver might not be compatible with the device. See the device

manufacturer for information on the latest supported drivers.

On Windows 2000, disable RSM for each storage device to be used by Legato

Single Server Version:

1. On the Windows desktop, right-click My Computer and select Manager.

2. On the Computer Management navigation pane (left side of the dialog

box), expand Storage\Removable Storage\Physical Locations.

3. For for each connected device:

a. Right-click the device name and select Properties from the pop-up

menu.

b. In the General tab of the Properties dialog box, ensure that the Enable

Library check box is cleared.

4. Click OK to apply any changes and close the Computer Management

dialog box.
Legato Single Server Version, Release 6.1
Administrator’s Guide 83



3

Device Resource Configuration
Device Resource Configuration

View, create, modify, or delete Device resources using the Administrator

program. For more information on the Administrator program, see "The

Administrator Program" on page 51.

Important: A nonrewinding device name must be specified in a tape device

configuration. When backing up to a tape volume, Legato Single Server

Version writes a file mark on the volume at the end of each backup and uses

the position of that file mark to append data onto the volume during the next

backup. If the device rewinds the volume at the end of a backup, the file mark

position is lost and the existing data on the volume is overwritten during the

next backup.

For information on Device resource procedures, see the following sections:

• "How to View a Device Resource" on page 85

• "How to Create a Device Resource" on page 85

• "How to Edit a Device Resource" on page 86

• "How to Delete a Device Resource" on page 86

Information on the configured storage devices is displayed in the

Administrator program:

• On UNIX, in the Devices window in the Message area. See "Message

Area" on page 57.

• On Windows, in the Monitor tab in the Server window. See "Server

Window" on page 62.

To enable the device autodetection feature on Windows NT only, see "Device

Autodetection and Configuration on Windows NT" on page 87.

For information on labeling, mounting, and using volumes in the configured

storage devices, see "Storage Managements Operations" on page 90.
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How to View a Device Resource

To view an existing Device resource and its attributes using the Administrator

program:

• On UNIX:

1. Select Media>Devices to open the Devices window.

2. Click the device name in the Devices scrolling list. The resource

attributes appear in the lower part of the window.

• On Windows:

1. In the Configure tab in the Server window, click Devices to open the

Devices window.

2. Right-click the icon of the device and select Edit to open the Edit

Device dialog box. The resource attributes appear in the dialog box.

How to Create a Device Resource

To create a Device resource using the Administrator program:

1. Open a window for creating the resource:

• On UNIX:

a. Select Media>Devices to open the Devices window.

b. Click the Create button under the Devices scrolling list.

• On Windows:

a. In the Configure tab in the Server window, click Devices to open

the Devices window.

b. Right-click the main Devices icon and select Create to open the

Create Device dialog box.

2. In the Name attribute, enter the device pathname for the tape device.

3. In the Media Type attribute, select the correct type of media from the list.

4. In the Read Only attribute, select:

• Yes to specify that the device be used only for restoring Oracle data.

• No to specify that the device be used for both backups and restores.

5. In the Target Sessions attribute, select the number of sessions that Legato

Single Server Version will allocate to the device before using the next

device during a backup of multiple backup sets.
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For more information on how Legato Single Server Version uses the Target

Sessions attribute during backups, see "Multiplexing during Oracle

Backups" on page 127.

6. In the Auto Media Management attribute (in the Operation tab on

Windows), select Yes to enable auto media management for the tape

device.

For more information on auto media management, see "Auto Media

Management for Tape Devices" on page 93.

7. Click Apply or OK.

How to Edit a Device Resource

To edit an existing Device resource using the Administrator program:

1. Open the resource window:

• On UNIX:

a. Select Media>Devices to open the Devices window.

b. Click the device name in the Devices scrolling list. The resource

attributes appear in the lower part of the window.

• On Windows:

a. In the Configure tab in the Server window, click Devices to open

the Devices window.

b. Right-click the icon of the device and select Edit to open the Edit

Device dialog box. The resource attributes appear in the dialog

box.

2. Make the required changes to any of these attributes:

• Media Type

• Read Only

• Target Sessions

• Auto Media Management

Note: The Enabled attribute must be set to Yes to ensure that the device is

enabled for Oracle backup and restore operations.

3. Click Apply or OK.

How to Delete a Device Resource

Note: A Device resource cannot be deleted for a device that contains a

mounted volume.
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To delete an existing Device resource using the Administrator program:

• On UNIX:

1. Select Media>Devices to open the Devices window.

2. Click the device name in the Devices scrolling list.

3. Click the Delete button under the Devices scrolling list.

4. Click OK in the dialog box that pops up.

• On Windows:

1. In the Configure tab in the Server window, click Devices to open the

Devices window.

2. Right-click the icon of the device and select Delete.

3. Click Yes in the dialog box that pops up.

Device Autodetection and Configuration on Windows NT

On Windows NT only, the device autodetection and configuration feature can

be enabled. This feature enables Legato Single Server Version to automatically

detect and configure attached SCSI (sequential access) tape devices.

Legato Single Server Version starts an autodetection session as a background

process that automatically looks for new SCSI sequential access tape devices.

When autodetection is complete, Legato Single Server Version creates a Device

resource for each supported device it detects. The Device resources are listed

in the Devices window of the Administrator program. As for other resources,

the attributes can be modified or the Device resources deleted altogether.

Device autodetection also looks at devices with existing Device resources. If an

existing Device resource’s description has changed or if a Device resource is

listed but the device itself cannot be detected by the autodetection process,

Legato Single Server Version displays an error message and the device remains

disabled.

Note: Legato Single Server Version supports up to four configured storage

devices. If device autodetection is enabled and more than four devices are

connected, Legato Single Server Version will use only up to four of the

detected and configured devices.

Device autodetection does not automatically delete inactive or obsolete Device

resources listed in the Devices window. These resources must be deleted

manually. See "How to Delete a Device Resource" on page 86.
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Device Autodetection Enabling Options

When Legato Single Server Version is first installed, the device autodetection

feature is disabled. To enable the device autodetection feature, change the value

of the Search New Devices attribute in the Server resource, located in the Set

Up Server dialog box.

Select one of these values for the Search New Devices attribute:

• Now - Begins device detection immediately. This value reverts to the

previous setting (either At Startup or Never) following the autodetection.

Reset the Search New Devices attribute to this choice each time an

immediate autodetection is to be performed.

• At Startup - Automatically looks for new devices each time the computer

is rebooted, or if the Legato Single Server Version services are restarted

manually.

Note: Ensure that the devices are compatible and the latest device drivers

are installed prior to starting Legato Single Server Version. Device and

driver incompatibilities can degrade or prevent Legato Single Server

Version from properly starting when this feature is enabled.

• Never - Disables the device autodetection feature. This is the default value

of the Search New Devices attribute.

How to Set Device Autodetection

To set autodetection and configuration of devices on Windows NT:

1. Run the Administrator program as one of the users listed in the

Administrator attribute of the Server resource. For more information, see

"The Administrator Program" on page 51.

2. In the Configure tab in the Server window, click Set Up Server to open the

Set Up Server dialog box.

3. In the Device Configuration tab, select the appropriate choice from the

Search New Devices drop-down list:

• Now - Begins device detection immediately. (This value

automatically reverts to its previous setting of either At Startup or

Never following autodetection.)

• At Startup - Automatically looks for new devices each time the

Administrator program starts.

• Never (default) - Disables the device autodetection feature.
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4. Select Yes from the Enable New Devices list to have Legato Single Server

Version automatically enable all devices it detects.

Note: Enable this attribute only if it is certain that all devices detected will

serve Legato Single Server Version--otherwise, another computer’s

devices might be inadvertently misused or reconfigured.

5. Enter the Legato Single Server Version hostname in the Device Host List

list box.

6. Click OK to close the Set Up Server dialog box.

If Now is selected for the Search New Devices attribute, Legato Single Server

Version immediately starts an autodetection session. Otherwise, Legato Single

Server Version must be shut down and restarted for autodetection to occur.

Device Enabling and Configuration Following Autodetection

Some of the devices detected might be owned by other applications. Legato

Single Server Version initially disables and only partially configures the

Device resources that it creates during autodetection, by default.

Note: Speed up and simplify autodetected device configuration by specifying

that Legato Single Server Version automatically enable all new devices. Setting

the Enable New Devices attribute in the Set Up Server dialog box to Yes

instructs Legato Single Server Version to immediately enable any new Device

resources created during the autodetection process. See "How to Set Device

Autodetection" on page 88.

To enable each Device resource manually, open its Edit Device dialog box and

select Yes for the Enabled attribute. For details, see "How to Edit a Device

Resource" on page 86.

To assist in identifying each device, the Edit Device dialog box contains the

Description attribute describing the device. This is a read-only attribute

displaying device information, including the vendor ID, product ID, and

logical unit number (LUN).

After a device is enabled, Legato Single Server Version completes all the

required configuration for the device. Legato Single Server Version gives

default values to other attributes in the Edit Device dialog box. To change any

attribute value, open the Edit Device dialog box and make the change. Once

the devices are enabled and their configuration is complete, Legato Single

Server Version can use the devices for Oracle backup and restore operations.
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Storage Managements Operations
The following sections detail the various components and tasks involved in

the operations of storage volume and pools.

How Legato Single Server Version Uses Pools and Label Templates

A pool is a collection of storage volumes that Legato Single Server Version

groups together according to specific common characteristics. Legato Single

Server Version uses volume pools to sort and store Oracle backup data. It uses

pools in conjunction with label templates to keep track of what data is on

which specific volume.

Every volume belongs to a volume pool. Every volume pool is defined by its

Pool resource. The attributes in the Pool resource act as a filter that Legato

Single Server Version uses to determine which data to write to the volumes in

that pool.

Each pool has a matching label template associated with it. Volumes are

labeled according to the rules of these label templates. Label templates provide

a method for consistently naming and labeling volumes so there is no need to

keep track of how many volumes are used.

A volume label is a unique internal code applied by Legato Single Server

Version that initializes and identifies the volume as part of a specific pool.

Labeling a volume provides a unique name for tracking and recognizing the

media in records stored in the media index. Legato Single Server Version uses

the media index to store information about backup volumes and determine

which volumes are needed for restoring data. For more information on how

Legato Single Server Version uses the media index, see "Overview of Legato

Single Server Version Operations" on page 44.

Legato Single Server Version supports only the preconfigured Default label

template. For more information on label templates, see "Appendix D: Using

Label Templates" on page 195.

When Legato Single Server Version labels a volume, it first verifies that the

volume is unlabeled. Then it labels the volume with the name specified in the

Volume Name attribute, using one of the following:

• The next sequential label from the label template associated with the

pool.

• An override volume name that is entered.
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Important: Applying a new label to a volume, or recycling a volume by

relabeling it, makes any existing data on the volume unavailable for restore.

If a recyclable volume is relabeled from the same pool, the volume label name

and sequence number remain the same, but access to the original data on the

volume is destroyed. The volume becomes available for new data.

While Legato Single Server Version contains several preconfigured volume

pools after installation, it supports the Default volume pool only. For more

information, see "Default Volume Pool" on page 91.

Default Volume Pool

The preconfigured resource for the Default volume pool has the following

attributes:

Name: Default

Enabled: Yes

Pool type: Backup

Label template: Default

Store index entries: Yes

Auto media verify: No

Recycle to other pools: No

Recycle from other pools: No

Note: The Default Pool resource cannot be modified.

To view the Default Pool resource configuration, run the Administrator

program (see "The Administrator Program" on page 51) and perform the

following steps:

• On UNIX:

1. Select Media>Pools in the main Administrator window to open the

Pools window.

2. In the upper part of the Pools window, highlight Default in the Pools

scrolling list. The Default pool attributes are displayed in the lower

part of the window.
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• On Windows:

1. In the Configure tab in the Server window, click Manage Pools to

open the Pools window.

2. Right-click the Default icon and select Edit. The Edit Pool dialog box

opens with the Default pool attributes displayed.

The preconfigured label template associated with the Default pool is also

named Default. The Default Label Template resource has the following

attributes:

Name: Default

Fields: hostname, 001-999

Separator: .

Legato Single Server Version automatically uses this Default label template

when it labels volumes for the Default pool. For example, if its hostname is

jupiter, Legato Single Server Version automatically labels the volumes for the

Default pool as jupiter.001, jupiter.002, jupiter.003, and so on. This default

labeling scheme can be overridden when a backup volume is labeled

manually.

For more information on how to label volumes, see "Volume Operations" on

page 95.

How Legato Single Server Version Uses Volumes during a Backup

When an Oracle backup occurs, Legato Single Server Version tries to match the

characteristics of the save stream to the resource attributes configured for a

pool. If the save stream matches the criteria of a pool configuration, Legato

Single Server Version directs the save stream to a labeled volume belonging to

that pool.

Legato Single Server Version then checks if a correctly labeled volume from the

pool is mounted in a configured tape device.

• If only one volume from the pool is mounted and appendable, Legato

Single Server Version writes the backup data to that volume.

• If more than one volume from the same pool is mounted, Legato Single

Server Version uses the following considerations to select a volume:

– Volume mode

Legato Single Server Version selects a volume using the following

hierarchy:

1. A mounted, appendable volume from the appropriate pool.
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2. A mounted, recyclable volume from the appropriate pool but not

currently in use. (All the save sets on a recyclable volume have

the status recyclable.)

Note: A mounted recyclable volume that belongs to a different

pool will not be recycled. The choice is a new, unlabeled volume.

3. An appendable volume that is not currently mounted in the

device, but is from the appropriate pool.

4. A recyclable volume that is not currently mounted in the device,

but is from the appropriate pool.

– Volume label time (the time when the volume was labeled)

Volumes with the oldest label time are selected before volumes that

were labeled more recently.

– Number of sessions currently being written to a device.

• If Legato Single Server Version cannot find a mounted volume from the

appropriate pool, it performs one of the following actions:

– If auto media management is enabled for a device (in the Device

resource), Legato Single Server Version can automatically label and

mount an unlabeled or recyclable volume that is loaded in the device

and proceed with the backup.

For more information on auto media management, see "Auto Media

Management for Tape Devices" on page 93.

– If auto media management is not enabled for a device, Legato Single

Server Version requests a writable volume by displaying a message

similar to the following in the Pending Messages section:

media waiting (or critical): backup to pool ’Default’
waiting for 1 writable backup tape or disk

Legato Single Server Version displays one of three messages

suggesting that the user mount a volume, relabel a volume, or label a

new volume. It continues to generate messages until the user mounts

an appropriate volume; then it proceeds with the backup.

Auto Media Management for Tape Devices

Legato Single Server Version supports auto media management for tape

devices. The auto media management feature gives automatic control over a

volume loaded in a configured tape device.
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If the auto media management feature is enabled in the Device resource for the

tape device, Legato Single Server Version automatically:

• Labels the volume

• Mounts the volume

• Overwrites a volume it considers unlabeled

• Reuses a recyclable volume that is loaded in the device

Legato Single Server Version considers a volume unlabeled if one of the

following conditions apply:

• The volume has no internal label.

• The volume is labeled with information other than a recognizable label.

• The volume is labeled with a proper label, but the density indicated on

the internal label differs from the density of the device where the volume

is mounted.

Note: Since auto media management can relabel a tape volume with a different

density, it is possible to inadvertently overwrite data that still has value. For

this reason, be careful if tape volumes are shared between devices with

different densities.

If the auto media management feature is not enabled for a tape device, Legato

Single Server Version ignores an unlabeled tape in the device and does not

consider it for backup.

If the auto media management feature is enabled for a tape device, the

following processes occur when a volume becomes full during a backup:

1. Legato Single Server Version issues a notification that it is waiting for a

writable volume. At the same time, it waits for the full, verified volume to

be unmounted.

2. Legato Single Server Version monitors the device, and waits for an

operator to insert another volume into the device.

3. After detecting a volume, Legato Single Server Version checks whether the

volume is labeled. If the volume is already labeled, it mounts the volume.

Legato Single Server Version checks to see whether the newly mounted

volume is a candidate to write data to.

– If so, the write operation continues.

– If not, it waits for a writable volume to continue the backup.

4. If the volume is recyclable and is a member of the required pool, Legato

Single Server Version recycles it the next time a writable volume is needed.
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5. If the volume is unlabeled, Legato Single Server Version labels it when the

next writable volume is needed for a backup.

If a non-full volume is unmounted from a tape drive and auto media

management is enabled, Legato Single Server Version waits for 60 minutes

before it automatically remounts the volume in the drive. This hour delay is

designed to give an operator time to unload the volume after unmounting it.

To enable auto media management for a tape device, modify the Device

resource for the tape device, as described in "How to Edit a Device Resource"

on page 86.

Important: Legato Single Server Version considers volumes that were labeled

by a different application to be valid relabel candidates if auto media

management is enabled. Once Legato Single Server Version relabels a volume,

any data on the volume is lost.

Volume Operations
A configured backup device attached to the Oracle Server must have a labeled

storage volume mounted in it before Legato Single Server Version can use the

device and volume for backup and restore operations. A volume must also be

unmounted in the device before it can be replaced with another volume.

Use the Administrator program to view information about volumes and their

save sets. In the Administrator program, an administrative user can also use

the Volumes window to perform the following volume operations:

• Change a save set status

• Change a volume mode

• Recycle a volume

• Delete a volume from the media index

For information on volume operations, see the following sections:

• "How to View Volume Information" on page 96

• "How to View Save Set Information" on page 98

• "How to Mount a Volume" on page 100

• "How to Label and Mount a Volume in One Operation" on page 100

• "How to Label a Volume without Mounting It" on page 102
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• "How to Unmount a Volume" on page 102

• "How to Find a Volume Name" on page 103

• "How to Change the Mode of a Volume" on page 103

• "Marking a Volume as Full for Off-Site Storage" on page 105

How to View Volume Information

To view volume information:

• On UNIX:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Select Media>Volumes or click the Volumes button to open the

Volumes window.

• On Windows:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Select the Volumes tab in the main Administrator window.

The Volumes tab appears as shown in Figure 17 on page 96.

Figure 17. Volumes Tab

The Volumes window or Volumes tab displays the information for each

backup volume, including the volume name, the amount of data written to the

volume, the percentage currently used, and other topics.

Check the Volumes window or Volumes tab to view the contents of the media

index and as a starting point for changing volume modes, deleting volumes,

or setting locations for the collection of volumes.
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Table 10 on page 97 describes the volume information displayed in the

Volumes window or Volumes tab.

Read-Only Mode

Changing the mode of a volume to read-only prevents new data from being

written to the volume. A read-only volume is not a write-protected volume.

The save sets on a read-only volume are still subject to their browse and

retention policies, and the volume is not protected from being overwritten.

When all the save sets on the volume change status to recyclable, the mode of

Table 10. Volume Information in the Volumes Window or Volumes Tab

Category Description

Name Volume name, which is the same as the name that

appears on the volume label. An (R) at the end of the

name indicates that the volume is read-only.

Pool Name of the pool to which the volume belongs.

Written Exact number of bytes written to the volume.

% Used Estimated percentage of the volume used, based on the

total capacity of the volume according to the Media Type

value specified in the Device resource. When %Used is

full, there is no more space on the volume and the

end-of-tape marker has been reached or an error with the

media has occurred. In contrast, when %Used is 100%,

the Written value equals or exceeds the estimated

capacity of the volume. (However, space may still be

available because the end-of-tape marker has not been

reached.)

Mode One of the possible volume mode values described in

"Volume Modes" on page 50.

Location Location of the volume (entered by the user as a

reminder) that describes a physical location meaningful

within the user’s environment, such as "2nd shelf,

Cabinet 2, Room 42."
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the volume changes to recyclable, and the volume becomes eligible for

automatic recycling.

To change a volume mode, see "How to Change the Mode of a Volume" on

page 103.

How to View Save Set Information

To view save set information:

• On UNIX:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Select Media>Volumes or click the Volumes button to open the

Volumes window.

3. Click a volume name to view save set information for the specific

volume.

• On Windows:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Select the Volumes tab in the main Administrator window.

3. Right-click a volume name in the list of volumes.

4. Select Show Save Sets.

The Volume Save Sets dialog box appears as in Figure 18 on page 98,

displaying information about the save sets on the selected volume.

Figure 18. Volume Save Sets Dialog Box
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The Volumes window or Volume Save Sets dialog box displays information

about all the save sets stored on a volume, including the client name, the save

set name, size, and other categories. The status of a save set can be changed

from here.

Table 11 on page 99 describes the save set information displayed in the

Volumes window or Volume Save Sets dialog box.

How to Change a Save Set Status

To change the status of a save set:

1. Open the Volumes window (on UNIX) or Volume Save Sets dialog box (on

Windows), using the steps described in "How to View Save Set

Information" on page 98.

2. Click the save set name.

3. Select Change Status.

4. Select the appropriate status:

• Normal: Select this status if the save set is suspect but it can be used

for restores.

• Suspect: Select this status to prevent Legato Single Server Version

from using the save set for restores.

5. Click Apply or OK.

Table 11. Save Set Information in the Volumes Window or Volume Save
Sets Dialog Box

Category Description

Client Name of the Legato Single Server Version computer that

created the save set.

Date or Time Date (and time) when the save set was created.

Level For Oracle backups, the level is blank.

Status One of the possible save set status values described in

"Save Set Status" on page 49.

Save Set or Name Pathname of the filesystem containing the save set.
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How to Mount a Volume

To mount a labeled volume:

1. Insert the volume in the storage device, or ensure that the volume is

already present.

2. Run the Administrator program, as described in "The Administrator

Program" on page 51.

3. Mount the volume:

• On UNIX:

a. In the Devices section of the main Administrator window, select

the appropriate device.

b. Select Media>Mount or click the Mount button.

• On Windows:

a. In the Configure tab, click Devices to open the Devices window.

b. Right-click the icon for the device in which to mount the volume,

and select Operations.

c. Click Mount.

After a volume is labeled and mounted, the name of the volume appears

beside the device pathname in the Devices list in the Administrator program.

To perform an unattended backup using a tape device, a labeled volume must

be mounted in the device before being left unattended.

Important: On UNIX, use a nonrewinding tape device only. If a rewinding

device is used, the read/write tape head is repositioned at the start of a volume

in the device, and the existing data on the volume is overwritten. A

nonrewinding device pathname must follow the Berkeley Storage Device

(BSD) semantic rules, for example, /dev/rmt/0mbn. The b in the pathname

satisfies the BSD semantics requirement.

How to Label and Mount a Volume in One Operation

If there is more than one storage device connected, the device to be used for

labeling must be first selected from the Devices list in the Administrator

program.
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Notes:

• Since the volume label is internal and machine-readable, it is a good idea

to put an adhesive label on each volume that matches the internal volume

label.

• Relabeling a volume makes it impossible for Legato Single Server Version

to recover data from that volume.

To label and mount a volume in one operation:

1. Insert a volume in the storage device, or ensure that a volume is already

present.

2. Run the Administrator program, as described in"The Administrator

Program" on page 51.

3. Open the Label window or dialog box:

• On UNIX:

a. In the Devices section of the main Administrator window, select

the appropriate device.

b. Select Media>Label or click the Label button to open the Label

window.

• On Windows:

a. In the Configure tab, click Devices to open the Devices window.

b. Right-click the appropriate device icon, and select Operations.

c. Click Label to open the Label dialog box.

4. In the Pool attribute, select Default.

This action generates a name in the Volume Label attribute. The following

rules apply:

• If the volume is unlabeled, Legato Single Server Version assigns the

next sequential label from the label template associated with the pool.

• If a recyclable volume from the same pool is relabeled, the volume

label name and sequence number remain the same. However, access

to the original data on the volume is destroyed, and the volume

becomes available for new data.

• If a pool is not selected for the volume to be labeled, Legato Single

Server Version automatically applies the label template associated

with the Default pool.

• To create an individual label name not associated with a template,

edit the Volume Label and enter a unique label name.
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5. Select the Manual Recycle attribute to manually recycle the volume.

If the Manual Recycle attribute is enabled when a volume is labeled, the

volume cannot automatically be marked as recyclable according to the

retention policy. When a volume is marked manual recycle, Legato Single

Server Version disregards the assigned browse and retention policies.

Only an Administrator can mark the volume recyclable.

6. Select the Mount After Labeling attribute.

7. Click OK.

Legato Single Server Version automatically labels the volume and mounts it in

the device. After the volume is labeled and mounted, it is ready to receive data.

How to Label a Volume without Mounting It

To label a volume without mounting it, follow the same procedures as for

labeling and mounting in one operation, described in "How to Label and

Mount a Volume in One Operation" on page 100, except deselect the Mount

After Labeling attribute in the Label window or dialog box.

How to Unmount a Volume

To unmount a volume:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Unmount the volume:

• On UNIX:

a. In the Devices section of the main Administrator window, select

the appropriate device.

b. Select Media>Unmount or click the Unmount button.

• On Windows:

a. In the Configure tab, click Devices to open the Devices window.

b. Right-click the appropriate device icon, and select Operations.

c. Click Unmount.

Once the volume is unmounted from the device, the Devices section in the

Administrator window displays that information.
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How to Find a Volume Name

If the adhesive label on a volume is missing or illegible, use one of these

methods to determine the volume name:

• Mount the volume in a storage device. The volume name appears next to

the device name in Administrator program (in the Devices pane of the

Monitor tab on Windows).

For more information, see "How to Mount a Volume" on page 100.

• Mount the volume in a storage device and enter the nsrmm command (as

root user on UNIX) at the operating system command line to determine

the volume name:

nsrmm -pv -f device-name

Note: On UNIX systems, when the nsrmm command includes the

-f device-name option and the device name contains backslashes, a

backslash (escape) character must be used with each backslash. For

example, enter the device name rd=sn1:\\.\Tape0 as

rd=sn1:\\\\.\\Tape0 .

• Load the volume in a storage device and perform the appropriate steps:

– On UNIX:

a. Run the Administrator program, as described in "The

Administrator Program" on page 51.

b. Select Media>Label. In the Label window, the name of the

volume appears in the Volume Name attribute.

c. Click Cancel to close the window without relabeling the volume.

– On Windows:

a. Run the Administrator program, as described in "The

Administrator Program" on page 51.

b. Right-click the device’s icon in the Device window and select

Operations.

c. Click Label. In the Label dialog box, the name of the volume

appears in the Volume Label text box.

d. Click Cancel to close the dialog box without relabeling the

volume.

How to Change the Mode of a Volume

The mode of a volume determines whether Legato Single Server Version can

write to it during a backup. For more information on volume modes, see

"Volume Modes" on page 50.
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A volume is automatically recyclable if all the save sets on the volume are

recyclable. Recyclable save sets have passed the time period designated by the

retention policy.

If the data on a full or appendable volume is not needed, the mode of the

volume can be changed manually to recyclable. Legato Single Server Version

then overwrites the data on the volume the next time it needs a volume for a

backup.

To change the mode of a volume, see the appropriate section:

• "How to Change the Mode of a Volume on UNIX" on page 104

• "How to Change the Mode of a Volume on Windows" on page 104

How to Change the Mode of a Volume on UNIX

To change the mode of a volume on UNIX:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. In the Devices section of the main Administrator window, select the

appropriate device.

3. Select Media>Volumes or click the Volumes button to open the Volumes

window.

4. Select the volume whose mode is to be changed.

5. Select Volume>Change Mode and one of the following values:

– Appendable

– Read Only

– Recyclable

For a listing of the volume modes, see "Volume Modes" on page 50.

6. Select a Mode button and click OK.

The changed volume mode appears in the Volumes window.

How to Change the Mode of a Volume on Windows

To change the mode of a volume on Windows:

1. Run the Administrator program, as described in "The Administrator

Program" on page 51.

2. Select the Volumes tab.
Legato Single Server Version, Release 6.1
Administrator’s Guide104



Chapter 3: Device and Media Management

3

3. Right-click the volume whose mode is to be changed.

4. Select Change Mode to open the Change Mode dialog box.

5. Select a Mode button and click OK.

The changed volume mode appears in the Volumes list box.

Marking a Volume as Full for Off-Site Storage

When removing a volume from a device to store off-site, mark the volume as

full so that Legato Single Server Version will not continue to ask for the

volume.

To mark a volume as full, enter the following nsrmm command (as the root

user on UNIX), where volid is the volume identifier of the volume:

nsrmm -V volid -o full

The mminfo command can be used to determine the volume identifier.

For more information on the nsrmm and mminfo commands, see the

corresponding man pages on UNIX or the Legato Command Reference Guide (see

"Legato Command Reference Guide" on page 39).
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Marking a Volume as Full for Off-Site Storage
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Chapter 4: Backup and Restore Operations

This chapter describes how to set up and run Oracle backups and restores.

Legato Single Server Version enables a user to run Oracle backups and restores

using either the Oracle RMAN command line interface or the OEM Backup

Management Tools.

An important consideration with the Oracle backups is maintaining regular

bootstrap backups to ensure adequate preparation for disaster recovery.

This chapter includes the following main sections:

• "Roadmap for Oracle Backups and Restores" on page 108

• "Legato Single Server Version Environment Variables" on page 109

• "RMAN Commands" on page 114

• "Creating RMAN Scripts" on page 123

• "Performing Oracle Backups or Restores" on page 126

• "Using the OEM Backup Management Tools" on page 127

• "Multiplexing during Oracle Backups" on page 127

• "Completing the Oracle Data Recovery" on page 128

• "Legato Single Server Version Bootstrap Backup" on page 128

• "Canceling a Running Oracle Backup" on page 131

• "Canceling a Nonresponding Oracle Backup" on page 132

• "Monitoring Oracle Backups and Restores" on page 133
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Roadmap for Oracle Backups and Restores
Before running Oracle backups, ensure that the Legato Single Server Version

configurations have been completed according to the "Configuration

Roadmap" on page 69. The Server, Client, and Device resources must be

configured, and the required backup volumes labeled and mounted.

Note: Legato Single Server Version can be used to restore only Oracle data that

has been backed up according to the instructions in this chapter.

To perform an Oracle data backup or restore, use either the RMAN command

line interface or OEM Backup Management Tools:

• To use the RMAN command line interface:

1. Review the Legato Single Server Version environment variables that

can be set in the RMAN script for the backup or restore. See "Legato

Single Server Version Environment Variables" on page 109.

2. Review the RMAN commands that are dependent on the Legato

Single Server Version media management implementation. See

"RMAN Commands" on page 114.

3. Create the RMAN backup or restore script for the Oracle backup or

restore, as required. See "Creating RMAN Scripts" on page 123.

4. Run the Oracle backup or restore using the RMAN command line

interface. See "Performing Oracle Backups or Restores" on page 126.

• To use the OEM Backup Management Tools, see "Using the OEM Backup

Management Tools" on page 127.

Important: The bootstrap is a special backup set essential for disaster recovery

procedures. The bootstrap is not automatically backed up at the end of an

Oracle backup. However, Legato Single Server Version is preconfigured to

perform an automatic daily bootstrap backup. After running a number of

Oracle backups, a manual bootstrap backup should be performed using the

instructions in "Legato Single Server Version Bootstrap Backup" on page 128.

For important additional considerations for Oracle backups, see "Multiplexing

during Oracle Backups" on page 127.

For information on how to keep track of the status of Oracle backups and

restores, see "Monitoring Oracle Backups and Restores" on page 133.
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Note: Oracle database backups must be performed using RMAN scripts, as

described in this chapter. In addition, other important Oracle files (for

example, init<oracle_sid>.ora) should be backed up using appropriate backup

methods. For more information, refer to the Oracle backup and recovery

documentation.

Legato Single Server Version Environment Variables
Legato Single Server Version environment variables described in Table 12 on

page 111 are environment variables that can be set in the RMAN command or

script for an Oracle backup or restore using Legato Single Server Version.

To ensure that the required environment variables are set during an Oracle

backup or restore, set them in one of three ways:

• Using the parms option in either the allocate channel command or the

configure command. See "The parms Option in the allocate channel

Command" on page 121.

Note: Each environment variable set using the parms option in the allocate
channel command must be included in the parms option for each allocated

channel.

• Using the rman send command on the operating system command line.

• Using the send command in the RMAN session or script.

For more information on the RMAN send command, see "The send

Command" on page 116.

Do not mix these three ways of setting the environment variables in the same

RMAN session.

On Windows, when an environment variable is set using the parms option in

either the allocate channel command (as in the RMAN script on page 124) or
the configure channel command used for automatic channel allocation, the
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Administrator’s Guide 109



4

Environment Variable Definitions
value of that variable remains in effect for all subsequent allocated channels

and for all subsequent RMAN sessions until either:

• The Oracle database is shut down; or

• The variable is unset for the channel using the parms option, as in the

following example:

run {
allocate channel t1 type ’SBT_TAPE’
parms ’ENV=(NSR_COMPRESSION=)’;
:
:
release channel t1;

}

Note: This problem on Windows does not occur if the environment variables

are set using the send command in all RMAN sessions.

Using a UNIX setenv command or Windows set command on the operating

system command line to set the NSR_* variables has no effect.

Environment Variable Definitions

Table 12 on page 111 describes all the Legato Single Server Version

environment variables to set in the RMAN session. For each variable, the table

includes a description of the variable, the default value, and the valid values

for the variable.
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Table 12.  Legato Single Server Version Environment Variables in the
RMAN Command or Script (Part 1 of 3)

 Variable Description
Default and Valid
Values

NSR_BROWSE Mandatory if setting a

nondefault browse policy

for an Oracle backup.

Date when the entry for the

backup is to be deleted

from the client index.

• Most appropriate

policy for the client,

as selected by Legato

Single Server Version

(default)

• Valid date in

nsr_getdate(3)
format

NSR_CHECKSUM Optional. Specifies whether

or not Legato Single Server

Version performs

checksumming on the

backup data.

• FALSE (default) =

Legato Single Server

Version performs no
checksumming

• TRUE = Legato

Single Server Version

performs

checksumming

NSR_CLIENT Recommended for all

restores.

Client resource to use for a

backup or restore session.

Might be needed for

disaster recovery.

• Physical host on

which the session

runs (default)

• Valid name of a

Client resource

NSR_COMPRESSION Optional. Specifies whether

or not Legato Single Server

Version performs

compression on the backup

data.

• FALSE (default) =

Legato Single Server

Version performs no
compression

• TRUE = Legato

Single Server Version

performs

compression
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NSR_DEBUG_FILE Optional. Only used for

debugging of Legato Single

Server Version SBT API.

Enables debugging by

specifying the complete

pathname of a file to

receive debugging

information.

• Undefined (default)

• Valid pathname of

the debug file

Note: If undefined, no

debugging information

is generated. If a file

with the specified

pathname cannot be

created, debugging

information is either

directed to default

location or not

generated.

NSR_ENCRYPTION Optional. Specifies whether

or not Legato Single Server

Version performs

encryption on the backup

data.

• FALSE (default) =

Legato Single Server

Version performs no
encryption

• TRUE = Legato

Single Server Version

performs encryption

Table 12.  Legato Single Server Version Environment Variables in the
RMAN Command or Script (Part 2 of 3)

 Variable Description
Default and Valid
Values
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NSR_NWPATHa Mandatory when deleting a

backup from Legato Single

Server Version if both:

• nsrmm binary is in a

nondefault location; and

• /nsr/res/nwora.res file is

not created or does not

contain the correct

location of Legato Single

Server Version binaries.

Complete pathname of the

directory containing the

nsrmm binary.

• Platform-specific

default location of

Legato Single Server

Version binaries

(default)

• Valid pathname of

nsrmm binary

directory, for

example,

/usr/local/bin

NSR_SAVESET_

EXPIRATION

Mandatory if setting a

nondefault retention policy

for an Oracle backup.

Date when the save set

becomes recyclable.

• Most appropriate

policy for the client,

as selected by Legato

Single Server Version

(default)

• Valid date in

nsr_getdate(3)
format

a. As an alternative to setting the NSR_NWPATH variable in the RMAN script, create the

/nsr/res/nwora.res file and add a line containing NSR_NWPATH=nsrmm_dirpath to the file, where

nsrmm_dirpath is the complete pathname of the directory containing the nsrmm program.

For example:

NSR_NWPATH=/opt/networker/bin
This is the only variable entry allowed in the nwora.res file. Other environment variables cannot be

set in the file.

Table 12.  Legato Single Server Version Environment Variables in the
RMAN Command or Script (Part 3 of 3)

 Variable Description
Default and Valid
Values
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RMAN Commands
This section describes RMAN commands that are dependent on the Legato

Single Server Version media management implementation. Review the

following information before using any of the RMAN commands.

• "The delete expired backup Command" on page 114

• "The change...crosscheck and crosscheck Commands" on page 115

• "The pool Option of the backup Command" on page 115

• "Proxy Copy" on page 115

• "The send Command" on page 116

• "The set duplex Command" on page 122

• "The trace Option of the backup Command" on page 123

For more information on these RMAN commands, refer to the appropriate

Oracle Server documentation.

For more information on how to use the main new Oracle9i RMAN features

with Legato Single Server Version, see "Appendix A: Oracle9i Support in

Legato Single Server Version" on page 163.

The delete expired backup Command

To be able to use the delete expired backup command with Legato Single

Server Version, a user must be listed as an Administrator in the Server

resource, as described in "Server Access Management" on page 71.

If the user name is not listed in the Server resource, or there is an authorization

problem when the delete expired backup runs, Legato Single Server Version

fails to delete the required entries in the client index and media index.

Note: If the Legato Single Server Version binaries are located in a nondefault

directory on the Oracle Server host and the /nsr/res/nwora.res file was not
created during the Legato Single Server Version installation, the

NSR_NWPATH environment variable might need to be set in the

/nsr/res/nwora.res file or in the RMAN script. For more information, see "Legato

Single Server Version Environment Variables" on page 109.

In Oracle9i, the change...delete command is deprecated and has been replaced

by the delete... command (including the delete expired backup option).
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The change...crosscheck and crosscheck Commands

For all Legato Single Server Version client index entries that are not browsable,

running the change...crosscheck or crosscheck command in Oracle9i causes

the status of the corresponding backup pieces to change to expired in the

RMAN catalog.

Note: In the RMAN catalog, an expired status for a backup piece indicates that

the Legato Single Server Version browse policy specified for that backup piece

is expired.

The pool Option of the backup Command

Important: Legato Single Server Version does not support the pool option of

the RMAN backup command, with the exception of pool=0.

If any nonzero value is specified for the pool option of the RMAN backup
command, the RMAN session will terminate and Legato Single Server Version

will return the following error message:

sbtbackup: Oracle pool is not supported

For more information on this error message, see "Legato Single Server Version

Error Messages" on page 184.

Proxy Copy

Important: Legato Single Server Version does not support proxy copy.

The proxy only option of the RMAN backup command will cause the Oracle

backup to fail. To perform a regular backup, do not specify the proxy only
option.

As mentioned in the Oracle backup and recovery documentation, the proxy
option of the RMAN backup command will default to a regular backup.
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The send Command

The Legato Single Server Version implementation of the send command

enables a user to set the environment variables described in "Legato Single

Server Version Environment Variables" on page 109.

The send command is supported in Oracle9i. Legato recommends use of the

send command instead of the parms option in the allocate channel or configure
channel command for setting the environment variable values.

The following sections describe the send command syntax and precedence

rules and how to use the send command to set the environment variables.

• "Syntax Rules" on page 116

• "Two Ways to Run the send Command" on page 119

• "The parms Option in the allocate channel Command" on page 121

• "Precedence Rules" on page 122

Syntax Rules

The send command must have the following format:

send  [ device_type ’ device_specifier’  | channel channel_id ]
’NSR_ENV=(var_name1=value1 [ , var_name2=value2,  ...] )’

These sections describe the syntax rules for the two main parts of the send
command:

• "send Command String" on page 116

• "send Command Options" on page 117

send Command String

The command string in the send command is the string inside the quotes,

’NSR_ENV=(var_name1=value1...)’.

Follow these syntax rules for the send command string:

• The maximum length of the command string is restricted by Oracle to 512

bytes, including the terminating NULL.

• The NSR_ENV keyword and the variable names must be all uppercase.
Legato Single Server Version, Release 6.1
Administrator’s Guide116



Chapter 4: Backup and Restore Operations

4

• Between the NSR_ENV keyword and left parenthesis, an equal sign and

spaces are optional. For example, these commands are all correct:

send ’NSR_ENV = (NSR_CLIENT=client1)’

send ’NSR_ENV=(NSR_CLIENT=client1)’

send ’NSR_ENV (NSR_CLIENT=client1)’

send ’NSR_ENV(NSR_CLIENT=client1)’

• The parentheses in the command string are mandatory.

• Inside the parentheses, there must be one or more Legato Single Server

Version environment variable names and the corresponding variable

values.

• Inside the parentheses, spaces are not allowed around the equal signs. A

space before an equal sign becomes part of the variable name. A space after
an equal sign becomes part of the variable’s value.

• Commas separating the var_name=value entries are mandatory.

• Comments are not allowed inside the quotes. In the following example,

“# NSR_CLIENT” is considered the first variable’s name:

run {

allocate channel t1 type ’SBT_TAPE’;
send ’NSR_ENV=(

# NSR_CLIENT=oracle,
NSR_COMPRESSION=TRUE)’;

:

• A send command in an RMAN script can span multiple lines. For

example:

send ’NSR_ENV=(
NSR_CLIENT=oracle,
NSR_COMPRESSION=TRUE)’;

send Command Options

Use the send command with only one of the following options:

• send with no option—only the quoted command string—sets the

environment variables for all allocated channels.

• send device_type ‘SBT_TAPE’ sets the environment variables for all

channels of the backup tape device.

Note: The send command has no effect with device type disk.
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The send Command
• send channel sets the environment variables for the specified channels

only.

In the following sample script, the environment variables are set for channel t1
only, not for channel t2:

run {

allocate channel t1 type ’SBT_TAPE’;

allocate channel t2 type ’SBT_TAPE’;

send channel t1 ’NSR_ENV=(NSR_CLIENT=client1,
NSR_COMPRESSION=TRUE)’;
:

}

Important: Use the device_type or channel option in the send command in an

RMAN script only. Neither option can be used in the send command on the

operating system command line. For more information, see "The send

Command on the Operating System Command Line" on page 119.

Specify the correct option values in the send command:

• device_specifier is the device type as specified in an allocate channel
command in the RMAN script. For a backup tape device, use SBT_TAPE.

• channel_id is the channel identifier as specified in an allocate channel
command in the RMAN script. In the previous sample script, the

identifier is t1.

• var_name1 is the first environment variable name. In the previous sample

script, the first variable name is NSR_CLIENT.

• value1 is the value assigned to the first environment variable. In the

previous sample script, the first value is client1.

• var_name2 is the second environment variable name. In the previous

sample script, the second variable name is NSR_COMPRESSION.

• value2 is the value assigned to the second environment variable. In the

previous sample script, the second value is TRUE.
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Two Ways to Run the send Command

There are two different ways to run the send command:

• As an option of the rman invocation on the operating system command

line, as described in "The send Command on the Operating System

Command Line" on page 119.

• In the run job of the RMAN script, as described in "The send Command

in the RMAN Script" on page 120.

The send Command on the Operating System Command Line

To use the send command as an option of the rman invocation on the

operating system command line, enter the command in the following format:

% rman send ”’NSR_ENV=( var_name1=value1[, var_name2=value2, ...])’”

• If more than one send option appears in the rman command, only the last
send command is executed.

• Follow all the send command syntax rules listed in "send Command

String" on page 116—except for the last rule, which applies only to a send
command in an RMAN script.

• Do not use either the device_type or channel option (see "send Command

Options" on page 117).

• Use two sets of quotes around the command string, each set consisting of

a single and double quote. The single quote can be either before or after

the double quote, but the second set of quotes must be opposite to the

first set. For example, this command is also correct:

% rman send ’”NSR_ENV=( var_name1=value1[, var_name2=value2, ...])”’

Two sets of quotes are required to prevent some operating system shells

(for example, ksh) from treating spaces inside the quotes as meta (special)

characters and attempting to tokenize the string.

• The variable values in the quoted string are applied to all channels

allocated during the RMAN session. These values are applied before any

variable values specified in send commands within the RMAN script

itself. For more information, see "Precedence Rules" on page 122.
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The send Command
In the following example, the NSR_CLIENT environment variable value

(mars.legato.com) is applied to all three channels (t1, t2, t3) allocated in the

RMAN script:

% rman send ”’NSR_ENV=(NSR_CLIENT=mars.legato.com)’”

(RMAN script:)

run {

allocate channel t1 type ’SBT_TAPE’;

allocate channel t2 type ’SBT_TAPE’;

allocate channel t3 type ’SBT_TAPE’;
:

}

The send Command in the RMAN Script

To run the send command in the run job of the RMAN script, enter the

command in the following format, at the required point within the run
command brackets:

send [ device_type ’ device_specifier’ | channel channel_id ]
’NSR_ENV=(var_name1=value1 [, var_name2=value2, ...])’

• Follow all the send command syntax rules listed in "send Command

String" on page 116.

• Use either the device_type or channel option with the send command in

an RMAN script, as described in "send Command Options" on page 117.

• Specify the correct option values in the send command, as described in

"send Command Options" on page 117.

• RMAN commands are run in the order that they appear in the backup or

restore script. For an environment variable value to be in effect during a

backup or restore, put the send command (setting the value) before the

backup or restore command in the script, but after the allocate channel
commands for those channels to which the variable value applies.

• If no channel is allocated when the send command runs, an RMAN error

is produced.
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The following sample RMAN script performs a backup of the entire Oracle

database.

run {

allocate channel t1 type ’SBT_TAPE’;

allocate channel t2 type ’SBT_TAPE’;

send ’NSR_ENV=(NSR_DEBUG_FILE=
C:\Program Files\nsr\applogs\backup.log)’;

backup full filesperset 4
format ’/FULL_%d_%u/’
(database);

release channel t1;

release channel t2;

}

This script is the same as the sample script on page 124, except the environment

variable is set using a single send command instead of the parms option in

each allocate channel command. The single send command sets the

environment variable for each channel.

Note: To prevent backup performance problems, use forward slashes in the

format option in either the RMAN backup command or configure command

to generate backup piece names that resemble UNIX directory names. For

more information on this issue, refer to the Legato Single Server Version Release
Supplement.

The parms Option in the allocate channel Command

If environment variables are set using both the send command and the parms
option in the allocate channel command (not recommended), the variables are

set in the order of the "Precedence Rules" on page 122.

On Windows, when a Legato Single Server Version environment variable is set

using the parms option, the value of that variable remains in effect for all

subsequent allocated channels and for all subsequent RMAN scripts until

certain conditions exist. For more information, see "Legato Single Server

Version Environment Variables" on page 109.
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The set duplex Command
Precedence Rules

Environment variables are set for channels allocated during the RMAN

session in the following order:

1. In the parms option of the allocate channel command in the RMAN script

or in the configure channel command.

2. In the rman send command on the operating system command line.

3. In the send command in the run job of the RMAN script.

To prevent confusion and simplify the task of setting environment variables in

a specific order, do not mix these three ways of setting environment variables

in the same RMAN session.

In the following example, the NSR_CLIENT variable is set in this order:

1. To client2 in the parms option.

2. To client1 in rman send.

3. To client3 in send channel.

% rman send ”’NSR_ENV=(NSR_CLIENT=client1)’”

(RMAN script:)

run {

allocate channel t1 type ’SBT_TAPE’
parms ’ENV=(NSR_CLIENT=client2)’;

send channel t1 ’NSR_ENV=(NSR_CLIENT=client3)’;
:

}

The set duplex Command

Important: Legato Single Server Version does not support the set duplex
command. However, Legato NetWorker Module for Oracle (used in

conjunction with Legato NetWorker) does support the set duplex command.
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The trace Option of the backup Command

The trace option of the RMAN backup command can be set to the value 0, 1,

or 2. The default value of trace is 0.

The output of trace is written to the Oracle sbtio.log file. The output is also

written to the /nsr/applogs/nmo.messages file on UNIX and to the

%SystemDrive%\Program Files\nsr\applogs\nmo.messages file on Windows.

Table 13 on page 123 outlines the conditions traced when the trace option is set

to each of the three valid values.

Creating RMAN Scripts
Create an appropriate RMAN script to perform the desired type of Oracle

backup or restore on the Oracle Server host.

RMAN scripts can be stored as flat ASCII files. Alternatively, if a Recovery

Catalog is used, scripts can be stored in the Recovery Catalog database. For

more information on storing RMAN scripts in the Recovery Catalog database,

refer to the appropriate Oracle backup and recovery documentation.

Table 13. Trace Option Values and Conditions Traced

Trace Value Conditions Traced

0 (default) • All error conditions

1 • All error conditions

• Entry and exit for each SBT function (the Legato

implementation of the Oracle SBT interface)

2 • All error conditions

• Entry and exit for each SBT function (the Legato

implementation of the Oracle SBT interface)

• Values of all function parameters

• First 32 bytes of each read/write buffer
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Creating RMAN Scripts
The following sample RMAN backup script performs a backup of the entire

database and writes RMAN-specific debugging information to the

C:\Program Files\nsr\applogs\backup.log file.

run {

allocate channel t1 type ’SBT_TAPE’
parms ’ENV=(NSR_DEBUG_FILE=
C:\Program Files\nsr\applogs\backup.log)’;

allocate channel t2 type ’SBT_TAPE’
parms ’ENV=(NSR_DEBUG_FILE=
C:\Program Files\nsr\applogs\backup.log)’;

backup full filesperset 4
format ’/FULL_%d_%u/’
(database);

release channel t1;

release channel t2;

}

Note: To prevent backup performance problems, use forward slashes in the

format option in either the RMAN backup command or configure command

to generate backup piece names that resemble UNIX directory names. For

more information on this issue, refer to the Legato Single Server Version Release
Supplement.

Using automatic channel allocation and persistent settings, the backup
command can be run as a stand-alone command. See "Automatic Channel

Allocation" on page 163.

Set the type option in the RMAN allocate channel command to SBT_TAPE.

This value specifies a Legato Single Server Version media management device.

If a device is allocated using the allocate channel t1 type disk command (with

Oracle correctly configured and Legato Single Server Version uninstalled),

backups to disk files using Oracle’s backup implementation are supported.

Obviously, in this case, the parms option has no effect.

The following sample RMAN restore script performs a restore of a tablespace

and writes RMAN-specific debugging information to the specified log files.

run {

allocate channel t1 type ’SBT_TAPE’
parms ’ENV=(NSR_DEBUG_FILE=
C:\Program Files\nsr\applogs\restore_ch1.log)’;
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allocate channel t2 type ’SBT_TAPE’
parms ’ENV=(NSR_DEBUG_FILE=
C:\Program Files\nsr\applogs\restore_ch2.log)’;

sql ’alter tablespace users offline immediate’;

restore (tablespace users);

sql ’alter tablespace users online’;

release channel t1;

release channel t2;

}

To ensure that the required Legato Single Server Version environment

variables are set during an Oracle backup or restore, the variables can be set:

• Using the parms option in either the allocate channel command or the

configure command.

• Using the RMAN send command.

Note: The environment variables cannot be set using another command, such

as setenv or set, on the operating system command line.

For complete information on setting the environment variables in the RMAN

script, including specific issues to consider, see "Legato Single Server Version

Environment Variables" on page 109.

In the RMAN backup script on page 124, the format string FULL_%d_%u
specifies the name of each backup piece. This name can be anything, provided
that each backup piece has a unique name in Legato Single Server Version. Use

substitution variables, such as %d and %u, to guarantee unique names.

• %d specifies the name of the database.

• %u specifies an eight-character name consisting of compressed

representations of the backup set number and time the backup set was

created.

A format string such as FULL or FULL_%d will not generate unique names.

Similarly, the format string FULL_%u will not generate unique names for two

databases being backed up to Legato Single Server Version.

Important: If a backup piece name is not unique, the Oracle backup fails.
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Performing Oracle Backups or Restores
For more information, refer to the following sources:

• For information on how to write RMAN scripts, refer to the appropriate

Oracle backup and recovery documentation.

• For information on how to use the OEM Backup Wizard to generate

RMAN scripts, refer to the Oracle Enterprise Manager documentation.

• For important Legato-specific information on RMAN commands, see

"RMAN Commands" on page 114.

Performing Oracle Backups or Restores
Before starting an Oracle backup or restore, ensure that the required

configurations and scripts are in place.

• The Oracle system must be properly configured. The Oracle Server

should have the Net service configured. If a Recovery Catalog is to be

used, the Recovery Catalog must be set up and the target database

registered.

• Legato Single Server Version must have the required Server, Client,

Device, and Pool resources configured, as described in "Configuration

Roadmap" on page 69.

• The required volume must be labeled (and mounted as required) in a

configured backup device, or—if auto media management is enabled for

a tape device—the tape must be loaded in the tape device for Legato

Single Server Version to use automatically.

• If using an RMAN backup or restore script, the script must be created, as

described in "Creating RMAN Scripts" on page 123.

Start an Oracle backup or restore using the RMAN command line interface on

the Oracle Server host.

For example, if the RMAN backup script on page 124 is stored in the file

/disk1/scripts/full_backup.txt on a UNIX Oracle Server and the Net service has

been configured to connect to the databases payroll and rcvcatdb, the Oracle

backup can be started using the following command:

% rman target internal/oracle@payroll rcvcat
rman/rman@rcvcatdb cmdfile
\’/disk1/scripts/full_backup.txt\’

As another example, if the RMAN restore script on page 124 is stored in the file

/disk1/scripts/restore.txt and the Net service has been configured to connect to
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the databases payroll and rcvcatdb, the Oracle restore can be started using the

following command:

% rman target internal/oracle@payroll rcvcat
rman/rman@rcvcatdb cmdfile \’/disk1/scripts/restore.txt\’

On Windows, the command to run the RMAN script is rman for Oracle9i. For

more information on the rman command line options, refer to the appropriate

Oracle backup and recovery documentation.

Using the OEM Backup Management Tools
The OEM Backup Management Tools can be used instead of the RMAN

command line interface to start an Oracle backup or restore. The OEM Backup

Management Tools include a graphical user interface to RMAN for generating

the required RMAN commands and performing backup and restore

operations.

Important: After the completion of an Oracle backup or restore, the OEM job

queue history displays the status of the job as "failed", even if the backup or

restore completed successfully. This is due to a known problem with OEM.

View the job output to confirm that the backup or restore completed

successfully.

For more information on using OEM Backup Management Tools, refer to the

Oracle Enterprise Manager documentation included with the product kit.

Multiplexing during Oracle Backups
To prevent Legato Single Server Version from multiplexing multiple RMAN

backup sets to one tape drive, only allocate as many RMAN channels as there

are physical tape drives available to Legato Single Server Version.

Allocating more channels than physical tape drives will typically result in

multiplexed RMAN backup sets to one drive, which might significantly add to

the time required to restore from those backups. To clarify, the multiplexing

performed by Legato Single Server Version (when allocating more channels

than physical devices) would be in addition to the multiplexing automatically

performed by RMAN.
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Completing the Oracle Data Recovery
The Target Sessions attribute of a Device resource is described in "How to

Create a Device Resource" on page 85. The Target Sessions value is not a hard
limit on the number of sessions that will run concurrently on the device. It

defines the number of sessions that Legato Single Server Version allocates to a

device before using the next device. The Target Sessions attribute value

defaults to 1 for devices created during the initial Legato Single Server Version

installation as well as for devices created afterwards.

If more concurrent backup sets are created than the number of available

devices, Legato Single Server Version multiplexes those backup sets onto the

available devices, up to the maximum number of sessions specified in the

parallelism value of the Server resource.

Note: The "client parallelism" attribute does not apply to Legato Single Server

Version sessions initiated by RMAN.

Completing the Oracle Data Recovery
After a Legato Single Server Version backup of Oracle data is restored using

the RMAN utility, the data recovery must be completed, if required.

To recover the Oracle data, use the appropriate Oracle commands to apply the

archived redo logs and online redo logs. There are two ways to run the Oracle

recovery commands:

• Include the Oracle commands in the RMAN restore script.

• Run the commands after the RMAN restore script has completed

successfully.

For more information on Oracle data recovery procedures, refer to the

appropriate Oracle backup and recovery documentation.

Legato Single Server Version Bootstrap Backup
Legato Single Server Version is preconfigured to perform a special automatic

backup--the bootstrap backup--every day at 3:33 a.m. The bootstrap save set

contains the information needed to restore the media index and resource

configuration files to the point just before the bootstrap was created.

The bootstrap is a special backup save set essential for disaster recovery procedures on
the Legato Single Server Version host. Legato Single Server Version writes the

bootstrap file to the backup tape and generates a report about the success of

the bootstrap backup. Legato Single Server Version also sends an automatic
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notification to the Administrator about the bootstrap backup and displays the

same information in the Administrator program. The bootstrap information is

sent to a printer on the Legato Single Server Version host.

Note: If Legato Single Server Version is down at the time that the automatic

bootstrap backup is scheduled to run, the backup will run when the system

comes back up.

The bootstrap backup can also be run manually. For example, after running a

number of Oracle backups, run a bootstrap backup manually, to ensure an

up-to-date bootstrap. An up-to-date bootstrap is essential for a complete

disaster recovery on the Legato Single Server Version host.

• For information on how to verify that Legato Single Server Version is

properly configured for the automatic bootstrap backup, see "Automatic

Bootstrap Backup" on page 129.

• For information on how to run the bootstrap backup manually, see

"Manual Bootstrap Backup" on page 130.

• For information on the critical bootstrap information to keep for future

disaster recovery procedures, see "Maintaining Bootstrap Information" on

page 131.

• For information on how to use the bootstrap during a disaster recovery,

see "Chapter 5: Disaster Recovery" on page 137.

Automatic Bootstrap Backup

Verify that the configuration is properly set up for the automatic bootstrap

backup. The Client resource and Default Group resource must both be

configured correctly.

In the Client resource, verify that the Group attribute is set to Default. For

information on how to access the Client resource, see "Verifying the Client

Resource Configuration" on page 75.

To verify the Default Group resource configuration for the automatic bootstrap

backup:

1. Run the Legato Single Server Version Administrator program, as

described in "The Administrator Program" on page 51.

2. Open the Groups resource window:

• On UNIX, select Customize>Groups to open the Groups window.

The Groups window lists the single Group resource named Default.
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Manual Bootstrap Backup
• On Windows:

a. In the Configure tab in the Server window, click Manage Groups

to open the Groups window.

The Groups window lists the single Group resource named

Default.

b. Right-click the Default group icon and select Edit to open the Edit

Group dialog box.

The General tab shows the attributes of the Default Group

resource.

3. Verify that the Start Time attribute is set to 3:33 a.m. This attribute specifies

when the bootstrap backup is configured to start.

4. Verify that the Autostart attribute is set to Enabled. If Autostart is set to

Disabled, the bootstrap backup does not run.

5. To have the bootstrap information sent to a specific printer, set the Printer

attribute to the name of that printer.

Information confirming the completion of the automatic bootstrap backup

appears in the Messages area (in the Monitor tab on Windows) of the main

Administrator program window.

Manual Bootstrap Backup

To run the bootstrap backup manually, log in as the root user (UNIX) or

administrator (Windows) and enter this savegrp command at the operating

system command prompt:

savegrp -O -l full -P printer_name -c server_name

where:

• printer_name is the name of the printer where the bootstrap information is

printed at the end of the bootstrap backup.

• server_name is the Legato Single Server Version hostname.

Note: Ensure that a writable tape device is available before starting a manual

bootstrap backup. If the savegrp command is run for a manual bootstrap

backup without an available device, the backup will fail. In that case, the

writable device must be provided and the savegrp command rerun, to restart

the manual bootstrap backup.

For more information on the savegrp command, refer to savegrp in the Legato
Command Reference Guide (see "Legato Command Reference Guide" on

page 39).
Legato Single Server Version, Release 6.1
Administrator’s Guide130



Chapter 4: Backup and Restore Operations

4

Information confirming the completion of the manual bootstrap backup is

displayed in the Messages section (in the Monitor tab on Windows) in the

Administrator program.

Maintaining Bootstrap Information

At the end of the automatic daily bootstrap backup, Legato Single Server

Version prints the bootstrap information to the printer specified in the Printer

attribute of the Default group resource; or, if that Printer attribute is blank, to

the default printer.

At the end of a manual bootstrap backup run with the savegrp command, as

described in "Manual Bootstrap Backup" on page 130, the bootstrap

information is sent to the printer specified in the savegrp command.

Store the bootstrap printout in a safe location. The printed bootstrap information

includes dates, locations, and save set ID numbers for the bootstrap save sets

backed up during the past month. With this information, a user can determine

which volumes are needed to recover the Legato Single Server Version media

index and resource database files during a disaster recovery. For more

information, see "Chapter 5: Disaster Recovery" on page 137.

An example of a bootstrap printout is as follows:

March 20 03:30 2002 NetWorker bootstrap information Page 1

date time level ssid file record volume

3/19/02 2:29:08 9 114886894956 0 jupiter.005

3/20/02 2:52:25 9 114886898577 0 jupiter.001

Canceling a Running Oracle Backup
To keep the Legato Single Server Version index and RMAN catalog

synchronized, include the Oracle user name in the Administrator list in the

Server resource before canceling an Oracle backup. For more information, see

"Server Access Management" on page 71.

Cancel a running Oracle backup (not including a backup initiated by OEM)

during the RMAN script execution on any platform by pressing the [Ctrl]+[c]

keys or the equivalent “attention” key combination on the system.
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Canceling a Nonresponding Oracle Backup
If this method of canceling an Oracle backup is not successful, use the alter
system kill command to interrupt the running rman process. For each

allocated channel, perform the following:

1. View the RMAN message log file to determine the Oracle session ID for

the channel.

For example, the following sample line from an RMAN message log

shows that channel ch1 has the Oracle session ID 15:

channel ch1: sid=15 devtype=SBT_TAPE

2. Run the following select command in the Oracle svrmgr or sqlplus
program to determine the serial number, where session_id is the Oracle

session ID from the RMAN message log in step 1:

select serial# from v$session where sid= session_id;

3. Run the following alter system command in the Oracle svrmgr or sqlplus
program to terminate the channel, where session_id is the Oracle session ID

from step 1 and serial# is the serial number from step 2:

alter system kill session ’ session_id, serial#’;

Canceling a Nonresponding Oracle Backup
The following procedures for canceling a nonresponding Oracle backup might
work. If these procedures do not work, contact Oracle for assistance.

Note: If the following procedure is used to cancel an Oracle backup, the Legato

Single Server Version index and RMAN catalog might become

unsynchronized, since Legato Single Server Version does not attempt to delete

the backup save set entries from its index.

To cancel a nonresponding Oracle backup on UNIX:

1. Include the set command id to ‘xxx’ command in the RMAN backup script

used for the Oracle backup. Otherwise, the query in the next step will fail.

For a sample script including this command, see "Creating RMAN Scripts"

on page 123.

2. Run the following query in the Oracle svrmgr or sqlplus program to

determine the Oracle process ID corresponding to each RMAN channel:

select spid, client_info from v$process p, v$session s
where p.addr=s.paddr and client_info like ‘%id=%‘;
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3. Run the following kill command to cancel the Oracle backup process,

where pid is the appropriate Oracle process ID:

kill -9 pid

To cancel a nonresponding Oracle backup on Windows, stop the nsrsbtcn.exe
process in the Windows Task Manager.

Monitoring Oracle Backups and Restores
The Administrator program can be used to monitor the status of Oracle

backup and restore operations. In the Administrator program on Windows,

the messages appear in the Monitor tab.

The nsrwatch program provides a character-based interface for monitoring

Legato Single Server Version activity. For more information, refer to the

nsrwatch man page on UNIX or the nsrwatch entry in the Legato Command
Reference Guide.

During a restore operation, Legato Single Server Version displays specific

types of messages:

• Legato Single Server Version requests the volume that needs to be

mounted in the device by displaying a message similar to the following in

the Pending Messages section:

media waiting: recover waiting for 8mm 5GB tape_volume_name

• If a restore operation requires more than one volume, Legato Single

Server Version lists all the volumes in the order they are required. During

the restore, Legato Single Server Version requests the volumes, one at a

time.

Progress messages appear during a backup or restore, and completion

messages advise when the backup or restore is complete. Messages can also be

viewed in specific online files.

• For progress messages, watch the Sessions display in the Administrator

program. The Sessions display information is also written to the

daemon.log file:

– /nsr/logs/daemon.log on UNIX

– %SystemDrive%\Program Files\nsr\logs\daemon.log on Windows
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Monitoring Oracle Backups and Restores
• For completion messages, watch the Messages display in the

Administrator program. The Messages display information is also

written to the messages file:

– /nsr/logs/messages on UNIX

– %SystemDrive%\Program Files\nsr\logs\messages on Windows

• For information about why a backup cannot progress, view the messages

in the Pending display. The Pending display shows requests to mount

tapes and other conditions that require operator intervention. For

examples of the messages that Legato Single Server Version displays

when requesting a volume for Oracle backup or restore, see "Volume

Operations" on page 95.

• For information on how to view RMAN error messages and debugging

information, see "RMAN Error Messages" on page 183.

• For information on how to view Legato Single Server Version error

messages and debugging information, see "Legato Single Server Version

Error Messages" on page 184.

Figure 19 on page 135 shows the types of Oracle backup messages displayed

in the Sessions and Messages sections of the Monitor tab in the Administrator

program on Windows.
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Figure 19. Oracle Backup Messages

Storage Management Reports

Table 14 on page 136 lists the programs that Legato Single Server Version

provides to query the contents of the storage management system. For more

detailed descriptions of the most commonly used commands and options,

refer to the Legato Command Reference Guide.
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Storage Management Reports
Table 14. Storage Management Report Programs

Program Information Reported

mminfo Contents and mode of the storage volumes

and/or the identification numbers and status of

the stored save sets.

mmlocate User-defined location of storage volumes.

nsrinfo Contents of the client index.

nsrmm Status of the storage devices known to Legato

Single Server Version.
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Chapter 5: Disaster Recovery

This chapter provides information on how to recover from different types of

system disasters on the Legato Single Server Version host computer. It stresses

the importance of preparing for a disaster. Proper preparation for disaster

recovery involves regular backups of Oracle data and the implementation of

the planning procedures outlined in this chapter.

This chapter includes the following main sections:

• "Types of Disaster" on page 137

• "Disaster Preparation" on page 140

• "Gathering the Key Information" on page 141

• "Disaster Recovery" on page 142

Types of Disaster
For the purpose of this guide, a disaster is any situation in which the day-to-day

access to data (for example, working files, software programs, or system files)

is disrupted. A disaster can also damage network components such as data,

devices, hardware, media, and software.

A disaster can be the result of any one or a combination of the following:

• Computer viruses that can corrupt data

• Hardware and software failures

• Infrastructure interruptions, inconsistencies, or loss of services such as

communication or network connections

The degree of loss during a disaster can range from one or more files lost when

a disk crashes to an entire computer system. The degree of severity of the

disaster determines the procedures that might need to be performed to recover

the data on a computer.
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Damaged Disk Containing Operating System and Legato Single Server Version Software
In a disaster recovery plan, consider how to recover from the following types

of disasters on the Legato Single Server Version host:

• "Damaged Disk Containing Operating System and Legato Single Server

Version Software" on page 138

• "Damaged Disk Containing Legato Single Server Version Indexes" on

page 139

• "Damaged Disk Containing Oracle Data" on page 139

• "Destroyed Legato Single Server Version Host" on page 140

Damaged Disk Containing Operating System and Legato Single Server
Version Software

Figure 20 on page 138 illustrates how the operating system and Legato Single

Server Version software can be damaged or destroyed. In this example, the

computer has several physical disks. A power outage has corrupted the

filesystem on Disk 0, and the operating system and Legato Single Server

Version software residing on Disk 0 has been lost.

To recover from the disaster:

1. Replace the disk.

2. Reinstall the operating system and Legato Single Server Version software.

3. Use the Legato Single Server Version software to recover the lost server

configuration and any data that was lost when the filesystem was

corrupted.

Figure 20. Damaged Disk Containing Operating System and Legato
Single Server Version Software

/usr/sbin

Damaged Disk 
Containing Operating 
System and Legato 
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Disk 0

Undamaged Disks 
Containing a 
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and Applications

Disk 1

Disk 2

Disk 3
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Note: If the primary disk containing both the operating system and the Legato

Single Server Version binaries has been destroyed, it is important to reinstall

the operating system, reinstall the Legato Single Server Version software, and

then recover the remainder of the data. Data backed up by Legato Single

Server Version cannot be recovered without reinstalling the operating system

and Legato Single Server Version software first.

Damaged Disk Containing Legato Single Server Version Indexes

Figure 21 on page 139 shows how the directory containing the Legato Single

Server Version online indexes and resource configuration files can be damaged

or destroyed. In this example, a disaster has corrupted the disk on the

computer that contains the Legato Single Server Version indexes and

configuration files. To recover from a disaster of this type, recover the contents

of the bootstrap save set and client index.

Figure 21. Damaged Disk Containing Legato Single Server Version
Indexes

Damaged Disk Containing Oracle Data

Figure 22 on page 140 illustrates how Oracle data can be damaged or

destroyed. In this example, a Legato Single Server Version host computer has

two disks. The second disk containing the Oracle data has been destroyed by

a disk crash. However, the disk containing the operating system and Legato

Single Server Version software is still operational. To recover from this

situation, use the Oracle RMAN utility in conjunction with Legato Single

Server Version.

/nsr/res
/nsr/index
/nsr/mm

Damaged Disk Containing 
Legato Single Server 
Version Indexes and 
Configuration Files
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Destroyed Legato Single Server Version Host
Figure 22. Damaged Disk Containing Oracle Data

Destroyed Legato Single Server Version Host

In the example in Figure 23 on page 140, the Legato Single Server Version host

computer is destroyed. To recover from this disaster, recover all the data to a

new system by the same name.

Figure 23. Destroyed Legato Single Server Version Host

Disaster Preparation
It is important to develop a plan for recovering from different types of

disasters on the Legato Single Server Version host computer. Back up

important data on the computer on a regular basis. Develop and test a plan for

recovering data in the event of a disk crash or loss of data. The more time and

effort invested in developing and testing a backup strategy and disaster

recovery plan, the better the preparation will be in the event of a disaster.

Note: Back up the Oracle data on the computer regularly using the Oracle

RMAN utility in conjunction with Legato Single Server Version. Also, back up

the other (non-Oracle) data on the computer regularly using a suitable backup

method.
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"Legato Single Server Version Bootstrap Backup" on page 128 describes how

Legato Single Server Version is preconfigured to perform an automatic daily

bootstrap backup. The bootstrap is a special backup save set that includes the

media index and resource configuration files. A manual bootstrap backup can

also be performed using the procedure in "Manual Bootstrap Backup" on

page 130.

The bootstrap information printed at the end of each bootstrap backup is

essential for recovering the Legato Single Server Version index and resource

configuration files. As explained in "Maintaining Bootstrap Information" on

page 131, the bootstrap printout should be kept in a safe place, ready for use

during a disaster recovery.

Without the bootstrap printout, the save set ID of the most recent bootstrap

must be determined. For more information on determining the bootstrap save

set ID and using the bootstrap information, see "Recovering Legato Single

Server Version" on page 153.

To prepare for disaster recovery, it is important to provide suitable access to the

key information about the Legato Single Server Version host computer.

Maintain this key information in an onsite location that is the most resistant to

disaster. The information should be easily accessible by those assigned to

perform disaster recovery. Enact strict guidelines regarding the access,

maintenance, and usage of this key information.

Gathering the Key Information
Maintain accurate records for each hardware, software, network, device, and

media component related to the Legato Single Server Version host computer.

Computer Hardware Information

Maintain the following information about computer hardware and keep this

information up-to-date:

• Filesystem configuration

• Fully qualified Domain Names, IP addresses, and hostnames

• For Domain Name Service (DNS) clients, maintain the DNS host’s

internet address and its hostname

• Hard drive configuration information

• Media device names
Legato Single Server Version, Release 6.1
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Computer Software Information
• Hardware vendor contact information and contract number

• Configuration information for each piece of hardware, both active and

inactive

Computer Software Information

Maintain the following information about computer software and keep this

information up-to-date:

• Copies of the original operating system and software media and patches,

including the original Legato Single Server Version software media (and

where they are located)

• Software enabler and authorization codes

• Software vendor contact information and contract number

• Operating system version and patches installed

• Operating system configuration information

• Emergency media that can be used to restore the computer in the event of

a disaster

• Legato Single Server Version bootstrap information

• Kernel configuration and location information

• Device drivers

Disaster Recovery
The following sections describe how to perform a disaster recovery on a

Legato Single Server Version host computer. The information is designed to

provide general principles on how to recover critical data and to help in

understanding the disaster recovery procedures.

The following list provides a brief overview of the tasks required for a

successful disaster recovery on a Legato Single Server Version host computer.

These tasks are explained in detail in subsequent sections in this chapter.

1. Reinstall the operating system, if necessary.

2. Reinstall the Legato Single Server Version software, if necessary.

3. Configure the tape device to be used for recovering the Legato Single

Server Version bootstrap and load the tape volume containing the latest

bootstrap.
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4. If the bootstrap save set ID is known, run the mmrecov command at the

operating system command prompt to recover the bootstrap (media index

and resource configuration files).

If the bootstrap save set ID is unknown, run the scanner -B device-name
command to locate the bootstrap save set ID; then run the mmrecov
command to recover the bootstrap.

5. Stop the Legato Single Server Version daemons (UNIX) or services

(Windows).

6. Copy the contents of the res.R directory to the res directory.

7. Restart the Legato Single Server Version daemons or services.

8. Run the nsrck -L7 command to recover the client index.

9. Recover any required Oracle data using Legato Single Server Version.

10. Recover non-Oracle data using a suitable recovery method.

Refer to the list of sections in Table 15 on page 143 to determine the specific

disaster recovery instructions that apply to the situation.

Note: To recover data other than Oracle data on the Legato Single Server Version

host computer, use the recovery method that corresponds to the method used

to back up that data. Use Legato Single Server Version to recover only Oracle
data that was backed up by Legato Single Server Version.

Table 15. Sections Containing Disaster Recovery Information

To recover... See...

Hard drive • "Replacing a Hard Drive" on page 144

Operating system • "Recovering the UNIX Operating System" on

page 145

• "Recovering the Windows Operating System"

on page 149

Legato Single Server Version • "Recovering Legato Single Server Version" on

page 153

Oracle data • "Recovering Oracle Data" on page 161
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Replacing a Hard Drive
Replacing a Hard Drive

To replace a hard drive:

• Obtain the hard drive information. See the appropriate section:

– "Obtaining the Hard Drive Information on UNIX" on page 144

– "Obtaining the Hard Drive Information on Windows" on page 144

• Replace the hard drive. See "How to Replace a Hard Drive" on page 145.

Obtaining the Hard Drive Information on UNIX

The following information is required to replace a hard drive. Obtain the

information using the commands appropriate for the operating system.

• Size of the drive

• Filesystem volume information

• Volume label assigned to each disk partition

This information includes details about:

• How the disk is partitioned

• How the disk is loaded

• The size of the disk

• Each logical volume (size and label)

• Each filesystem

Note: Although it will not affect Legato Single Server Version operation, any

use of mirroring, RAID/striping, compression, and volume sets might be

noted.

After obtaining this information, replace the hard drive.

Obtaining the Hard Drive Information on Windows

On Windows 2000, go to Start>Programs>Administrative Tools>Computer

Management>Storage>Disk Management. On Windows NT, use the Windows

NT Disk Administrator.

Obtain the following information about the damaged drive:

• Size of the drive

• Volume size, filesystem type (Windows NT)

• Size, format, and volume label assigned to each disk partition
Legato Single Server Version, Release 6.1
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Note: Although it will not affect Legato Single Server Version operation, any

use of mirroring, RAID/striping, compression, and volume sets might be

noted.

After obtaining this information, replace the hard drive.

How to Replace a Hard Drive

If a hard drive fails, refer to the hard drive vendor documentation and the

appropriate operating system documentation for instructions on how to

replace the hard drive.

Important: Install a new drive that is the same size as, or larger than, the

original drive. This ensures that there is enough space to recover all of the

failed drive’s data.

To begin the recovery process, recover:

• The UNIX operating system, if necessary. See "Recovering the UNIX

Operating System" on page 145.

• The Windows operating system, if necessary. See "Recovering the

Windows Operating System" on page 149.

• The Legato Single Server Version software, if necessary. See "Recovering

Legato Single Server Version" on page 153.

• Oracle data that was backed up by Legato Single Server Version. See

"Recovering Oracle Data" on page 161.

• Other filesystem data as necessary, using a suitable recovery method.

Recovering the UNIX Operating System

To recover the UNIX operating system:

• Meet the operating system recovery requirements. See "UNIX Operating

System Recovery Requirements" on page 146.

• Recover the operating system. See "How to Recover the UNIX Operating

System" on page 146.
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Recovering the UNIX Operating System
UNIX Operating System Recovery Requirements

To recover the UNIX operating system, obtain the following information about

the state of the computer immediately prior to the disaster:

• Operating system version and patch level

• TCP/IP properties:

– Adapter type

– IP address

– Default gateway

– Subnet mask

– DNS server

• Computer properties:

– Hostname

– DNS domain name

– Superuser password

• Device and SCSI drivers

• Boot files required for booting the kernel. For example:

– /unix

– /boot

– /etc/default/boot

– /stand/vmunix

Note: Refer to the appropriate operating system documentation to determine

which boot files should not be overwritten during a recovery.

Once these requirements have been met, recover the UNIX operating system.

How to Recover the UNIX Operating System

This section describes how to recover the UNIX operating system. This process

can be used to recover the operating system back to the original computer or

to a different computer.

Recover the operating system by performing either:

• A complete installation and configuration of the operating system.

OR

• A partial installation and configuration, of only those files that enable the

computer to communicate over the network. Then, recover the remaining

operating system and configuration files using a suitable recovery

method.
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Note: Do not recover the operating system from an X session. Rather, recover

the operating system in single-user mode from the system console.

To recover the operating system, follow these steps, explained in detail below:

1. Install the operating system.

2. Configure the operating system.

3. Test the operating system and configure the devices.

Step 1: Install the Operating System

To install the operating system:

1. Install the same version and patch level of the UNIX operating system into

its original location. Refer to the documentation accompanying the UNIX

operating system for details.

To upgrade the operating system, first recover the operating system as it

was previous to the disaster, and then perform the upgrade.

2. Re-create all the filesystems that were previously on the computer.

The filesystems must be:

• The same filesystem type.

• At least the same size as before, to hold all of the backed up data.

At a minimum, configure the root volume group and kernel parameters,

such as asynchronous I/O. If the resources are available, reconstruct

non-root volume group filesystems and logical volumes.

Step 2: Configure the Operating System

To configure the operating system:

1. Configure the network exactly as it was configured before the disaster.

Otherwise, the Legato Single Server Version software will view the

computer containing Legato Single Server Version as a new computer. If

the computer has a host ID different from the one used before the disaster,

the Legato Single Server Version software must be reinstalled and

configured on the computer. For details, see "Recovering Legato Single

Server Version" on page 153.
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Recovering the UNIX Operating System
2. If the operating system is being recovered to a different computer, assign

the same hostname (as used for the original Legato Single Server Version

host computer before the disaster) for the new computer. If the same

hostname is not used, the Legato Single Server Version indexes associated

with the original computer cannot be recovered.

3. Configure the date and time as they were configured before, including the

time zone.

4. Install any additional UNIX components before recovering the computer’s

data.

5. Reboot the computer.

Step 3: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by Legato Single Server Version.

2. Perform a test to verify that the:

• Name to Address resolution and TCP/IP are functioning properly.

This test can be performed using the ping command.

• Operating system is functioning properly.

• Tape drive is functioning properly. This test can be performed using

the mt command.

• Devices are recognized by the operating system. If the devices are not

recognized by the operating system:

– Load the SCSI driver.

– Install the device driver software.

– Modify the device configuration files to enable the computer to

communicate with the device during recovery. For details on

device configuration, see "Chapter 3: Device and Media

Management" on page 81.

To complete the recovery process, recover:

• The Legato Single Server Version software, if necessary. See "Recovering

Legato Single Server Version" on page 153.

• Oracle data that was backed up by Legato Single Server Version. See

"Recovering Oracle Data" on page 161.

• Other filesystem data as necessary, using a suitable recovery method.
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Recovering the Windows Operating System

To recover the Windows operating system:

• Meet the operating system recovery requirements. See "Windows

Operating System Recovery Requirements" on page 149.

• Recover the operating system. See "How to Recover the Windows

Operating System" on page 149.

Windows Operating System Recovery Requirements

To recover the Windows operating system, obtain the following information

about the state of the computer immediately prior to the disaster:

• Operating system version, patches, service packs, and option packs

• Location of the operating system

• TCP/IP properties:

– Adapter type

– IP address

– Default gateway

– Subnet mask

– DNS server

• Windows server/workstation properties:

– Computer name (also called the hostname)

– Full domain name

– Administrator name and password

• Date/time properties

• Virtual memory settings

• Protocols installed

Note: For more information about requirements on Windows NT, see

"Dynamic Host Configuration Protocol (DHCP) and Windows Internet

Naming Service (WINS) Databases" on page 160.

Once these requirements have been met, recover the Windows operating

system.

How to Recover the Windows Operating System

This section describes how to recover the Windows operating system. Use this

process to recover the operating system back to the original computer or to a

different computer.
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Recovering the Windows Operating System
Recover the operating system by performing either:

• A complete installation and configuration of the operating system.

OR

• A partial installation and configuration, of only those files that enable the

computer to communicate over the network. Then, recover the remaining

operating system and configuration files using a suitable recovery

method.

To recover the operating system, follow these steps, explained in detail below:

1. Install and configure the operating system.

2. Test the operating system and configure the devices.

Step 1: Install and Configure the Operating System

To install and configure the operating system:

1. Install the same version, service pack, and patch level of the Windows

operating system into its original location. Refer to the operating system

documentation for details.

To upgrade the operating system, first recover the operating system as it

was previous to the disaster, and then perform the upgrade.

2. For Windows NT, install the computer as a workstation or server, not as a

BDC (Backup Domain Controller) or PDC (Primary Domain Controller).

3. Install the computer into a workgroup, not into a domain.

4. Configure the TCP/IP properties as they were configured before, with the

same hostname (domain name), IP address, default gateway, subnet mask,

and DNS server.

For example, in the hosts file on Windows 2000

(%SystemRoot%\system32\drivers\etc\hosts), the computer name should

appear directly after the fully qualified domain name, on the same line, as

in the following example:

123.56.890.474   kingdome.seattle.washington.com
kingdome

Note: If recovering the operating system to a different computer:

• Use the same hostname for the new computer. If the same hostname

is not used, the Legato Single Server Version indexes associated with

the original computer cannot be recovered.
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• Assign the same TCP/IP address for the new computer; otherwise,

the computer will be assigned a new host ID by Legato Single Server

Version. If this computer does not have the same TCP/IP address as

the original computer, Legato Single Server Version must be

reinstalled and configured on it. For details, see "Recovering Legato

Single Server Version" on page 153.

5. Configure the Windows server/workstation properties as they were

configured before the disaster. Use the same computer name, full domain

name, administrator name, and password. (The full domain name for a

computer named kingdome, for example, might be

kingdome.seattle.washington.com.)

For example, on Windows 2000, perform the following steps:

a. On the Desktop, right-click My Computer and select Properties on

the context menu. The System Properties dialog box appears.

(Another way to reach the System Properties dialog box is to select

Start>Settings>Control Panel and click the System icon.)

b. In the System Properties dialog box, select the Network Identification

tab.

c. In the Network Identification dialog box, click the Properties button.

d. In the Identification Changes dialog box, click the More button.

e. In the DNS Suffix and NetBIOS Computer Name dialog box, ensure

that the field labeled “Primary DNS suffix of this computer” contains

the domain name. If not, enter the domain name in this field.

6. Configure the Localization Properties or Date/Time Properties as they

were configured before the disaster.

7. Restart the computer after installing the Windows operating system.

8. Reset the Virtual Memory Settings as they were configured before by

selecting the appropriate options in the Control Panel:

•  Windows 2000: Control Panel>System>Advanced>Performance

options>Virtual Memory>Change

•  Windows NT: Control Panel>System>Performance>Change

Note: On Windows NT, do not upgrade OEM drivers for network

interface cards (NIC) with the OEM Service Pack version of the NIC.

9. If any additional Windows components were installed previously, install

them before recovering the computer data.

10. Restart the computer after the service pack is installed, to apply the new

settings.
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Recovering the Windows Operating System
Step 2: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by Legato Single Server Version.

2. On Windows 2000, disable RSM on any stand-alone device connected to

the Legato Single Server Version host computer:

a. On the Windows desktop, right-click My Computer and select

Manager from the pop-up menu.

b. For each stand-alone device:

1. On the Computer Management navigation pane (left side of the

dialog box), expand Storage\Removable Storage\Physical Locations.

2. Right-click the device name and select Properties from the

pop-up menu.

3. In the General tab of the Properties dialog box, ensure that the

Enable Library check box is cleared.

4. Click OK to apply any changes and close the Computer

Management dialog box.

3. Verify that the:

• Operating system is functioning properly.

• Network protocols are functioning properly. Test by running ping.

• The Name to Address resolution is correct. Test by running nslookup
using the fully qualified domain name of Legato Single Server

Version.

• Required devices are recognized by the operating system. If the

devices are not recognized by the operating system:

– Load the SCSI driver.

– Install the device driver software.

To complete the recovery process, recover:

• The Legato Single Server Version software, if necessary. See "Recovering

Legato Single Server Version" on page 153.

• Oracle data that was backed up by Legato Single Server Version. See

"Recovering Oracle Data" on page 161.

• Other filesystem data as necessary, using a suitable recovery method.
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Once the computer’s data is recovered and the computer is rebooted:

• To use Active Desktop, install it.

• On Windows NT:

– If the computer is a Backup Domain Controller, synchronize it with

the Primary Domain Controller.

– If the computer is a Primary Domain Controller, synchronize it with

the domain.

Recovering Legato Single Server Version

To recover Legato Single Server Version:

• Meet the Legato Single Server Version recovery requirements. See "Legato

Single Server Version Recovery Requirements" on page 153.

• Recover Legato Single Server Version. See "How to Recover Legato Single

Server Version" on page 153.

Legato Single Server Version Recovery Requirements

To recover Legato Single Server Version, determine the following:

• Version and patch level of Legato Single Server Version

• Location of the Legato Single Server Version software

• Legato Single Server Version software installation media

• Backup volumes containing the Legato Single Server Version bootstrap

(media index and configuration files) and client index

• On UNIX, any links to Legato Single Server Version directories (for

example, /nsr might be linked to /usr/nsr)

Note: Before recovering Legato Single Server Version on Windows NT, follow

the instructions in "Dynamic Host Configuration Protocol (DHCP) and

Windows Internet Naming Service (WINS) Databases" on page 160 to ensure

that the Windows NT DHCP databases and WINS databases are properly

restored.

Once these requirements have been met, recover Legato Single Server Version.

How to Recover Legato Single Server Version

This section describes how to recover Legato Single Server Version. Use the

following steps to recover Legato Single Server Version back to the original

computer or to a different computer.
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Recovering Legato Single Server Version
To recover Legato Single Server Version, follow these steps, explained in detail

below:

1. Install Legato Single Server Version.

2. Configure Legato Single Server Version.

3. Locate the bootstrap save set ID.

4. Recover the bootstrap.

5. Rename the resource configuration files.

6. Recover the client index.

7. Verify the Legato Single Server Version recovery.

Step 1: Install Legato Single Server Version

To install Legato Single Server Version:

1. Install the same release of Legato Single Server Version in its original

location. For installation instructions, refer to the Legato Single Server
Version Installation Guide.

Note: By default, the configuration files are located in the /nsr/res directory

(UNIX) or C:\Program Files\nsr\res directory (Windows). Attempt to

reuse these configuration files only if the hard drive had not crashed and

you are upgrading to or reinstalling Legato Single Server Version.

2. Install any Legato Single Server Version patches that were installed prior

to the disaster.

3. (Perform this step on UNIX only.) Re-create any links to Legato Single Server

Version directories, such as the directories containing the index and

configuration files. For example, /nsr might be linked to /usr/nsr.

Step 2: Configure Legato Single Server Version

To configure Legato Single Server Version:

1. (Perform this step on Windows only.) In the Legato Single Server Version

Administrator program, check the settings in the Preferences tab of the

Client resource. Verify that the computer’s aliases are entered correctly.

The settings might look something like the following:

aliases:kingdome

      kingdome.seattle.washington.com
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2. Configure the Device resource for each tape device to be used in "Step 3:

Locate the Bootstrap Save Set ID" on page 155. For more information on

device configuration, see "Configuring Storage Devices" on page 81.

3. (Perform this step on Windows only.) The client index path must be the same

as when the disaster occurred. If the client index path was relocated to a

new location, reset it to the original path using the following procedure:

a. Edit the Index Path attribute in the Client resource to the original

path.

b. Restart the Legato Single Server Version services. This will enable

Legato Single Server Version to recognize that the index path has

changed. For information on how to restart the Legato Single Server

Version services, refer to "Step 5: Rename the Resource Configuration

Files" on page 158.

c. Run nsrck -c server-name from the directory containing the Legato

Single Server Version binaries to create an empty file index into

which the records can be recovered. By default, the binaries are

located in the C:\Program Files\nsr\bin directory.

Step 3: Locate the Bootstrap Save Set ID

This section describes how to locate the save set ID for the latest Legato Single

Server Version bootstrap. The bootstrap contains the media index and resource

configuration files.

Note: If the Legato Single Server Version backup tape volumes are routinely

moved to an offsite location for safekeeping, be aware that a file recover

operation that generates a mount request will wait until an operator satisfies

the mount request. To avoid delays in recovering files, use the mminfo -mv
command to list the volume containing the file to be recovered and then

retrieve the volume from the offsite storage, as required, before starting the

recover.

To locate the save set ID of the most recent bootstrap:

1. Insert the most recent backup tape volume used for the automatic daily

bootstrap backups or for manual bootstrap backups into the appropriate

tape device.

2. At the system console or command prompt, switch to the directory where

the Legato Single Server Version binaries are located. For information on

the default directory location of the binaries, refer to the Legato Single
Server Version Installation Guide.
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3. Use the scanner -B device-name command to determine the save set ID of

the most recent bootstrap on the volume. For example:

• On Solaris:

# scanner -B /dev/rmt/0hbn

• On Windows:

scanner -B \\.\Tape0

The scanner -B command displays the latest bootstrap save set

information found on the backup volume, for example:

scanner: scanning 8mm tape mars.006 on \\.\Tape0

scanner: Bootstrap 1148869870 03/31/01 6:29:58 mars.006,
file 88

Note: If the save set ID of the latest bootstrap is not located on the most

recent tape, run the scanner -B command on preceding tapes to locate the

save set ID of the latest bootstrap.

4. When the scanner -B command output appears, record both the bootstrap

save set ID and the volume label.

Step 4: Recover the Bootstrap

This section describes how to recover the Legato Single Server Version

bootstrap (media index and configuration files) using the mmrecov command.

To recover the bootstrap:

1. Use the mmrecov command at the operating system command prompt to

recover the bootstrap. For example:

• On UNIX:

# mmrecov

• On Windows:

C:\Program Files\nsr\bin> mmrecov

The following output appears:

mmrecov: Using madrid.spain.com as server
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Important: The mmrecov command overwrites the media index. It does not
overwrite the resource configuration files, as mmrecov recovers them to the

res.R directory. For more information on the mmrecov command, refer to these

sources:

• mmrecov entry in the Legato Command Reference Guide (see "Legato

Command Reference Guide" on page 39)

• mmrecov man page on UNIX (see "UNIX Man Pages" on page 37)

2. If the following message appears, enter the name of the device being used

for the recovery (this message only appears if Legato Single Server Version

has multiple devices configured and enabled).

What is the name of the device you plan on using
[ device-name]?

3. When the following message appears, enter the save set ID for the latest

bootstrap.

Enter the latest bootstrap save set ID []: 20076

4. When the following message appears, enter the file number to begin the

recovery. If unknown, press [Enter].

Enter starting file number (if known) [0]: 130

5. When the following message appears, enter the first record number to

begin the recovery. If unknown, press [Enter].

Enter starting record number (if known) [0]:  0

6. When the following message appears, insert the volume containing the

save set ID into the backup device (if required) and press [Enter]:

Please insert the volume on which save set ID 20076 started
into device-name. When you have done this, press <RETURN>:

Once the required volume is loaded and [Enter] is pressed, the following

message appears:

Scanning device-name for save set 20076; this may take a
while...

Legato Single Server Version then scans the volume for the save set and

recovers it.
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Note: The nwadmin program can be used (click the Monitor tab on Windows)

to monitor the recovery of the bootstrap (media index and configuration files).

If the media index is not on the same volume as the resource configuration

files, Legato Single Server Version will prompt during the recovery if

additional volumes are required.

The bootstrap is recovered when the following message appears:

If your resource files were lost, they are now recovered
in the ’res.R’ directory. Copy or move them to the ’res’
directory, after you have shut down the service. Then
restart the service.

Otherwise, just restart the service.

If the on-line index for the server-name was lost, it can be
recovered using the nsrck command.

Step 5: Rename the Resource Configuration Files

Because the resource configuration files cannot be reliably overwritten while

Legato Single Server Version is running, mmrecov recovered the res directory

as res.R by default. In addition, mmrecov might have recovered another

server’s configuration file in this directory. Stopping and restarting the Legato

Single Server Version daemons or services is recommended.

To rename the configuration files:

• On UNIX:

1. Stop the Legato Single Server Version daemons by entering the

nsr_shutdown command at the UNIX command prompt:

# nsr_shutdown

2. Rename the existing /nsr/res directory to /nsr/res.orig:

# mv /nsr/res /nsr/res.orig

3. Rename the recovered /nsr/res.R directory to /nsr/res:

# mv /nsr/res.R /nsr/res

4. Restart the Legato Single Server Version daemons by entering the

nsrexecd and nsrd commands, in that order:

# nsrexed

# nsrd

5. After verifying that the Legato Single Server Version configurations

are correct in the Administrator program, delete the /nsr/res.orig
directory.
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• On Windows:

1. Stop the Legato Single Server Version services:

a. In the Windows Control Panel, select Services.

b. Stop the NetWorker Backup and Recover Server service.

c. Stop the NetWorker Remote Exec service.

d. Click Close.

2. Rename the existing nsr\res directory (in C:\Program Files or a

relocated directory) to nsr\res.orig.

3. Rename the recovered nsr\res.R directory (in C:\Program Files or a

relocated directory) to nsr\res.

4. Restart the Legato Single Server Version services:

a. In the Windows Control Panel, select Services.

b. Start the NetWorker Remote Exec service.

c. Start the NetWorker Backup and Recover Server service.

d. Click Close.

5. After verifying that the Legato Single Server Version configurations

are correct in the Administrator program, delete the nsr\res.orig
directory.

Step 6: Recover the Client Index

Once the bootstrap consisting of the media index and resource configuration

files is recovered, recover the client index.

To recover the client index, enter this nsrck -L7 command at the operating

system command prompt:

nsrck -L7 hostname

The nsrck -L7 command recovers the /nsr/index/<hostname> directory

containing the required client index.

Step 7: Verify the Legato Single Server Version Recovery

To verify the Legato Single Server Version recovery:

1. Perform a test Oracle backup or restore to ensure that Legato Single Server

Version is fully recovered.

2. Perform a test bootstrap backup manually using the instructions in

"Manual Bootstrap Backup" on page 130.
Legato Single Server Version, Release 6.1
Administrator’s Guide 159



5

Dynamic Host Configuration Protocol (DHCP) and Windows Internet Naming Service (WINS) Databases
To complete the recovery process, recover:

• Oracle data that was backed up by Legato Single Server Version. See

"Recovering Oracle Data" on page 161.

• Other filesystem data as necessary, using a suitable recovery method.

Dynamic Host Configuration Protocol (DHCP) and Windows Internet
Naming Service (WINS) Databases

If DHCP or WINS on Windows NT is being used, it is recommended that these

databases be regularly dumped and the dumps backed up using a suitable

backup method.

Windows NT does not provide a programming interface for backup and

restore of the DHCP database or the WINS database, but DHCP and WINS

database dumps can be configured using DHCP Manager and WINS Manager.

Back up these database dumps as part of the routine filesystem backup

operations and then restore the dumps if it ever becomes necessary. After

restoring the dumps, import them, again using DHCP Manager or WINS

Manager.

To dump, back up, restore, and import the DHCP and WINS databases:

1. To open the DHCP administrative interface, go to

Start>Programs>Administrative Tools>DHCP Manager.

2. To run DHCP dumps as necessary, configure the dumps from DHCP

Manager. A default dump location is provided, but a different location can

be specified. Make a note of the chosen database dump location.

3. To open the WINS administrative interface, go to

Start>Programs>Administrative Tools>WINS Manager.

4. To run WINS dumps as necessary, configure the dumps from WINS

Manager. A default dump location is provided, but a different location can

be specified. Make a note of the chosen database dump location.

5. As part of the routine filesystem backups, specify the backup save sets

including the filesystem locations specified for the DHCP and WINS

databases dumps. Restore a dump whenever it becomes necessary.

6. To recover a DHCP or WINS database, open DHCP Manager or WINS

manager and import the database that was backed up and restored.
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Recovering Oracle Data

This section describes how to recover from a crash in which one or more files

of an Oracle database were damaged on the Legato Single Server Version host

computer.

The first sign of a disk crash is usually an I/O error. Oracle usually documents

the I/O error in both the trace file and the alert log.

If only one database file is affected, the database might have encountered a bad

spot on the disk. This can be circumvented by reformatting the disk to make a

new list of bad blocks. However, this can be time-consuming, so it is prudent

to have a spare disk available to swap in during the reformatting.

If several database files are affected, all on the same disk, there might be a disk

controller problem or a disk head crash. A bad controller can be replaced, and

data on the disk will often be in perfect shape. But after a head crash, that spare

disk will need to be used as a replacement.

Keep an extra disk on hand as a "hot spare," in case a disk failure occurs.

Format it and verify that it works. If a disk failure does occur, it is much faster

to swap in a spare disk than it is to rename database files and update the

control file accordingly.

After the Oracle data requiring recovery has been determined, restore the

relevant files first.

Restore and recover the Oracle database files by using one of these programs:

• RMAN command line interface

• OEM Backup Management Tools

For complete details on how to restore Oracle database files using Legato

Single Server Version, see "Chapter 4: Backup and Restore Operations" on

page 107.

To recover an Oracle database using the Oracle RMAN utility, refer to the

appropriate Oracle backup and recovery documentation.
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Appendix A: Oracle9i Support in Legato Single
Server Version

This appendix is designed to help in the use of RMAN features introduced in

Oracle9i with Legato Single Server Version. For a complete list and more

information on these Oracle9i features, refer to the appropriate Oracle9i

backup and recovery documentation.

This appendix includes the following main sections:

• "Automatic Channel Allocation" on page 163

• "Control File Autobackup" on page 165

• "Backup Copies" on page 166

• "Retention Policies" on page 166

• "Backup and Restore Optimization" on page 167

• "Backup of Backup Sets" on page 168

• "Restartable Backups" on page 169

Automatic Channel Allocation
In Oracle9i, RMAN supports automatic channel allocation. This feature

enables a user to configure persistent settings for automatic channels for use in

all RMAN sessions.

To configure persistent settings for Oracle backups or restores using Legato

Single Server Version, specify the device type in the configure command using

the noncase-sensitive keywords sbt, sbt_tape, ‘sbt’, and ‘sbt_tape’.

If the allocate channel command is not used in an RMAN script to manually

allocate at least one channel, RMAN allocates automatic channels in the
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RMAN session using the settings that are specified in the following configure
commands:

configure default device type to sbt

configure device type sbt parallelism...

configure channel device type sbt parms...

configure channel n device type sbt parms...

Important: Manual and automatic channels are mutually exclusive and cannot

be mixed in an RMAN session. The format of an automatic channel name of

the device type for Legato Single Server Version backups and restores is

ORA_SBT_n or ORA_SBT_TAPE_n, where n is the channel number. Do not use

this name format for manual channel allocation with Legato Single Server

Version; otherwise, RMAN reports an error.

Specify persistent settings for automatic channels for Legato Single Server

Version backups and restores using the configure commands.

• Specify the default device type using the configure default device type
command. For example, specify the automatic channel default device

type for backups using the following command:

configure default device type to ’sbt_tape’

• Specify the number of automatic channels using the parallelism option.

For example, specify two automatic channels for backups using the

following command:

configure device type ’sbt_tape’ parallelism 2

• Specify generic automatic channel options using the configure channel
device type...parms... command. For example, set an automatic channel

for Oracle backups and specify backup compression using the following

command:

configure channel device type ’sbt_tape’ parms
’ENV=(NSR_COMPRESSION=TRUE)’

Note: Use the send command to set the NSR_* environment variables for

automatic channels only through the operating system command line

option of the rman invocation. Do not use the send command in an RMAN

script to set the variables for automatic channels. Oracle performs

automatic channel allocation when an RMAN command runs that

requires the channel allocation, for example, the backup command. If the
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send command is issued before this type of RMAN command, an RMAN

error is generated, stating that no channels were found for the send
command.

• Specify automatic channel options for a specific channel number using the

configure channel n device type...parms... command. For example,

specify a Legato Single Server Version debug file only for the second

automatic channel (not for other automatic channels) using the following

command:

configure channel 2 device type ’sbt_tape’ parms
’ENV=(NSR_DEBUG_FILE=/db/logs/backup.log,
NSR_COMPRESSION=TRUE)’

• With automatic channel allocation, the RMAN backup, restore, or

maintenance commands can be run as stand-alone commands without

requiring manual channel allocations.

The following sample RMAN backup script specifies two automatic channels

for Oracle backups, each channel using a different debug file:

configure default device type to sbt;

configure device type sbt parallelism 2;

configure channel 1 device type sbt
parms ’ENV=(NSR_DEBUG_FILE=/db/logs/debug1.log)’;

configure channel 2 device type sbt
parms ’ENV=(NSR_DEBUG_FILE=/db/logs/debug2.log)’;

Control File Autobackup
In Oracle9i, RMAN performs a control file autobackup after each RMAN

backup command if the control file autobackup has been enabled using the

configure controlfile autobackup on command. Use this feature to restore the

backup entries contained in the control file when the control file is lost and the

Recovery Catalog is not available.

Specify persistent settings for the control file autobackups using the configure
controlfile autobackup command. For example, enable control file
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autobackup and specify the persistent setting for the format of the control file

autobackup name using the following commands:

configure controlfile autobackup on

configure controlfile autobackup format for device type
’sbt_tape’ to ’/NMO_%f/’

If the control file autobackup is set to on and the RMAN backup is performed

using Legato Single Server Version, the control file autobackup will also be

performed using Legato Single Server Version. As a result, one or more

channels of device type sbt_tape must be allocated for the restore.

Backup Copies
Legato Single Server Version does not support the duplexing of backups. As a

result, Legato Single Server Version does not support the following commands

in Oracle9i:

• configure...backup copies for device type sbt_tape to...

• backup...copies

• set backup copies

Note: Legato NetWorker Module for Oracle (used in conjunction with Legato

NetWorker) supports the above commands for duplexing backups.

Retention Policies
In Oracle9i, RMAN provides an Oracle retention policy for backups. An Oracle

retention policy is based on the recovery window or redundancy; it is not
based on a defined time period, such as a year. Oracle considers a backup

obsolete when it is no longer required according to the Oracle retention policy

setting. Oracle checks the retention policy of a backup when the report
obsolete... or delete obsolete... command is run.

Legato Single Server Version supports the Oracle retention policy with some

restrictions, since Legato Single Server Version has its own browse and

retention policies to specify how long data is available for recovery. The Legato

Single Server Version browse and retention policies are based on a defined

time period. Since the Oracle retention policy is independent from the Legato

Single Server Version policies and there is no mechanism to synchronize these

policies, the Legato Single Server Version and Oracle policies might conflict

with each other.
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For example, Legato Single Server Version might expire an Oracle backup that

is not yet obsolete in RMAN, depending on the Legato Single Server Version

browse and retention policies set by a user. Legato Single Server Version cannot
guarantee that it will not expire a backup volume until all the RMAN backups

on that volume have been deleted from the RMAN catalog.

To avoid conflict problems, disable the Oracle retention policy (and then use

only the Legato Single Server Version policy) with the following command:

configure retention policy to none

If the Recovery Catalog is used, a backup can be exempted from the retention

policy with one of the following commands:

change backupset...keep until/forever...

backup...keep until/forever...

If the Oracle retention policy is to be used, set the Legato Single Server Version

browse and retention policies for backups to be long enough that the backups

are kept on the backup volumes until the Oracle retention policy makes them
obsolete. Specify the Legato Single Server Version policies by using the default

settings in the Client resource or by setting the NSR_BROWSE and

NSR_SAVESET_EXPIRATION environment variables. For more information

on how to set Legato Single Server Version policies for Oracle backups, see

"Verifying the Client Resource Configuration" on page 75.

Important: Run the crosscheck command on the Oracle backups before

running report obsolete or delete obsolete backups of the device type
sbt_tape. This ensures that backups expired by Legato Single Server Version

are flagged as expired in the RMAN catalog. As a result, RMAN can correctly

identify which backups are not needed according to the Oracle retention

policy.

Backup and Restore Optimization
If backup optimization is enabled using the configure backup optimization
on command in Oracle9i, RMAN decides which files to skip during a backup,

based on several criteria. For more information on these criteria, refer to the

appropriate Oracle backup and recovery documentation.
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Notes:

• To force a backup that would otherwise be skipped due to backup

optimization, use the force option in the backup command.

• When RMAN skips a backup due to backup optimization, it does not

produce an error message. However, RMAN does issue a warning

message similar to the following:

skipping archive log file...

Important: When using Oracle backup optimization with Legato Single Server

Version backups and restores, run the crosscheck command regularly to

synchronize the Recovery Catalog and Legato Single Server Version indexes.

This ensures that backups expired by Legato Single Server Version are also

marked as expired in the Recovery Catalog and RMAN does not skip a backup

when a referenced backup is already expired in Legato Single Server Version.

Restore optimization in Oracle9i causes RMAN not to restore a file if the

original file is already in the correct location and contains the expected

information.

Note: To force a restore that would otherwise be skipped due to restore

optimization, use the force option in the restore command.

Backup of Backup Sets
In Oracle9i, RMAN supports the backup of backup sets. If Oracle data is

backed up using device type disk, this Oracle9i feature can be used to back up

these backup sets from disk to backup volumes using Legato Single Server

Version.

For example, to back up all backup sets from disk to Legato Single Server

Version backup volumes in a tape device, use the following command:

backup device type sbt backupset all

The backup set on disk can also be deleted using the delete input option in the

backup device type sbt backupset... command. For example, to back up the

backup sets that were created on disk more than a week ago and then delete

the backup sets from disk, use the following command:

backup device type sbt backupset completed before
sysdate-7 delete input
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Restartable Backups
In Oracle9i, RMAN can back up files that have not been backed up since a

specified time. For example, to continue the backup of a database that was

canceled two days ago, use the following command:

backup device type sbt database not backed up since time
’sysdate-2’

RMAN compares the given time in this command with the completion time of

the most recent backup of a datafile to determine if the datafile requires

backup. For more information, refer to the appropriate Oracle backup and

recovery documentation.

For more information on how to cancel Oracle backups, see the appropriate

section:

• "Canceling a Running Oracle Backup" on page 131

• "Canceling a Nonresponding Oracle Backup" on page 132
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Appendix B: Troubleshooting and Error
Messages

This appendix describes troubleshooting guidelines to follow if Legato Single

Server Version does not function properly. It also describes RMAN error

messages and common Legato Single Server Version error messages that

might be encountered.

This appendix includes the following main sections:

• "Troubleshooting Tips" on page 171

• "Client/Server Communications on UNIX" on page 173

• "Client/Server Communications on Windows" on page 181

• "RMAN Error Messages" on page 183

• "Legato Single Server Version Error Messages" on page 184

Troubleshooting Tips
The following list of troubleshooting tips refers to portions of this

Administrator’s Guide and the Legato Single Server Version Installation Guide,
Release 6.1 that are commonly overlooked. Use the following list to

troubleshoot any problems in running Oracle backup and restore operations

using Legato Single Server Version.

To set up an Oracle backup and restore system correctly:

1. Configure the Oracle Server and Net service (if used) according to the

instructions in the Oracle documentation.

Without Legato Single Server Version installed on the Oracle Server host,

it should be possible to perform a backup and restore using the allocate
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channel t1 type disk command. For more information, see the appropriate

Oracle documentation.

2. Verify that the combination of the operating system, Oracle Server, and

Legato Single Server Version software is supported.

For more information, refer to the installation requirements in the Legato
Single Server Version Installation Guide, Release 6.1.

3. Install Legato Single Server Version using the instructions in the Legato
Single Server Version Installation Guide.

To relink the library file on UNIX, use the commands listed in the

Installation Guide. Shut down and restart Oracle when required. Use the

correct liblsm.* library file.

To verify the version of the Legato Single Server Version SBT library

installed, check the version of the appropriate file:

• On UNIX, use one of these commands, where the liblsm.* filename

ending depends on the particular UNIX system:

# what $ORACLE_HOME/lib/liblsm.*

# strings $ORACLE_HOME/lib/liblsm.* | grep ”@(#)”

• On Windows:

a. Find the orasbt.dll file.

b. Right-click the file icon and select Properties.

c. In the Properties window, select the Version tab and view the file

version information.

Compare the library file with the liblsm.* (UNIX) or orasbt.dll (Windows)

file in the Legato Single Server Version distribution—the two files should

be identical. On UNIX, ensure that Oracle is not linked to another liblsm.*,

libobk.* (BusinesSuite Module for Oracle version of liblsm.*), or libnwora.*
(NetWorker Module for Oracle version of liblsm.*) file.

4. Configure the required Legato Single Server Version resources.

For more information, see "Chapter 2: Preparing to Use Legato Single

Server Version" on page 41.

5. Perform an Oracle backup using Legato Single Server Version and the

proper RMAN script.

Set the required Legato Single Server Version environment variables in the

RMAN backup script or in the rman send command on the operating

system command line. For information on how to set the environment
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variables, see "Legato Single Server Version Environment Variables" on

page 109. For a simple startup RMAN script, see "Creating RMAN Scripts"

on page 123.

For more information on how to troubleshoot problems using Legato Single

Server Version, see the following sections:

• "Client/Server Communications on UNIX" on page 173

• "Client/Server Communications on Windows" on page 181

If an Oracle backup fails, check the debugging file for Legato Single Server

Version. For debugging information, set the NSR_DEBUG_FILE environment

variable. For more information, see "Legato Single Server Version Error

Messages" on page 184.

Client/Server Communications on UNIX
Communications between Legato Single Server Version and the Oracle Server

(as a Legato Single Server Version client) are defined by the attributes

configured in the Server and Client resources in the Administrator program.

These attributes—such as the Parallelism or Administrator attributes—affect

the performance and security of backups. To properly configure the Server and

Client resource attributes, follow the instructions in "Configuration Roadmap"

on page 69.

Many of the problems that might be encountered during Legato Single Server

Version setup and configuration are actually problems with network

communications. The following sections describe procedures for testing the

communications in a network.

How to Troubleshoot IP Errors

If any of the following error conditions occurs, an IP naming problem probably

exists:

• RPC errors

• Unknown host messages

• Failure contacting the portmapper

• Connection failures or timeouts

• Program unexpectedly exiting

• Refused connections

• RCMD to active client failures
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• Name-to-address translation failures

• Program not registered messages

• Legato Single Server Version services or daemons failing to start

• Legato Single Server Version services or daemons failing to remain active

• Invalid path messages

To troubleshoot IP errors:

1. Document the steps taken and the results, especially error messages, in

case Technical Support needs to be contacted. This enables e-mail or fax of

the exact steps and error message text directly to Technical Support.

2. Set up a hosts table for each Legato Single Server Version client and server.

See "How to Set Up a Hosts Table" on page 174.

3. Disable other name servers to simplify testing. See "Troubleshooting

Hostname Resolution Problems" on page 175.

4. Use the ping command to establish basic connectivity. See "How to Use

ping to Verify Network Connections" on page 176.

5. Use the rpcinfo command to verify that sessions can be established and

that portmapping is correct. See "How to Use rpcinfo to Verify That

Sessions Can Be Established" on page 177.

How to Set Up a Hosts Table

It is recommended that IP problems be troubleshooted using only the hosts

table. Troubleshooting using only the hosts table does not mean that the name

service, for example, DNS, cannot be used with Legato Single Server Version.

Run tests using only the hosts table to determine whether Legato Single Server

Version is installed correctly. After it is certain that the software works with the

hosts table, enable the named server being used.

To set up a hosts table:

1. On the Legato Single Server Version client, list the client and the server to

which it connects, for example:

127.0.0.1 localhost loopback

123.456.789.111 client client.domain.com

123.456.789.222 server server.domain.com
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2. On the Legato Single Server Version server, list the Legato Single Server

Version server itself and all of its clients, for example:

127.0.0.1 localhost loopback

123.456.789.111 server server.domain.com

123.456.789.222 client client.domain.com

3. Use the guidelines in "How to Use ping to Verify Network Connections"

on page 176 to ensure the highest success rate for parsing a hosts table

within any operating system.

Recommendations for hosts table configuration:

• Do not use blank lines in the body of the hosts table.

• The end of the hosts table should always contain a blank line.

• The first unremarked entry should always be the loopback line in the

exact order and format shown in step 1 and step 2.

• The last character of each unremarked line should be a space, not a

carriage return.

On UNIX platforms, the hosts table resides in the /etc/hosts directory.

Troubleshooting Hostname Resolution Problems

To simplify the troubleshooting of host name resolution problems, try

disabling services like DNS, WINS, and DHCP. If there are hostname

resolution problems, first configure the hosts table for the computer, and then

test the backups.

Some common problems that can be encountered with DNS, WINS, and

DHCP services include:

• The DNS is not configured with a reverse lookup table.

• The clients are configured with the wrong IP addresses for DNS or WINS

servers.

• The DHCP services do not properly update the WINS server with new

addresses.

DNS does not need to be disabled for the entire network, just for the initial

setup of the Legato Single Server Version client and server to be tested. Only

disable the ability of a client to obtain IP naming information from a DNS

server. Typically, the DNS server itself does not need to be disabled.

To disable the DNS server on most UNIX platforms, rename the file

/etc/resolv.conf and reboot.
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Troubleshooting Hostname Resolution Problems
For a Solaris or HP-UX system, instead of renaming resolv.conf, the IP name

search order can be set up so that the hosts table is searched before DNS.

How to Set the IP Name Search Order

To set the IP name search order:

1. Edit the /etc/nsswitch.conf file and verify that the /etc/resolv.conf file exists.

2. Set the host file to be first in the search order, with DNS second and NIS

last, for example:

hosts: files [NOTFOUND=continue] DNS [NOTFOUND=continue]
nis

For an AIX system, edit the /etc/netsvc.conf file and reboot.

The NSORDER environment variable can also be set. For directions specific to

the version of AIX, refer to Info Explorer.

How to Use ping to Verify Network Connections

After creating the hosts table, test it using the ping command.

On the Legato Single Server Version client, ping the following:

• Client short name (hostname) from the client

• Client long name (hostname plus domain information) from the client

• Client IP address from the client

• Server short name from the client

• Server long name from the client

• Server IP address from the client

The following example shows how to ping the client short name and client

long name from a Legato Single Server Version client called marsin the jupiter
domain:

# ping mars

# ping mars.jupiter.com

On the Legato Single Server Version server, ping the following:

• Server short name from the server

• Server long name from the server

• Server IP address from the server

• Client short name from the server
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• Client long name from the server

• Client IP address from the server

How to Use rpcinfo to Verify That Sessions Can Be Established

If ping is successful and backup problems still exist, the rpcinfo command can

also be used for testing. Because Legato Single Server Version relies heavily on

mapping of ports, use rpcinfo to test the operation of the portmapper. Using

ping tests the connection up to the network layer in the Open System

Interconnection (OSI) model; rpcinfo checks for communication up to the

session layer.

Use the same tests with rpcinfo as with ping.

For rpcinfo to be used successfully, the machine whose hostname is entered on

the command line must have a portmapper running. In most cases, Legato

portmappers are compatible with fully functional portmappers from other

vendors (third-party portmappers). If a product that provides its own

portmapper is used, Legato recommends not loading the third-party

portmapper until it is verified that Legato Single Server Version works with

the rest of the environment. This process enables portmapper compatibility

testing without adding other unknowns.

On Solaris, the rpcbind daemon must be running. On AIX and HP-UX, the

portmap daemon must be running. The rpcinfo utility is part of the operating

system.

Enter the following rpcinfo command to display ports using TCP:

# rpcinfo -p hostname

Substitute the long name and short name for the variable hostname, as for ping.

Other rpcinfo command options can be viewed by typing rpcinfo at the

command line. More information on the rpcinfo command and its error

messages are available in the rpcinfo man page. Repeat rpcinfo using all the

locations and all the iterations listed for ping in "How to Use ping to Verify

Network Connections" on page 176.

When rpcinfo runs successfully, the output is a list of port numbers and names

as shown in the following example:

rpcinfo for mars

program vers proto   port

100000    2   tcp    111  portmapper

100000    2   udp    111  portmapper
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Replacement for Functional Use of portmapper and rpcbind
390103    2   tcp    760

390109    2   tcp    760

390110    1   tcp    760

390103    2   udp    764

390109    2   udp    764

390110    1   udp    764

390113    1   tcp   7937

390105    5   tcp    821

390107    4   tcp    819

390107    5   tcp    819

390104  105   tcp    822

Replacement for Functional Use of portmapper and rpcbind

The nsrexecd process combines the functionality of portmapper and rpcbind.

The parent nsrexecd spawns a child nsrexecd that handles the portmapper
functions. As a result, more than one instance of the nsrexecd process will be

running.

In the following example, the instance of nsrexecd running under the process

ID (PID) 20415 is the parent and the instance of nsrexecd running under the

PID 20416 is the child:

jupiter# ps -ef | grep nsr

root 20429 204200 11:23:59 ? 0:00 /usr/sbin/nsrmmd -n 1
root 20415 1 0 11:23:49 ? 0:01 /usr/sbin/nsrexecd -s
jupiter
root 20416 204150 11:23:49 ? 0:01 /usr/sbin/nsrexecd -s
jupiter
root 20428 204200 11:23:57 ? 0:00 /usr/sbin/nsrindexd
root 20420 1 0 11:23:53 ? 0:02 /usr/sbin/nsrd
root 20446 203490 11:27:22 pts/6 0:00 grep nsr
root 20427 204200 11:23:55 ? 0:00 /usr/sbin/nsrmmdbd

This enables Legato Single Server Version processes to function in a more

secure manner that does not utilize ports or protocols that are commonly used

by other programs.
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How to Verify Firmware for Switches and Routers

If switches or routers from any vendor are used, ensure that the switch or

router firmware is dated after August 1995 (wherever they exist on the

network) to ensure that RPC (Remote Procedure Call) traffic is handled

properly. Most of the switch and router vendors have significantly improved

their handling of RPC traffic since August 1995.

Naming Requirements

Legato Single Server Version uses the /nsr/res/servers file to determine whether

a Legato Single Server Version server is authorized to back up the client data.

If the servers file does not exist, it can be created in the /nsr/res directory using

a preferred editor.

The servers file must contain both the short name and the long name of the

Legato Single Server Version server to be used for backups. For example, the

servers file would contain the following names for a Legato Single Server

Version server named mars in the jupiter.com domain:

mars

mars.jupiter.com

In the Alias attribute of the Client resource, list both the short name and the

long name, plus any other applicable aliases for the client.

Binding to Server Errors

Legato Single Server Version architecture follows the client/server model,

whereby a server provides services to a client through the RPC. These services

reside inside of long-lived processes known as daemons.

For a client to find these daemons, register the daemons with a registration

service. When the daemons start, they register themselves with the registration

service provided by the portmapper.

Legato Single Server Version provides a backup and recovery service. It

receives data from the Oracle Server (the client), stores the data on backup

media, and retrieves it on demand. If the Legato Single Server Version

daemons are not running and a Legato Single Server Version service is

requested, the following messages are received:

Server not available

RPC error, no remote program registered
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Saving Remote Filesystems
These messages indicate that the Legato Single Server Version daemons nsrd,

nsrexecd, nsrindexd, nsrmmd, and nsrmmdbd might not be running.

To restart the daemons, log in as root and enter the following command at the

prompt, depending on the system:

Saving Remote Filesystems

The following error messages might be included in the save group completion

mail when a backup for a remote client fails:

Host hostname  cannot request command execution

hostname : Permission denied

The first message means that the nsrexecd daemon on the client is not

configured to enable the server to back up its files. The second message means

that the nsrexecd daemon is not currently running on the client.

To resolve these problems, ensure that the nsrexecd daemon is running on the

client, and that the server’s hostname is listed in the boot-time file. The

boot-time file is automatically generated before the installation script is

completed, and takes the responses to the query for the names of all the

servers, in order of precedence, that can contact a client for backups. Table 17

on page 181 lists the location for the boot-time file. For more information about

the nsrexecd daemon, refer to the nsrexecd man page.

Table 16. Legato Single Server Version Startup Command

Operating System Startup Command

Solaris # /etc/init.d/networker start

HP-UX # /sbin/init.d/networker start

Linux # /etc/rc.d/init.d/networker start

AIX # /etc/rc.nsr

Tru64 UNIX # /sbin/rc3.d/S94NSRstartstop start
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Recover Access Rights

Data recover access can be controlled by configuring the Client resource. The

Remote Access list displays the user names that have recover access to the save

sets. User names can be added or deleted, depending on the level of security

the files require.

The following users have permission to recover any files, regardless of the

contents of the Remote Access list:

• Root

• Operator

• Member of the operator group

Other users can only recover files for which they have read permission,

relative to the file mode and ownership at the time that the file was backed up.

Files recovered by a user other than root, operator, or the operator group are

owned by that user.

Client/Server Communications on Windows
Communications between Legato Single Server Version and the Oracle Server

(as a Legato Single Server Version client) are defined by the attributes

configured in the Server and Client resources in the Administrator program.

These attributes—such as the Parallelism or Administrator attributes—affect

the performance and security of backups. To properly configure the Server and

Client resource attributes, follow the instructions in "Configuration Roadmap"

on page 69.

Table 17. Boot-Time File Locations

Operating System Boot-Time File

AIX /etc/rc.nsr

HP-UX /etc/rc

Solaris /etc/init.d/networker

Others /etc/rc2.d/S95networker
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Host Name Determination
Many of the problems that might be encountered during Legato Single Server

Version setup and configuration are actually problems with network

communications. The following sections address various client/server

communication issues for Legato Single Server Version on Windows.

Host Name Determination

Legato Single Server Version on Windows gets its hostname from its TCP/IP

setup. Both the server and domain name can be accessed through the

Windows control panel. This name is not necessarily the same computer name

that is common to other Windows applications.

How to Determine the Hostname

Use these steps to determine the hostname on a Windows computer:

1. From the Windows Start menu, select Settings>Control Panel to open the

Control Panel window.

2. Double-click the Network icon to open the Network applet.

The computer’s hostname and domain names are displayed in the

Identification tab.

Name Resolution

If the network consists of only Windows computers, using WINS or

LMHOSTS may be adequate for use of Legato Single Server Version. However,

for use of Legato Single Server Version with clients running on other platforms

such as UNIX, a local host file or DNS name resolution must be used.

The Legato Single Server Version hostname must be added to either the local

hosts file (located in %SystemDrive%\winnt\system32\drivers\etc) or the

Domain Name Server (DNS) that contains the names of all servers on the

network.

Backup Operators Group

The Backup Operators local group provides its members the rights necessary

to back up and recover data from a Windows computer. Users requesting

backups must be in the Backup Operators or Administrators group of the

domain into which they are logged. The Backup Operators group is assigned

on a computer-by-computer basis. It is not assigned globally by the domain. If
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there is trouble performing tasks on one Legato Single Server Version server

but not another, check the problematic computer’s Backup Operators group to

ensure that the required user is properly assigned.

Dynamic Host Configuration Protocol (DHCP) Clients

Legato Single Server Version requires a static (fixed) hostname address.

Typically, addresses for Dynamic Host Configuration Protocol (DHCP) clients

change because they use dynamic addressing. If the address changes, the

registration code for that Legato Single Server Version becomes invalid. If

Legato Single Server Version is a DHCP client, a static TCP/IP address must

be reserved for it.

Backup and Recover Server Service

In Windows operating systems, the NetWorker Backup and Recover Server

service is normally started by the Windows System account. This enables

backup and recovery services to run even if no one is logged onto that

computer.

RMAN Error Messages
RMAN stores information and RMAN-specific error messages in the log file

specified using the msglog option. Review the RMAN information in this log

file after each backup.

To specify the name of the RMAN log file for an Oracle backup, use the msglog
option in the rman command on the command line:

% rman target ... rcvcat ... msglog filename

For more information on specific RMAN error messages and recommended

courses of action, refer to the appropriate Oracle Error Messages guide.
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Legato Single Server Version Error Messages
Legato Single Server Version Error Messages
During a backup or restore, Legato Single Server Version records the same

error messages in both the Oracle sbtio.log file and in the following default log

file on the Oracle Server host:

• On UNIX:

/nsr/applogs/nmo.messages

• On Windows:

%SystemDrive%\Program Files\nsr\applogs\nmo.messages

To obtain more debugging information for a backup or restore, set the

environment variable NSR_DEBUG_FILE to the valid pathname of a file to

store the information. If the variable is set to an invalid pathname or the

specified file does not have write permissions, the debugging information is

written as follows:

• On UNIX:

1. In the /nsr/applogs/nmosbt.log file, or

2. The information is not written.

• On Windows:

1. In the %SystemDrive%\Program Files\nsr\applogs\nmosbt.log file, or

2. The information is not written.

Legato Single Server Version also writes diagnostic information from the

Oracle backup to specific log files. For more information on the log files, see

"Chapter 4: Backup and Restore Operations" on page 107.

Legato Single Server Version error messages appear in the following format:

function_name: error_message

where:

• function_name is the name of the internal function that generates the error

message.

• error_message is the text of the error message.

The following table of error messages includes several references to Legato

Single Server Version environment variables. For more information on how to

set the environment variables, see "Legato Single Server Version Environment

Variables" on page 109.

Table 18 on page 185 describes the main Legato Single Server Version error

messages related to Oracle backups and restores and recommended actions to

resolve the associated problems.
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Table 18. Legato Single Server Version Error Messages (Part 1 of 4)

Error Message Description Resolution

nwora_getssinfo: could
not locate the saveset
saveset_id

Displayed during recovery,

when Legato Single Server

Version could not find an

entry for the requested backup

in the client index.

Check the Legato Single Server

Version media index using the

backup timestamp (the save

set name in the media index is

different than the backup piece

name in the RMAN catalog for

scheduled backups) to find out

if the backup entry exists. If it

exists, run the scanner
program to re-create the client

file index that should contain

the backup entry.

To prevent recurrence of the

problem, set the browse policy

to the same value as the

retention policy in the Client

resource.

doinfo: client could not
connect to server server
to find backup file
backup_piece_name

Legato Single Server Version

could not connect to the

nsrindexd or nsrmmd
daemon.

Check that the Legato Single

Server Version daemons are

running.

doinfo: client could not
find backup file
backup_piece_name on
server server:
permission denied

The software could not obtain

authorization to connect to the

Legato Single Server Version

server.

Add the required user name to

the Administrators list in the

Server resource.

nwora_index_ssinfo:
index connect to server
failed for client
client: reason

Legato Single Server Version

was unable to establish a

session with the nsrindexd
daemon due to the reason.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

nwora_mmdb_connect:
cannot connect to
media index server
server: reason

Legato Single Server Version

was unable to establish a

session with the nsrmmd
daemon due to the reason.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.
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nwora_open_backup:
backup file
backup_piece_name already
exists: ssid saveset_id

A backup with this name

already exists in the client

index. As a result, Legato

Single Server Version could

not complete the backup.

Delete the existing backup in

the client index and restart the

backup operation.

nwora_open_backup:
browse time date not in
future

The value of the

NSR_BROWSE environment

variable is less than or equal to

the current date.

Check the value of the

NSR_BROWSE environment

variable in the RMAN script.

nwora_open_backup:
expiration time date
not in future

The value of the

NSR_SAVESET_EXPIRATION

environment variable is less

than or equal to the current

date.

Check the value of the

NSR_SAVESET_EXPIRATION

environment variable in the

RMAN script.

nwora_open_backup:
invalid browse time:
date

The NSR_BROWSE

environment variable has an

invalid date value.

Check the NSR_BROWSE

environment variable in the

RMAN script. It should have a

value in the Legato Single

Server Version date format.

nwora_open_backup:
invalid expiration
time: date

The

NSR_SAVESET_EXPIRATION

environment variable has an

invalid date value.

Check the

NSR_SAVESET_EXPIRATION

environment variable in the

RMAN script. It should have a

value in the Legato Single

Server Version date format.

nwora_open_backup:
unable to start save
session with server
server: reason

Legato Single Server Version

could not establish a save

session.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

nwora_open_restore:
cannot start recover
session with server:
reason

Legato Single Server Version

could not establish a recover

session.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

Table 18. Legato Single Server Version Error Messages (Part 2 of 4)

Error Message Description Resolution
Legato Single Server Version, Release 6.1
Administrator’s Guide186



Appendix B: Troubleshooting and Error Messages

B

nwora_open_restore:
restore: permission
denied

The host machine is not

allowed to restore the

specified backup.

Add the user ID and the

hostname to the Remote

Access attribute in the Client

resource when performing a

restore from a host different

from the one that did the

backup.

nwora_remove: Could
not determine client
name

Legato Single Server Version

could not determine the client

name.

Set the NSR_CLIENT

environment variable in the

RMAN script.

nwora_remove: Could
not find the nsrmm
binary

Legato Single Server Version

could not find the nsrmm
utility, which is probably in a

nondefault location.

Set the NSR_NWPATH

environment variable in the

/nsr/res/nwora.res file or in the

RMAN script. See "Legato

Single Server Version

Environment Variables" on

page 109.

For example, create the

/nsr/res/nwora.res (text) file, if

required, and add this line to

the file:

NSR_NWPATH=/opt/networker/
bin

nwora_remove: Error
removing ssid saveset_id
from the media
database: reason

Legato Single Server Version

was unable to delete the save

set from the media index.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

nwora_restore_mmdconn:
#: could not prepare
restore session:
reason

Legato Single Server Version

could not connect to the

nsrmmd daemon. # can be 1 or

2.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

nwora_session_close:
could not end session:
reason

Legato Single Server Version

could not close the session.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

Table 18. Legato Single Server Version Error Messages (Part 3 of 4)

Error Message Description Resolution
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nwora_session_init:
could not determine
client name

Legato Single Server Version

could not determine the client

name.

Set the NSR_CLIENT

environment variable in the

RMAN script to the Oracle

hostname.

nwora_server_init:
unable to contact
server server: reason

Unable to establish connection

with the Legato Single Server

Version server.

Check the Legato Error Message
Guide on the Legato web site

for the reason and follow the

given instructions.

sbtbackup: Oracle pool
is not supported.

Legato Single Server Version

does not support Oracle pools.

Delete the pool option of the

backup command in the

RMAN script or set the pool
option to zero. See "RMAN

Commands" on page 114.

sbtcommand: string
should be in format:
KEY=(xxxxx)

Invalid syntax of string in the

RMAN send command.

For the correct send command

syntax, see "RMAN

Commands" on page 114.

Table 18. Legato Single Server Version Error Messages (Part 4 of 4)

Error Message Description Resolution
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The scanner program can be used to re-create the Legato Single Server Version

client index entries for the save sets on a backup tape volume. The scanner
program can also be used to re-create the Legato Single Server Version media

index entries for a volume, if the entries for the volume no longer exist in the

media index.

To find the volume that contains a specific file, use the mminfo program if the

volume is still in the media index or the scanner program if the volume is no

longer in the media index. The mminfo and scanner programs provide

detailed information on the contents of the volume, including:

• The name of the backup volume

• The name of the save set that contains the required file

• The name of the client to which the file belongs

• The date and time the file was backed up

This appendix includes the following main sections:

• "Using the scanner Program" on page 189

• "scanner Program Options" on page 190

• "Rebuilding Save Set Entries in the Indexes" on page 192

• "scanner Requests an Entry for Record Size" on page 193

• "scanner Marks a Volume Read-Only" on page 194

Using the scanner Program
The scanner program reads a backup tape to confirm the contents of the tape

volume or to rebuild the Legato Single Server Version online indexes. The

scanner command can be run only by the root user (UNIX) or administrator

(Windows).
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scanner Program Options
The scanner program reads the volume directly, without accessing

information that may be available in the media index. If no entries exist in the

media index, make an educated guess as to which volume contains specific

data.

After the volume is mounted in the tape drive, run the scanner program with

any of its available options. The scanner options most commonly used are as

follows. For more information on these options, see Table 19 on page 191.

• -m device

• -i device

• -S save-set-id -i device

• -S save-set-id -m device

• -c client-name

• -N save-set-name

Table 19 on page 191 describes the complete list of scanner program options.

For detailed information on the scanner command syntax and examples of

how scanner options can be customized to meet the needs of a particular

situation, refer to the following sources:

• scanner man page on UNIX (see "UNIX Man Pages" on page 37)

• scanner entry in the Legato Command Reference Guide (see "Legato

Command Reference Guide" on page 39)

The entries created in the client index receive a status of "scanned-in" to protect

them from being automatically deleted the next time the index management

service checks the index for entries that have surpassed their browse policy.

The entries created in the media index also receive a status of "scanned-in" and

the volume mode is listed as "read-only." All index entries created by the

scanner program must be deleted manually.

scanner Program Options
A tape device name configured in Legato Single Server Version is a mandatory

option of the scanner program. On UNIX, the tape device name must be a

nonrewinding device name.

If the scanner command is invoked without options (or with the -v option

only), the volume in the specified device is scanned and a table of contents is

generated. The table of contents contains information about each save set

found on the volume. By default, one line of information is written to standard

output for each save set found on the volume. The information provides the

client name, save set name, save time, level, size, files, save set ID, and a flag.
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The following example describes the format and options of the scanner
command:

scanner  [ -Bimnpqv  ] [ -s server ] [ -S save-set-id ]
[ -c client ] [ -N save-set-name ] [ -f file ] [ -r record ]
[ -t type ] [ -b pool ] device [ -x command argument-list ]

Table 19 on page 191 describes the complete list of scanner program options.

Table 19. scanner Program Options (Part 1 of 2)

Option Description

-b pool Specifies the pool to which the tape volume should belong. Legato Single
Server Version supports the Default pool only.

-B
(without -S)

Quickly scans the tape to the location of the start of the bootstrap save sets.
When the entire tape has been scanned, the save set ID and tape file location
of the most recent bootstrap save set is printed to standard output.

-c client-name Only processes save sets that came from the client-name computer. More than
one client name can be specified in the same command line. The -c option
can also be used in conjunction with the -N option, but only if the -i or -x
option is also specified.

-f file Starts the scan at a specific media file number. For information on how to
determine the media file number, refer to the mminfo entry in the Legato
Command Reference Guide (see "Legato Command Reference Guide" on
page 39).

-i device Rebuilds both the client index and media index for the volumes that are
read. If a single save set is specified with the -S save-set-id option, only the
entries from the specified save set are created in the client index.

-m device Rebuilds only the media index for the volumes that are read.

-n Runs scanner without rebuilding the client index or media index. This
option provides a way to check the tape volume without modifying the
client index or media index.

-N save-set-name Processes only save sets that match the specified name. The value of
save-set-name should be a literal string. Multiple names can be specified when
this option is used in conjunction with the -c client-name option, but only if
the -i or -x option is also specified.

-p Prints out information about each save set as it is processed.

-q Only displays error messages or messages of significance.
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Rebuilding Save Set Entries in the Indexes
For examples of scanner command usage and a list of common error messages,

refer to the following sources:

• scanner man page on UNIX (see "UNIX Man Pages" on page 37)

• scanner entry in the Legato Command Reference Guide (see "Legato

Command Reference Guide" on page 39)

Rebuilding Save Set Entries in the Indexes
If a file is not browsable (its save set entry is not in the client index), but the

save set is still tracked by Legato Single Server Version in the media index,

follow these steps to recover the save set’s entry back into the client index:

1. Enter the following mminfo command:

mminfo -a -v volume-name

2. From the mminfo command output, find the save set ID for the save set

believed to contain the required file. Ensure it is not the bootstrap save set ID.

3. Having determined the proper save set ID, replace the save set entry in the

file index using the following scanner command:

scanner -i -S save-set-id device-name

-r record Starts the scan at a specific media record number, to avoid a scan of
potentially unused information. For information on how to determine the
media record number, refer to the mminfo entry in the in the Legato
Command Reference Guide (see "Legato Command Reference Guide" on
page 39).

-s server-name Specifies the hostname of the controlling Legato Single Server Version.

-S save-set-id Extracts the save set specified by save-set-id. When this option is used in
conjunction with the -i or -x option, multiple save-set-id values can be
specified. The save sets selected are in addition to any selected using the -c
and -N options. If the -B option is also specified, the value of save-set-id is
assumed to be that of the bootstrap save set; only one save-set-id can be
specified in this case.

-x command Used with an optional list of command arguments, to specify an operating
system command to run on each save set scanned. This option can only be
specified once per scanner command line, after the device specification.

Table 19. scanner Program Options (Part 2 of 2)

Option Description
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Note: If the save set spans volume boundaries, use the scanner program

to read from all the volumes. Otherwise, the client index will not be fully

rebuilt, making it impossible to perform a recovery of the files in the save

set.

If the save set that contains the particular file is not browsable and the save set

is not represented in the media index, the save set’s entry must be rebuilt in

both the client index and media index.

To rebuild the save set’s entry in both the client index and media index:

1. Run the scanner program on the backup volume believed to contain the

requierd file (make a guess based on the adhesive label on the volume).

Enter the following scanner command:

scanner device-name

2. Use the scanner command output to decide whether to reintroduce the

contents of this volume into the client index and whether the save set to be

rebuilt is on this volume. Locate all the volumes that contain this save set

ID.

3. Having determined which volumes to reintroduce into the online indexes,

enter the following scanner command:

scanner -i device-name

The scanner command continues to prompt for a new volume until the

command is terminated. To rebuild the indexes completely, scan in all the

volumes that contain the particular save set ID.

scanner Requests an Entry for Record Size
If the scanner program is used with the -s option but without an -i and -m
option, the following message is generated:

please enter record size for this volume ('q' to quit) [xx]

The number in the bracket [xx] is the entry from the last query.

The scanner program always rewinds the tape and reads the volume label to

determine the block size. If the volume label is corrupted or unreadable, a

message is generated, asking for the block size (in kilobytes). Enter the block

size as an integer equal to or greater than 32. If an integer is less than 32 is

entered, the following message is generated:

illegal record size (must be an integer >=32)
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scanner Marks a Volume Read-Only
scanner Marks a Volume Read-Only
When the scanner program is used to rebuild the index of a backup volume,

the scanner program marks the volume read-only. This is a safety feature that

prevents the last save set on the backup volume from being overwritten. To

write to the tape without marking it read-only, use the nsrmm -o command:

nsrmm -o notreadonly volume-name

For more information on the nsrmm command, refer to the nsrmm entry in the

Legato Command Reference Guide (see "Legato Command Reference Guide" on

page 39).
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This appendix describes how the Legato Single Server Version uses label

templates to create unique labels for storage volumes and how it uses the

volume labels in conjunction with pools to identify and track backup data on

volumes.

This appendix includes the following main sections:

• "How Legato Single Server Version Uses Label Templates" on page 195

• "Label Template Resource Attributes" on page 197

• "Label Template Strategies and Procedures" on page 200

How Legato Single Server Version Uses Label Templates
Legato Single Server Version creates a unique label for each storage volume by

applying a label template. Label templates and pool configuration settings are

used to sort, store, and track data on storage volumes. During a restore, Legato

Single Server Version prompts for the specific volume that contains the

required data, identifying the volume by the name given to it when it was

labeled.

Legato Single Server Version writes a given set of data to a specific pool of

volumes. For Legato Single Server Version to recognize that a particular

volume belongs to a particular pool, the volume must have an identifying label

that associates it with the pool. The contents of the volume label follow rules

defined in a specific label template configured in a Label Templates resource.

The label template is associated with a specific pool in the Pools resource.

Legato Single Server Version uses the preconfigured Default pool and

corresponding Default label template.
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How Legato Single Server Version Uses Label Templates
The preconfigured Default label template has two fields separated by a period.

The first field contains the hostname of the Legato Single Server Version

computer and the second field contains a number. To allow for expansion of

the volume pool, the number range starts at 001 and ends with 999.

For example:

mars.001

mars.197

jupiter.054

Figure 24 on page 196 illustrates how the Default pool configuration uses its

associated Default label template to label a volume.

Note: For a label template name to appear as a choice in a Pool resource, the

Label Template resource must be configured before the associated Pool

resource.

Figure 24. Labeling a Volume Using a Label Template

During the labeling process, Legato
Single Server Version associates a tape

volume with the Default volume pool.

Legato Single Server Version applies the
label template associated with the pool.

Resulting Volume Label:
Hostname.025

Unlabeled
Volume

Pool Label Template

Name: Default
Label Template:
Default

Name: Default
Fields: Hostname
001-100
Separator: Period
Next: 025
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Label Template Resource Attributes
The attributes for a Label Template resource follow certain guidelines. Table 20

on page 197 describes the key attributes for a Label Template resource.

Table 20. Label Template Resource Attributes (Part 1 of 2)

Attribute Guidelines

Name Keep the label template name consistent with the pool name, so that it is easy to

see how the data is organized. For example, create a label template called

AcctFull for volumes that belong to a pool called Accounting Full.

Legato Single Server Version does not allow the following characters in a label

template name:

/ \ * [ ] ( ) $ ! ^ ’ ; ‘ ~ < > & | { }

In addition, the following four characters cannot be used, because they are used

as separators in label templates:

• colon (:)

• dash (-)

• period (.)

• underscore (_)
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Label Template Resource Attributes
Field A label template consists of one or more fields. Each field, or component,

provides a layer of specificity to the organizational structure. There can be as

many components as required, but it is best to keep the template simple with

few components. The label cannot exceed 64 characters.

Four types of components can be used:

• Range of numbers (for example, 001-999)

• Range of lower case letters (for example, aa-zz)

• Range of upper case letters (for example, AA-ZZ)

• Character string (for example, Accounting)

Each range includes a start value, a dash (-), and an end value. The start value

and the end value must have the same number of characters. For example, use

01-99, not 1-99, or aaa-zzz, not aa-zzz. (This rule does not apply to a list of

character strings or words; character strings should be separated by a blank

space.)

The order of entry of each component of the Field attribute is important. Legato

Single Server Version applies each component in a left-to-right order, starting

with the first one entered. Table 21 on page 199 illustrates how label templates

use components to create a number sequence for volume labels.

Separator Choose the symbol to appear between component entries. The period, dash,

colon, or underscore can be used to separate each component of the label

template. If a separator is not selected, the label components do not have

separators (for example, AA00aa), which makes the labels difficult to read.

Next Choose the next sequence number to write on the label that Legato Single Server

Version places on a volume (according to the template).

• To force a label to start the label scheme at a particular point, enter the start

label value. Legato Single Server Version continues to generate labels from

that point on, according to the rules of the template.

• To have Legato Single Server Version generate the first label, leave this

attribute blank.

Table 20. Label Template Resource Attributes (Part 2 of 2)

Attribute Guidelines
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Table 21 on page 199 lists examples of number sequences for volume labels.

A label template should allow for expansion of the backup tape storage

system. For example, it is better to create a template for 100 tapes and not use

all of them, than to create a template for only 10 tapes and run out of labels.

When Legato Single Server Version reaches the end of the template number

sequence, it issues a warning that the maximum tapes allowed for the label

template have been reached. Modify the label template to allow for more tapes.

Important: When Legato Single Server Version recycles a volume, the volume

label does not change if the volume remains in the same pool. For example, if

a volume labeled Dev.006 is recycled, it retains the label Dev.006 and does not

receive a new label with the next sequence number. However, the original data

on the volume will be overwritten by new data.

Table 21. Examples of Number Sequences for Volume Labels

Type of Components Field Number Sequence Result

Total
Number of
Labels

Range of numbers 001-100 001, 002, 003,...100 100

• Character string

• Range of numbers
SalesFull

001-100

SalesFull.001,...SalesFull.100 100

• Range of lower case letters

• Range of numbers
aa-zz

00-99

aa.00,...aa.99,

ab.00,...ab.99,

ac.00,...ac.99,

:

az.00...az.99,

ba.00,...ba.99

:

zz.00,...zz.99

67,600 (262

times 102)
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Label Template Strategies and Procedures
Label Template Strategies and Procedures
Legato Single Server Version is packaged with preconfigured label templates

that correspond to the preconfigured pools. Legato Single Server Version
supports the Default pool and Default label template only.

Note: The full featured Legato NetWorker product supports the creation of

customized label templates.

A customized label template can include as many components in the Field

attribute as necessary to suit an organizational structure. However, it is best to

keep the template simple with few components.

For example, in creating a label template for an accounting department, the

label template can be customized in several ways, depending on the size of the

storage system and device capabilities. Table 22 on page 200 illustrates several

ways the components can be used to organize labels.

Labeling Tips

Naming schemes vary from site to site. Volumes might be named with the

hostname of Legato Single Server Version followed by a three-digit number,

for example:

jupiter.001

Table 22. Using Label Template Components

Type of
Organizational
Structure Components Separator

Resulting Volume
Labels

Sequential AcctFull

001-100

period AcctFull.001

(100 total labels)

Storage oriented

(for example, 3

storage racks with

5 shelves each,

each shelf holding

100 tapes)

1-3

1-5

001-100

dash 1-1-001

This label is for the first

tape in rack 1 on shelf

1.

(1,500 total labels)

Two-sided media

(for example,

optical devices)

AcctFull

000-999

a-b

underscore AcctFull_000_a (side 1)

AcctFull_000_b (side 2)

(2,000 total labels)
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No matter what naming scheme is chosen, keep in mind that the simpler a

convention is, the easier it is for operators and administrators to understand.

When volumes are labeled, each volume should have a physical (adhesive)

label attached to it. Since Legato Single Server Version keeps track of the

backups and which volumes they are on, the volumes can be named with any

name that is convenient to use. For example, volumes might be labeled mars.1,

mars.2, mars.3, or Monday.1, Tuesday.1, Wednesday.1. Each volume label must be

unique.

The adhesive label on the volume should match the name generated by Legato

Single Server Version. For example, if a volume is physically labeled mars.1, its

generated name should also be mars.1.

How to Edit a Label Template

The name of a label template cannot be changed. However, to change an

individual label name, delete the existing name in the Next text box, and enter

a new name.

To edit a label template:

1. Run the Administrator program as a user with Administrator privileges.

For more information, see "The Administrator Program" on page 51.

2. Open the Label Templates window or Edit Label Template dialog box:

• On UNIX:

a. Select Customize>Label Templates in the main Administrator

window to open the Label Templates window, as shown in

Figure 25 on page 202.

b. Select the label template name in the Label Templates scrolling

list.

• On Windows:

a. In the Configure tab in the Server window, click Manage Label

Templates to open the Label Templates window.

b. Right-click the icon of the label template, and select Edit to open

the Edit Label Template dialog box, as shown in Figure 26 on

page 203.

3. Edit the required attributes.

4. Click Apply or OK.
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Labeling Tips
Figure 25. Label Templates Window on UNIX
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Figure 26. Edit Label Template Dialog Box on Windows
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Labeling Tips
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Glossary

This glossary contains terms and definitions found in this guide. Most of the

terms are specific to Legato Single Server Version.

Administrator The user with the privileges required to configure and use

the Legato Single Server Version. The Administrator

hostname must be listed in the Administrator attribute in

the Server resource in Legato Single Server Version.

Administrators
group

Windows user group whose members have all the rights

and abilities of users in other groups, plus the ability to

create and manage all the users and groups in the domain.

Only members of the Administrators group can modify

Windows operating system files, maintain the built-in

groups, and grant additional rights to groups.

Administrator
program

The program that provides a graphical interface to the

Legato Single Server Version software.

API An abbreviation for application programming interface, a

standard set of computer library routines designed to

accomplish a particular set of tasks.

Application-Specific
Module (ASM)

A program that, when used in a directive, specifies the

way a set of files or directories is to be backed up and

recovered.
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archived redo log An archived copy of a filled online Oracle redo log. An

Oracle database can be optionally configured to archive

copies of the online redo logs after they fill. An archived

redo log preserves older redo log data for recovery

operations while the preallocated online redo log files are

reused to store the most current database changes. See redo
log.

ASM See Application-Specific Module (ASM).

attribute A feature of a Legato Single Server Version resource. It is a

service or information that the resource provides.

auto media
management

A feature that enables the storage device controlled by

Legato Single Server Version to automatically label,

mount, and overwrite a volume it considers unlabeled.

Volumes that are eligible for reuse are also automatically

recycled.

autochanger A mechanism that uses a robotic arm to move media

among various components located in a device including

slots, media drives, media access ports, and transports.

Autochangers automate media loading and mounting

functions during backups and restores. Legato Single

Server Version does not support autochangers.

backup The writing of saved data to a volume.

Backup Operators
group

A Windows group whose members have the capability of

logging on to a domain from a workstation or a server,

backing it up, and restoring the data. Backup Operators

also can shut down servers or workstations.

backup save set See save set.

backup volume See volume.

bootstrap A save set that is essential for Legato Single Server Version

disaster recovery procedures, composed of the media

index and configuration files.

browse policy The Legato Single Server Version policy that determines

how long entries for backed up files remain in the online

client index.
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client The client that accesses Legato Single Server Version to

back up or restore files. The only type of client that Legato

Single Server Version supports is the Oracle Server.

client index A database of information maintained by Legato Single

Server Version that tracks every file or filesystem backed

up. Legato Single Server Version maintains a single client

index for the Oracle Server.

command line The shell prompt, where commands are entered.

daemon A program that lies dormant waiting for a specified

condition to occur.

DBA An abbreviation for database administrator, the person

normally responsible for installing, configuring, and

maintaining Oracle database systems.

device The tape device connected to the Legato Single Server

Version host computer that reads from and writes to

backup volumes during backups and restores.

expiration date The date when the volume changes from “read/write” to

“read-only.”

expired save set A save set whose browse time has been reached; therefore,

it can no longer be browsed. In addition, the save set has

been removed from the client index.

fileserver A computer with disks that provides services to other

computers on the network.

filesystem 1. A file tree on a specific disk partition or other mount

point.

2. The entire set of all files.

3. A method of storing files.

heterogeneous
networks

Networks with systems of different platforms that interact

meaningfully across the network.

himt A choice in the Devices window, representing half-inch

magnetic tape.
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instance The combination of Oracle processes that runs each time a

database starts up.

interoperability The ability of software and hardware on multiple

computers from multiple vendors to communicate

meaningfully.

Legato Single Server
Version

A Legato software product designed to provide backup

device, media, and storage management services for

Oracle9i databases.

Legato Single Server
Version
Administrator
program

See Administrator program.

Legato Single Server
Version client

See client.

Legato Single Server
Version registration

See registration.

Legato Single Server
Version server

See server.

media Magnetic tape used to back up files.

media index A database of information that contains indexed entries

about the life cycle status and location of all the backup

data and volumes managed by Legato Single Server

Version.

media management
library

See MML.

media manager The component of Legato Single Server Version that tracks

save sets to backup volumes.

MML An abbreviation for media management library, a library

of media management routines provided by Legato Single

Server Version and linked with the Oracle kernel software

during the Legato Single Server Version installation on the

Oracle Server host.
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multiplexing A feature of Legato Single Server Version that enables data

from more than one save set to be simultaneously written

to the same storage device.

notification A message generated and sent to the Administrator about

important Legato Single Server Version events.

nsrhost The logical hostname of the Legato Single Server Version

computer.

offline backup A backup of Oracle database objects performed while the

corresponding Oracle instance is shut down and

unavailable to users.

online backup A backup of Oracle database objects performed while the

corresponding Oracle instance is running and available to

users.

online indexes The databases located on the Legato Single Server Version

host that contain all the information pertaining to the

Oracle data backups (client index) and backup volumes

(media index).

operator The person who monitors the Legato Single Server Version

status, loads volumes into the backup devices, and

otherwise executes day-to-day tasks using Legato Single

Server Version.

Oracle9i Server A computer running an Oracle9i release 9.0.x RDBMS. See

RDBMS.

parallelism A feature of Legato Single Server Version that enables the

backup or restore of many save sets for the Oracle Server

at the same time.

pathname A set of instructions to the operating system for accessing

a file. An absolute pathname specifies how to find a file

beginning at the root directory and working down the

directory tree. A relative pathname specifies how to find the

file starting from the current directory.
Legato Single Server Version, Release 6.1
Administrator’s Guide 209



Glossary

G
lo

ss
ar

y

policy A set of constraints that specify how long an entry can

remain in a Legato Single Server Version online index.

When a policy expires, the save sets associated with that

policy are marked recyclable. The Client resource uses two

policies: a browse policy and a retention policy. Refer to

the nsr_policy entry in the Legato Command Reference
Guide.

pool See volume pool.

preconfigured Existing selections or configurations for different Legato

Single Server Version features.

qic A choice in the Devices window, representing quarter-inch

cartridge tape.

RDBMS An abbreviation for Relational Database Management

System, which refers to the primary architecture of an

Oracle database.

recover An Oracle datafile recovery method that uses Oracle

commands to apply archived redo logs and online redo

logs to make the database consistent.

Recovery Catalog A collection of Oracle database tables containing

information about Oracle database backups and restores.

The Recovery Catalog includes information about backup

sets and pieces, image and proxy copies, archived redo

logs, stored scripts, and the target database schema. RMAN

maintains and uses the information in the Recovery

Catalog to determine how to perform requested backup

and restore operations.

Recovery Manager See RMAN.

recyclable save set A save set whose browse and retention policies have been

reached; therefore, the save set has been removed from the

media index.

recyclable volume A volume whose data has passed both its browse and

retention policies and is now available for relabeling and

use by Legato Single Server Version.
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redo log The online log of an Oracle database, consisting of at least

two redo log files (separate from the datafiles) that record

all changes made in the database. See also archived redo log.

registration The process of obtaining a registration code from Legato

and applying the code in the Administrator program to

disable the regular display of the Legato Single Server

Version splash screen (on Windows) and registration

messages.

Registry A database of configuration information central to

Windows operations. The database centralizes all

Windows settings and provides security and control over

system, security, and user account settings.

resource A component of Legato Single Server Version that

describes the server and clients. Devices, clients, and

policies are examples of Legato Single Server Version

resources. Each resource contains a list of attributes that

define the parameters to use for the specific resource.

resource database A database that contains information about each of the

configured Legato Single Server Version resources.

restore The process whereby Legato Single Server Version

retrieves Oracle datafiles from backup volumes and stores

the files on disk.

retention policy The Legato Single Server Version policy that determines

how long entries are retained in the media index and thus

be recoverable.

RMAN An abbreviation for Recovery Manager, the Oracle utility

(in Oracle8, Oracle8i, or Oracle9i) that acts as an intelligent

interface to Oracle databases and works with third-party

media management products, such as Legato Single

Server Version, to back up and restore Oracle database

objects.
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root 1. (UNIX only) The UNIX superuser account (with user

name “root” and user ID). By extension, the privileged

system-maintenance login on any operating system.

2. (Windows NT/Windows 2000 and UNIX) The top node

of the system directory structure; the home directory of the

root user.

save set A set of files or a filesystem that Legato Single Server

Version backs up onto storage volumes.

save set ID An internal identification number that Legato Single

Server Version assigns to a save set.

save set status The Legato Single Server Version attribute that indicates

whether a given save set is restorable, recoverable, or

recyclable. The save set status also indicates whether the

save set has been successfully backed up.

save stream The data and save set information being written to a

storage volume during a backup. A save stream originates

from a single save set.

scanner The Legato Single Server Version utility used to read a

backup volume when the online indexes are no longer

available.

server The computer running the Legato Single Server Version

software, which contains the backup devices, media, and

online indexes and provides backup and restore services

to the Oracle Server.

shell prompt A cue for input in a shell window where a command is

entered.

SID An abbreviation for Oracle system identifier, a unique

name for an Oracle database instance. This value is

typically set in an ORACLE_SID environment variable.

silo A repository for holding hundreds or thousands of

volumes. Legato Single Server Version does not support

silos.

ssid See save set ID.
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stand-alone device A storage device that contains a single drive for backing up

data. Stand-alone devices cannot automatically load

backup volumes. Legato Single Server Version supports

only tape devices.

storage device The hardware that reads and writes data during backup,

restore, and other Legato Single Server Version operations.

system
administrator

The person normally responsible for installing,

configuring, and maintaining the Legato Single Server

Version system.

target database The Oracle database that has been backed up or that

Legato Single Server Version is to back up as a safeguard

against data loss.

versions The date-stamped collection of available backups for any

single file.

volume Magnetic tape used to back up files.

volume ID The internal identification that Legato Single Server

Version assigns to a backup volume.

volume name The name assigned to a backup volume when it is labeled.

volume pool A feature that enables backup data to be sorted to selected

volumes. A volume pool contains a collection of backup

volumes to which specific data has been backed up.

Legato Single Server Version supports only the Default

pool for backups.
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scripts 123
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using RMAN 108
viewing volume inventory 95

backup and recovery system

backup unable to progress, Pending Messages

Window 93
bootstrap 45
how data is backed up 44
Oracle 32–34
overview of Oracle 32

Backup Domain Controller (BDC)

Windows NT 150
Backup Operators group 182
bootstrap

automatic backups 129
defined 128
maintaining bootstrap information 131
manual backups 130
recovering 156
save set ID, locating 155
server backups 128–129

boot-time file 181
browsable save set 48
browse policy 46
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canceling

nonresponding backup 132
running backup 131

categories, table sorting 65
Change Server button 58
change...crosscheck command 115
change...delete command 114
channel option, send command 118–120
client

browse policy 46
communicating with server 173, 181
DHCP 183
DNS name resolution 182
index 45
resource attributes 75
retention policy 46

Client resource

attributes

Browse Policy 76
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Name 76
Retention Policy 77
Save Set 77
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with 173, 181
command

allocate channel, parms option 109, 116,
121–122

backup 115, 120, 123
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proxy option 115
trace option 123

change...crosscheck 115
change...delete 114
configure channel, parms option 109, 122
crosscheck 115
delete... 114
mminfo 189
mminfo -mv 155
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nslookup 152
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restore 120
rman send 109, 119, 122
scanner 156, 189
send 109, 116–117, 119–120, 122
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device_type option 117, 119–120
NSR_ENV keyword 116
precedence rules 122

set 110
setenv 110

Command Reference Guide, Legato 39
configuration, Legato Single Server Version

Client dialog box, Windows 76
Client resource 70
configuration roadmap 70
disaster recovery 154
overview 42
resource dependencies 43
resource types 42, 46
Server resource 70
storage devices 81

configuring 84
labeling a volume 102
labeling and mounting volumes 90
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tape device, no-rewind name 81
types that Legato Single Server Version
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unmounting a volume 102
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using menu commands 69
using toolbar 68

configure channel command

parms option 109, 122
Configure tab, server window 62
configuring, devices 152
connecting to Legato Single Server Version 54
creating resources 68
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cross-platform

name resolution 182
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delete... command 114
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destroyed server 140
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sessions 93
volumes

finding name 103
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DHCP (Dynamic Host Configuration
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Windows NT 160
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disaster
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disaster recovery
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recovering Oracle data
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restoring Oracle data

overview 161
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DNS (Domain Name System) 175

host name determination 182
hosts file 53

documentation, related

See also help
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dynamic addressing 183
Dynamic Host Configuration Protocol
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editing
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NSR_CHECKSUM 111
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NSR_COMPRESSION 111
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administrator’s list 71
hostname permission denied 180
Legato Single Server Version 184
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server, unavailable 179
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features, Legato Single Server Version 22
types of storage devices supported 81

files
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HOSTS 182
hosts file 53

filesystems

remote, saving 180
firmware, verification 179
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gathering the key information prior to a

disaster 141
Group attribute in Client Resource 77
group attributes, default 130
groups

Backup Operators 182
GUI, Legato Single Server Version

Devices Window 85, 87
Edit client Dialog Box on Windows 76
Edit Group Dialog Box 130
Edit Group Dialog Box on Windows 130
Groups Window on UNIX 130
labeling a volume 101–102
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73
TCP/IP requirements 53
Volumes Window 95

GUI, Oracle
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hard drive, replacing 144
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Command Reference Guide, Legato 39
Field Help 39
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Online Help 38
UNIX 36
UNIX online manual pages 37
What Is This Help 39
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in progress save set 48
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Legato Single Server Version 154
operating system 150

interface
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IP

errors

hosts table 174
troubleshooting 173
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Label button 58
label template 195
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Legato Single Server Version
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Administrator program
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Messages window 62
Network window 61
privileges 51–52
server information area 57
server window 62
Setup wizard 65
starting 56, 60
TCP/IP requirements 53
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resource dependencies 43
resource types 42
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storage devices 81

configuration files, renaming 158
configuring 154
connectivity 53
error messages 184
features 22, 32
how data is backed up 44
installing 154
interfaces

hidden attributes 59, 64
label template, using 195
LMHOSTS 182
name resolution 182
overview 19
privileges 52
recovering 153
recovery requirements 153
SBT API 34
troubleshooting 171–172
WINS 182

Legato Single Server Version indexes, rebuilding

using scanner 189
LMHOSTS, use with Legato Single Server

Version 182
locating, server’s bootstrap save set ID 155
logs

UNIX 134
Windows 134
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maintaining bootstrap information 131
man pages, UNIX 37
mandatory environment variables 111, 113
manual bootstrap backup 130

Manual Recycle attribute 102
media

auto media management 93
media index 45

removing storage volumes 95
media management

auto enabled, behavior 94
auto not enabled 93–94
automatic for tape devices 94
changing the volume modes 95
device configuration 81–82, 84–86

creating a Device resource 85
deleting a Device resource 87
editing a Device resource 86

labeling a volume 102
labeling and mounting volumes 90
mounting a volume 100
storage devices 81
unlabeled volumes 94
unmounting a volume 102
viewing

inventory of backup volumes 95
volume pools

default attributes 91–92
label templates 90–91

Media Management Library (MML), Oracle 35
media pools. See pools

menu commands, configuration resources 69
message windows 57
messages

display on UNIX 134
logs on Windows 134
logs UNIX 134

Messages window 62
Microsoft Windows

Backup Operators group 182
mminfo command 189
mminfo -mv command 155
mminfo program 136
mmlocate program 136
modes

volumes

changing 103
Monitor tab, server window 62
Mount button 58
mounting
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finding volume 103
resolution 175, 182
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in Client Resource 76
name servers, disabling 175
naming requirements 179
Network window 61
nonresponding Oracle backup, canceling 132
nslookup command 152
NSR_BROWSE environment variable 77, 111
NSR_CHECKSUM environment variable 111
NSR_CLIENT environment variable 111
NSR_COMPRESSION environment

variable 111
NSR_DEBUG_FILE environment variable 112
NSR_ENCRYPTION environment variable 112
NSR_ENV keyword in send command 116
NSR_NWPATH environment variable 113
NSR_RETENTION environment variable 77
NSR_SAVESET_EXPIRATION environment

variable 113
nsradmin program 51, 69
nsrck -c command 155
nsrexecd daemon

functionality 178
nsrinfo program 133, 136
nsrmm program 136
nsrwatch program 58, 133
nwadmin program 51
nwadmin program, starting the Administrator

program 56, 60

O

obtaining hard drive information 144
Online Help 38

Command Reference Guide, Legato 39
Field Help 39
How Do I Help 39
UNIX 36

UNIX manual pages 37
What Is This Help 39

operating system

installing 150
operating system recovery requirements 149
operating system, recovering 149
operating system, testing 152
Oracle

backup and recovery system 32–34
backup script 124
manual backup script 121
Media Management Library (MML) 35
Oracle Enterprise Manager 35, 127
recover 128
Recovery Catalog 33–34
Recovery Manager (RMAN) 33, 35
restore script 124
SBT API 34
sbtio.log file 123

Oracle backup

procedure for running 126
scripts 123

Oracle backup volumes

viewing 95
Oracle backups and restores

monitoring 133
prerequisites to running 108
RMAN 108

Oracle Enterprise Manager 127
Oracle 35

Oracle restore

procedure for running 126
Oracle9i commands and features 163
organizational structure, labeling for 200
overview

Legato Single Server Version features 19, 22,
32

Oracle backup and recovery system 32

P

parms option, allocate channel command 109,
116, 121–122

parms option, configure channel

command 109, 122
Pending Messages tab, Messages window 62
Pending Messages Window
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management of 73
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persistent settings in Oracle9i 124, 163–165
ping command 148, 152
policy

browse 46, 76
retention 46, 77

polling interval 64
pool option, backup command 115
pools, volume

default attributes 91–92
label templates 90–91
selection considerations

expiration date of the volume 92
volume label time 93
volume mode 92

unable to find a mounted volume 93
portmappers

nsrexecd daemon 178
verifying 177

precedence rules for send command 122
Primary Domain Controller (PDC)

Windows NT 150
program

mminfo 136
mmlocate 136
nsradmin 51
nsrinfo 136
nsrmm 136
nwadmin 51
scanner 156, 189
using nwadmin 158

proxy copy 115
proxy option, backup command 115
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recover 128
recoverable save set 48
recovery

Backup and Recover Server services 183
backup operators group 182
bootstrap 156

Legato Single Server Version 153
operating system 149

Recovery Catalog, Oracle 33–34
Recovery Manager (RMAN)

backup script 123
commands 114
error messages 183
overview 33
running an Oracle backup 35
running an Oracle restore 35

recyclable

save set 48
volumes 47

refresh, server information 64
remote access

recoveries 181
Remote Access list 181
remote filesystems, saving 180
remote servers

monitoring, termination 55
renaming configuration files 158
replacing a hard drive 144
reports

server statistics and diagnostics 133
storage management application 135

requirements

gathering the key information 141
Legato Single Server Version recovery 153
Linux operating system recovery 146
operating system recovery 149

resource types

Client 43, 46
Browse Policy 46
Retention Policy 46

Device 43
device 82
Label Template 43
Policy 43
Pool 43
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restore

command 120
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restoring, DHCP and WINS databases

Windows NT 160
retention policy 46

save set 50
Retention Policy attribute in Client Resource 77
rman send command 109, 119, 122
rpcbind program 178
rpcinfo program 177
running Oracle backup

canceling 131
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save set

changing the status 95
retention policy 50
status value

aborted 48
browsable 48
client index 49
in progress 48
recoverable 48
recyclable 48
scanned-in 48
suspect 48

Save Set attribute in Client Resource 77
save set ID, locating 155
save sets

information, viewing 98
SBT, API 34
sbtio.log file 123
scanned-in save set 48
scanner command 156
scanner program 189

determine bootstrap save set ID 156
using to rebuild online index entries 48
using to recover save sets 50
using to recover volumes 48

scripts

Oracle backup 123
send command 109, 116–117, 119–120, 122

channel option 118–120
device_type option 117, 119–120
NSR_ENV keyword 116
precedence rules 122

server

communicating with client 173, 181
server backup

automatic bootstrap backup 129
bootstrap backup 128–129
maintaining bootstrap information 131
manual bootstrap backup 130

server destroyed 140
server indexes and configuration files

damaged 139
Server resource

Administrator attribute 71
Server resource type 46
server, recovering Legato Single Server

Version 153
servers

administrators
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adding 72, 74
deleting 73
privileges 71, 73

Backup Operators group 182
changing 54
connectivity 55
DCHP 183
DNS name resolution 182
dynamic addressing 183
errors, binding to 179
host name determination 182
ping command, testing 176
refresh rate 64
remote, monitoring, termination 55
testing 176

services

Backup and Recover Server 183
set command 110
setenv command 110
Setup wizard 65
stopping

nonresponding backup 132
running backup 131

storage devices
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no-rewind device name to prevent data

loss 81
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unmounting a volume 102
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suspect save set 48
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tables, formatting 65
tape devices

auto media management 94
TCP/IP

DHCP clients 183
host name determination 182
network requirements 53

testing the operating system 152
toolbars

Legato Single Server Version

Administrator program 58, 62
modifying 65

ToolTips, enabling 65
trace option, backup command 123
troubleshooting

firmware 179
hosts table 174, 176
IP errors 173–174
Legato Single Server Version 171–172
name resolution 175
name servers, disabling 175
naming requirements 179
nsrexecd program 178
portmappers, verifying 177
ports 178
recoveries

remote access 181
remote filesystems, saving 180
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rpcinfo command 177
server errors, binding to 179
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unlabeled volumes 94
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nwadmin program 158
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NSR_CLIENT 111
NSR_COMPRESSION 111
NSR_DEBUG_FILE 112
NSR_ENCRYPTION 112
NSR_NWPATH 113
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volume label time 93
volume mode 92

tracking volumes 91
volume pool
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Volume tab, server window 62
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auto media management 93–94
changing the modes 95
information, viewing 96, 98
labeling 100, 102

and mounting 90, 100
tips 200
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